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Attribution Key For Externally Authored Images 
and Content 

 
For more information see: http://open.umich.edu/wiki/AttributionPolicy. 

 
Use + Share + Adapt 

{ Content the copyright holder, author, or law permits you to use, share and adapt. } 
 

 PD-GOV - Public Domain – Government: Works that are 
produced by the U.S. Government. (17 USC § 105). This work 
has been identified as being free of known restrictions under 
copyright law, including all related and neighboring rights. You 
can copy, modify, distribute and perform the work, even for 
commercial purposes, all without asking permission. 
http://creativecommons.org/publicdomain/mark/1.0/. 
 

 PD-EXP - Public Domain – Expired: Works that are no longer 
protected due to an expired copyright term. This work has been 
identified as being free of known restrictions under copyright 
law, including all related and neighboring rights. You can copy, 
modify, distribute and perform the work, even for commercial 
purposes, all without asking permission. 
http://creativecommons.org/publicdomain/mark/1.0/. 
 

 PD-SELF - Public Domain – Self Dedicated: Works that a 
copyright holder has dedicated to the public domain. This work 
has been identified as being free of known restrictions under 
copyright law, including all related and neighboring rights. You 
can copy, modify, distribute and perform the work, even for 
commercial purposes, all without asking permission. 
http://creativecommons.org/publicdomain/mark/1.0/. 
 

  CC0 - Creative Commons – Zero Waiver: The person who 
associated a work with this deed has dedicated the work to the 
public domain by waiving all of his or her rights to the work 
worldwide under copyright law, including all related and 
neighboring rights, to the extent allowed by law. You can copy, 
modify, distribute and perform the work, even for commercial 
purposes, all without asking permission. 
http://creativecommons.org/publicdomain/zero/1.0/. 
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 CC:BY - Creative Commons – Attribution License: Lets others 
copy, distribute, display, and perform the copyrighted work-and 
derivative works based upon it-but only if they give credit the 
way the author requests. 
http://creativecommons.org/licenses/by/3.0/.  
 

 CC:BY-SA - Creative Commons – Attribution Share Alike 
License. Lets others remix, tweak, and build upon the work even 
for commercial reasons, as long as they credit the author and 
license their new creations under the identical terms. All new 
works based on the original will carry the same license, so any 
derivatives will also allow commercial 
use. http://creativecommons.org/licenses/by-sa/3.0/. 
 

 CC:BY-NC - Creative Commons – Attribution Noncommercial 
License: This license lets others remix, tweak, and build upon the 
work non-commercially, and although their new works must also 
acknowledge the author and be non-commercial, they don't have 
to license their derivative works on the same 
terms. http://creativecommons.org/licenses/by-nc/3.0/. 
 

 CC:BY-NC - Creative Commons – Attribution Noncommercial 
License: Lets others remix, tweak, and build upon the work even 
for commercial reasons, as long as they credit the author and 
license their new creations under the identical terms. All new 
works based on the original will carry the same license, so any 
derivatives will also allow commercial 
use. http://creativecommons.org/licenses/by-sa/3.0/. 
 

 GNU-FDL - GNU – Free Documentation License: The GNU 
Free Documentation License is a form of copyleft intended for 
use on a manual, textbook or other document to assure everyone 
the effective freedom to copy and redistribute it, with or without 
modifications, either commercially or non-
commercially. http://www.gnu.org/licenses/fdl.html. 

 
Use + Share But Do Not Modify 

{ Content the copyright holder, author, or law permits you to use or copy but prohibit 
excerpts or content modifications. } 
 

 CC:BY-ND - Creative Commons – Attribution No Derivatives 
License: This license allows for redistribution, commercial and 
non-commercial, as long as it is passed along unchanged and in 
whole, with credit to the author.  
http://creativecommons.org/licenses/by-nd/3.0/. 
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 CC:BY-NC-ND - Creative Commons – Attribution 
Noncommercial No Derivatives License: This license is the most 
restrictive of the Creative Commons licenses, only allowing 
others to download the works and share them with others as long 
as they credit the author, but they can’t change them in any way 
or use them commercially. 
http://creativecommons.org/licenses/by-nc-nd/3.0/. 
 

 
Make Your Own Assessment 

{ Content Open.Michigan believes can be used, shared, and adapted because it is ineligible 
for copyright. } 
 

 PD-INEL - Public Domain – Ineligible: Works that are ineligible 
for copyright protection in the U.S. (17 USC § 102(b)) Laws in 
your jurisdiction may differ. 
 

 FAIR USE - Fair Use: Use of works that is determined to be Fair 
consistent with the U.S. Copyright Act. (17 USC § 107) Laws in 
your jurisdiction may differ. Our determination DOES NOT 
mean that all uses of this 3rd-party content are Fair Uses and we 
DO NOT guarantee that your use of the content is Fair. To use 
this content you should do your own independent analysis to 
determine whether or not your use will be Fair. 
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Schedule 
Week 1 
 
Monday 

   All Teams 
7:00 Breakfast 
8:00 Introduction to the Program 
9:00 Team Building 10:00 

11:00 Engineering and Agriculture 
12:00 Lunch 13:00 
14:00 Exploratory 
15:00 Hands On Lab 
16:00 Computer Lab  17:00 
18:00  Dinner  

 
Tuesday 

 Group 1 Group 2 Group 3 Group 4 
7:00 Breakfast 
8:00 Life Skills Life Skills Life Skills Life Skills 

9:00 Engineering and 
Agriculture 

Engineering and 
Agriculture 

Engineering and 
Agriculture 

Engineering and 
Agriculture 

10:00 English English English English 
11:00 Math Math Math Math 
12:00 Lunch 13:00 
14:00 Computer Lab Exploratory Hands On Exploratory 15:00 
16:00 Exploratory Computer Lab Exploratory Hands on 17:00 
18:00  Dinner  

 
Wednesday 

 Group 1 Group 2 Group 3 Group 4 
7:00 Breakfast 
8:00 Life Skills Life Skills Life Skills Life Skills 

9:00 Engineering and 
Agriculture 

Engineering and 
Agriculture 

Engineering and 
Agriculture 

Engineering and 
Agriculture 

10:00 English English English English 
11:00 Math Math Math Math 
12:00 Lunch 13:00 
14:00 Exploratory Hands On Exploratory Computer Lab 15:00 
16:00 Hands On Exploratory Computer Lab Exploratory 17:00 
18:00 Dinner 
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Thursday 
 Group 1 Group 2 Group 3 Group 4 

7:00 Breakfast 
8:00 Life Skills Life Skills Life Skills Life Skills 

9:00 Engineering and 
Agriculture 

Engineering and 
Agriculture 

Engineering and 
Agriculture 

Engineering and 
Agriculture 

10:00 English English English English 
11:00 Math Math Math Math 
12:00 
13:00 Lunch 

14:00 
15:00 Computer Lab Exploratory Hands On Exploratory 

16:00 
17:00 Exploratory Computer Lab Exploratory Hands On 

18:00  Dinner  
 
Friday 

 Group 1 Group 2 Group 3 Group 4 
7:00 Breakfast 
8:00 Life Skills Life Skills Life Skills Life Skills 

9:00 Engineering and 
Agriculture 

Engineering and 
Agriculture 

Engineering and 
Agriculture 

Engineering and 
Agriculture 

10:00 English English English English 
11:00 Math Math Math Math 
12:00 
13:00 Lunch 

14:00 Exploratory Hands On Exploratory Computer Lab 15:00 
16:00 Hands On Exploratory Computer Lab Exploratory 17:00 
18:00 Dinner 

 
Week 2 
 
Monday 

 Group 1 Group 2 Group 3 Group 4 
7:00 Breakfast 
8:00 Life Skills Life Skills Life Skills Life Skills 

9:00 Engineering and 
Agriculture 

Engineering and 
Agriculture 

Engineering and 
Agriculture 

Engineering 
and Agriculture 

10:00 English English English English 
11:00 Math Math Math Math 
12:00 
13:00 Lunch 

14:00 
15:00 Computer Lab Exploratory Hands On Exploratory 

16:00 
17:00 Exploratory Computer Lab Exploratory Hands On 

18:00 Dinner  
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Tuesday 

 Group 1 Group 2 Group 3 Group 4 
7:00 Breakfast 
8:00 Life Skills Life Skills Life Skills Life Skills 

9:00 Engineering and 
Agriculture 

Engineering and 
Agriculture 

Engineering and 
Agriculture 

Engineering and 
Agriculture 

10:00 English English English English 
11:00 Math Math Math Math 
12:00 
13:00 Lunch 

14:00 
15:00 Exploratory Hands On Exploratory Computer Lab 

16:00 
17:00 Hands On Exploratory Computer Lab Exploratory 

18:00  Dinner  
 
Wednesday 

 Group 1 Group 2 Group 3 Group 4 
7:00 Breakfast 
8:00 Life Skills Life Skills Life Skills Life Skills 

9:00 Engineering and 
Agriculture 

Engineering and 
Agriculture 

Engineering and 
Agriculture 

Engineering and 
Agriculture 

10:00 English English English English 
11:00 Math Math Math Math 
12:00 
13:00 Lunch 

14:00 
15:00 Computer Lab Exploratory Hands On Exploratory 

16:00 
17:00 Exploratory Computer Lab Exploratory Hands On 

18:00 Dinner  
 
Thursday 

 Group 1 Group 2 Group 3 Group 4 
7:00 Breakfast 
8:00 Life Skills Life Skills Life Skills Life Skills 

9:00 Engineering and 
Agriculture 

Engineering and 
Agriculture 

Engineering and 
Agriculture 

Engineering and 
Agriculture 

10:00 English English English English 
11:00 Math Math Math Math 
12:00 
13:00 Lunch 

14:00 
15:00 Exploratory Hands On Exploratory Computer Lab 

16:00 
17:00 Hands On Exploratory Computer Lab Exploratory 

18:00 Dinner 
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Friday 

 All Teams 
7:00 Breakfast 
8:00 Keynote Speakers 
9:00 

10:00 
11:00 

Team Competitions 

12:00 
13:00 Special Lunch and Certificate Ceremony 

14:00 Departure for Home 
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Engineering and Agriculture 
 

 
 
We’ll begin with an outline of this curriculum, which will consist of 8 classes, each lasting 1 
hour.  
 
Objective: 
To expose you, the students, to the fields of engineering and agriculture, in order to convey the 
importance and interdependence of these fields and to initiate excitement about them. This will 
be done through several hands-on demonstrations, lectures, and real-life examples/problems. In-
class discussions will allow the students to communicate their ideas and practice their 
presentation skills. 
 
Lesson Plan: 

 

1. Introduction to Engineering 

2. Introduction to Agriculture 

3. Disciplines in Engineering 

4. Disciplines in Agriculture 

5. Interdependency of Engineering and Agriculture 

6. Resources and Economics, Sustainability 

7. Case Studies to relate Engineering, Agriculture, Resources and Economics 

8. Hands-on Exhibition 

Jose Alfaro� 6/17/12 12:17 PM
Comment [1]: Introduce	  the	  curriculum	  and	  
mention	  the	  outline.	  	  	  
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Lesson 1: Introduction to Engineering 

• What is engineering? 
• Why engineering? 
• What do engineers do? 
• Activity: Is this engineering? 
• Activity: Identify problem/solution 

 

 
 

Word Bank 
Fill in the blanks below using these words: 

Problem 
Irrigation system 
Math 
Magnetic levitation 
Experimentation 
Designing 
Math 
Creating 
Components 
solves problems! 
 

Scientists 
airplane 
Tractor 
Engineers 
Chemical 
Physical  
Science 
Boat 
Cancer 

            

What is engineering? 

Class Discussion: Can anyone tell us what they think engineering is? 

“_______________ study the world that is; __________________ create the world that has 
never been.” – Theodore van Karman (aerospace engineer, 1881-1963) 

Engineers are everywhere. In fact, we are all engineers in our own respects. Your mom is an 
engineer by creating a complete dinner from a variety of individual ingredients. Your dad is an 

Figure 1: What would the world be like without engineering? How would 
we talk to one another when we’re not together?  
 
 

 Reference: “The World Without Engineers,” Hasaam, 
http://hassam.hubpages.com/hub/World-Without-Engineers. Author 
undetermined. All Rights Reserved. 

 

Sibu Kuruvilla� 6/13/12 3:48 PM
Comment [2]: There	  are	  a	  lot	  of	  blanks	  to	  be	  
filled	  in	  by	  the	  students	  in	  these	  lesson	  plans.	  Make	  
sure	  you	  tell	  the	  students	  to	  stop	  you	  and	  ask	  about	  
any	  blanks	  they	  don’t	  get,	  since	  you	  may	  not	  be	  
reading	  the	  text	  aloud,	  and	  can	  thereby	  miss	  some	  
of	  the	  words.	  	  

Sibu Kuruvilla� 6/13/12 3:29 PM
Comment [3]: To	  introduce	  engineering	  to	  the	  
students.	  

Sibu Kuruvilla� 6/13/12 3:29 PM
Comment [4]: First, ask the class to define what 
engineering is. If minimal response, offer ideas: 
Hold up a cell phone and ask if there is any 
engineering involved in this. Point to the building 
structure and ask the same thing, etc. etc. Anyone 
that responds can be asked to say why.	  

Sibu Kuruvilla� 6/13/12 3:30 PM
Comment [5]: Answers:	  Scientists;	  engineers	  
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engineer when he takes a look at your broken bicycle and puts it back together in a few minutes. 
You are an engineer when you go to school – you walk, take the bus, and then walk again to 
school; you are creating a system from the individual components that are found in “nature.”  

That is what engineering is: _________________ and _______________ a complex system from 
simple ____________________ to solve a ____________________.  

What comes from engineering? 

So what are the fruits of engineering? What would an “engineered” product be? We already 
talked about a cell phone being one, and the building you’re sitting in too. Also, your home is an 
engineered system. The food you are provided is available because of an engineered system that 
was able to provide water to the plants/animals, harvest those items, and then transport them to 
your table.  

For example, the _______________________ ________________________ train in Figure 2 is 
a train that operates with no wheels – it is actually floating! Instead of using wheels, it uses 
electricity and magnetism to propel itself along a guided track. This allows it to travel at much 
higher speeds, because it is never actually touching anything! Also, it is a much more 
comfortable ride for the passengers. Germany, China, the UK, and Japan are all implementing 
these trains into their everyday lives. 

Class discussion: What are some other engineered products?  

Why engineering? 

What is the purpose of all 
these engineered things? 
Why is engineering even 
important? Because it 
_______________ 
_________________! 
Engineering creates solutions 
to our issues and needs. For 
example, the reason why a 
____________ was created 
was because it was hard for 
us to move across water 
without it. A _____________ 
lets us harvest crops easier 
because it takes much more 
time and effort for us to do it 
by hand. Thousands of 
engineers are working on 
finding a cure for 
______________ because it is a major problem we face as humans.  

 

Figure 2: The Maglev train developed in China. This train 
uses electromagnetic levitation and propulsion to travel, 
instead of the traditional mechanical method. That means it 
has no wheels, and is actually floating (or levitating) in the air 
as it moves! 

  Brian Harrington Spier, Wikimedia Commons, 
http://commons.wikimedia.org/wiki/File:The_Maglev_-
_ci%27_fu%27_lie%27_che.jpg  

 

Sibu Kuruvilla� 6/13/12 3:31 PM
Comment [6]: Designing;	  creating;	  components;	  
problem	  

Sibu Kuruvilla� 6/13/12 3:33 PM
Comment [7]: Introduce	  to	  the	  children	  what	  we	  
get	  from	  engineering.	  Point	  out	  common	  things	  that	  
they	  know	  so	  that	  they	  can	  easily	  relate	  to	  the	  field	  
–	  bike,	  bus,	  oven,	  even	  a	  pencil.	  	  

Sibu Kuruvilla� 6/13/12 3:38 PM
Comment [8]: Magnetic	  levitation	  

Sibu Kuruvilla� 6/13/12 3:37 PM
Comment [9]: Magnetic	  levitation	  train.	  If	  it’s	  
too	  complex	  for	  the	  students	  to	  understand,	  just	  
stress	  the	  fact	  that	  it	  floats	  in	  air!	  

Sibu Kuruvilla� 6/13/12 3:36 PM
Comment [10]: Try	  to	  get	  the	  students	  to	  throw	  
out	  ideas	  of	  other	  engineered	  products:	  Electricity,	  
cars/buses,	  bicycles,	  tables,	  chairs,	  even	  your	  body!	  
	  one	  of	  the	  most	  remarkably	  engineered	  products	  
ever!	  

Sibu Kuruvilla� 6/13/12 3:39 PM
Comment [11]: Solves	  problems!	  

Sibu Kuruvilla� 6/13/12 3:40 PM
Comment [12]: boat	  

Sibu Kuruvilla� 6/13/12 3:40 PM
Comment [13]: tractor	  

Sibu Kuruvilla� 6/13/12 3:40 PM
Comment [14]: cancer	  
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These are all solutions that are created in order to fix the problems we face, to meet the needs of 
our societies, and/or to make living life easier and more efficient.  

How is engineering done? 

Finally, how might someone actually engineer something? What steps are required to go from 
having an issue, to creating the solution? First, engineers identify the problem, or the issue that 
needs to be dealt with or improved. This may be something like the need to provide more water 
for the crops on a farm. They then come up with various solutions (through brainstorming), and 
analyze which solution is the most feasible. To provide more water for the crops, engineers 
could: 1) make it rain more, 2) make the crops drink juice, or 3) collect rainwater and develop a 
system to distribute it to the crops. Once they have decided on a possible solution, the 
engineer(s) design a way to achieve it, using a combination of ____________________, 
_____________, and __________________________________. In the example, engineers 
would probably choose to develop a system using collected rainwater to water the crops. They 
would do this by using math and science principles to design a piping system that can access all 
the crops, and also pump water from the source. They can then test this system to see what 
works, and fix it to make it work efficiently. A system like this is actually in use everywhere 
today, it is called an _____________________ __________________. 

In another example, when travel on land took too much time and effort, and limited the distance 
people could go, some engineers thought of making a way to fly through the air, in order to go 
faster and avoid the delay of land travel. So they thought of developing the 
________________________, which is a very complex system that is based heavily on science 
and math. Airplanes can stay up in the air because of many concepts analyzed by engineers, such 
as ___________________ principles like gravity, drag, and force, or ______________________ 
principles, which determine what materials to make the airplane cabin, wings, and engines out 
of. Finally, ______________ helps an engineer tie everything together – what size wings are 
needed to carry a cabin of 300 people, the engine power required to accelerate the airplane to the 
necessary speed for flight, etc. So engineering is once again, the compilation of a variety of 
individual concepts and ideas, such as those of basic science and math.  

So now that we have talked to you about what engineering is in general, let’s see if you guys and 
girls are able to identify if something is engineering or not.  

Class Activity: Is this engineering? 

On the following worksheet, try to identify which items are engineered by humans, and which 
items are naturally occurring. This will help to see if you can determine what engineering is.  

Summary: 
In this lesson, we learned that engineering is a very essential and useful field for humanity. It 
allows us to solve problems that we face in our everyday lives, as well as develop ways to make 
life easier and more efficient. The next lesson concerning engineering will dive deeper into the 
various disciplines within the field, where we will learn specifically what type of engineer it 
takes to solve various problems.  

Sibu Kuruvilla� 6/13/12 3:54 PM
Comment [15]: Talk	  about	  engineers	  identifying	  
a	  problem,	  brainstorming	  about	  the	  possible	  
solutions,	  then	  designing	  and	  experimenting	  with	  
the	  most	  feasible	  solutions.	  	  

Sibu Kuruvilla� 6/13/12 3:44 PM
Comment [16]: science,	  math,	  and	  
experimentation	  

Sibu Kuruvilla� 6/13/12 3:50 PM
Comment [17]: irrigation	  system	  

Sibu Kuruvilla� 6/13/12 3:54 PM
Comment [18]: Example:	  airplanes	  

Sibu Kuruvilla� 6/13/12 3:50 PM
Comment [19]: airplane	  

Sibu Kuruvilla� 6/13/12 3:53 PM
Comment [20]: physical	  

Sibu Kuruvilla� 6/13/12 3:53 PM
Comment [21]: chemical	  

Sibu Kuruvilla� 6/13/12 3:53 PM
Comment [22]: math	  

Sibu Kuruvilla� 6/13/12 4:05 PM
Comment [23]: Work on the worksheet 
together with the class, going through each item 
and having the kids volunteer their answers.  
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Is this Engineering? Worksheet 
Take a look at each of the items listed below. Is the item a product of engineering? Or not? Make 
your selection and check off the corresponding column.  

  Engineering Not 
Engineering 

 
 
 

Sun 

 
 

 
 
 
 

 
 

 

 
 

Bicycle 

 
 

  

 
 
 

Apple 
 

 
 

  

 
 
 
 
 

Cow 

 
 

  

 
 

Mobile phone 

 
 

  

Sibu Kuruvilla� 6/19/12 9:41 PM
Comment [24]: Have	  the	  students	  identify	  what	  
is	  engineering	  and	  what	  isn’t.	  Give	  them	  5-‐10	  mins	  
to	  complete	  the	  worksheet,	  then	  call	  on	  students	  as	  
you	  go	  through	  the	  answers.	  	  
	  
If	  time	  allows,	  ask	  the	  students	  how	  each	  non-‐
engineering	  item	  can	  actually	  be	  used	  in	  
engineering.	  For	  example,	  the	  sun	  is	  not	  an	  
engineered	  system,	  but	  it	  could	  be	  very	  useful	  in	  
solar	  powered	  systems.	  	  

Sibu Kuruvilla� 6/19/12 9:38 PM
Comment [25]: yes	  

Sibu Kuruvilla� 6/19/12 9:39 PM
Comment [26]: no	  

Sibu Kuruvilla� 6/19/12 9:39 PM
Comment [27]: no	  

Sibu Kuruvilla� 6/19/12 9:39 PM
Comment [28]: yes	  
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Oil Rig 

 
 

  

 
 
 

Lightning 

 
 

  

 
Table 

 
 

  

 
 
 

Gold 

 
 

  

 
 
 
 
 

Computer 
 

 

  

 
 

Electricity 

 
 

  

Sibu Kuruvilla� 6/19/12 9:39 PM
Comment [29]: yes	  
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Comment [30]: no	  
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Comment [31]: yes	  
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Comment [32]: no	  
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Comment [33]: yes	  

Sibu Kuruvilla� 6/19/12 9:42 PM
Comment [34]: no!	  electricity	  exists	  in	  nature!	  If	  
they	  have	  a	  problem	  understanding	  this,	  refer	  to	  
lightning,	  static	  shock,	  or	  the	  very	  electrons	  and	  
protons	  that	  make	  up	  atoms	  
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House 

 
 

  

 
  
Image sources from table: 
• Sun:  Nicubunu, OpenClipArt, http://openclipart.org/detail/22012/weather-symbols:-

sun-by-nicubunu 
• Bicycle:  Franck Doucet, OpenClipArt, http://openclipart.org/detail/23878/blue-bike-

by-anonymous-23878 
• Apple:  Hans, Pixabay, http://pixabay.com/en/apples-fruit-vitamins-fresh-5880/ 
• Cow:   PixelBandit, Pixabay, http://pixabay.com/en/cow-meadow-animal-landscape-

8317/ 
• Mobile phone:   jhnri4, OpenClipArt, http://openclipart.org/detail/163789/iphone-44s-

by-jhnri4 
• Oil rig:  regelatwork, OpenClipArt http://openclipart.org/detail/7183/oil-rig-by-

regelatwork 
• Lightning:  Joe Monica, OpenClipArt, http://openclipart.org/detail/137905/clouds-and-

lightning-by-jgm104 
• Table:  Benji Park, OpenClipArt, http://openclipart.org/detail/26282/wooden-table-by-

anonymous 
• Gold:  gnokii, OpenClipArt, http://openclipart.org/detail/171507/money-pot-by-gnokii-

171507 
• Computer:  DTRave, OpenClipArt, http://openclipart.org/detail/6024/cartoon-

computer-and-desktop-by-dtrave 
• Electricity:   Liftarn, OpenClipArt http://openclipart.org/detail/2437/plug-and-outlet-

by-liftarn 
• House:  sheikh_tuhin, OpenClipArt, http://openclipart.org/detail/58441/house-by-

sheikh_tuhin 
 

Sibu Kuruvilla� 6/19/12 9:42 PM
Comment [35]: yes	  
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•  

Lesson 2: Introduction to Agriculture 
 

I. What does agriculture mean to you? 
 

II. The World Around Us 
 What is an Ecosystem? 

An ecosystem is a community of living and non-living things that work 
together.  

 Where do our resources come from? 
 

 Do we depend on the world around us? If so how? 
o Food Chain 
o Air Cycle 
o Water Cycle 

 
a) Food chain: The food chain is a description of how food (energy and nutrients) 

flow through the ecosystem starting from the soil (along with energy from the 
sun, air and water) to plants and animals and then back to the soil. 

 
 
 
 
 
 

 
 
 
 
 
 
 

 

 USGS Circular 1316. Figure 14.1. Wikimedia Commons. 
http://commons.wikimedia.org/wiki/File:Chesapeake_Waterbird_Food_Web.jpg  
 

sahitya� 6/22/12 2:00 PM
Comment [36]: Guide	  students	  through	  their	  
daily	  lives	  and	  make	  them	  think	  of	  all	  the	  products	  
of	  agriculture,	  beyond	  just	  food.	  Make	  a	  list	  of	  
popular	  answers	  on	  the	  black	  board	  and	  talk	  about	  
origin	  of	  all	  of	  the	  products,	  leading	  to	  the	  topic	  of	  
how	  the	  world	  around	  us	  provides	  us	  with	  resources.	  
	  

sahitya� 6/22/12 2:00 PM
Comment [37]: Pick	  an	  item	  from	  the	  list	  and	  
ask	  the	  students	  to	  identify	  the	  path	  which	  led	  to	  the	  
making	  of	  the	  item.	  It	  may	  help	  to	  work	  backwards	  
in	  the	  path.	  (e.g.	  Bicycle	  tires	  	  Rubber	  	  Plants).	  	  	  
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 The food chain starts with the sun, air, water and soil. 

Reference: “Description of Food Chain,” Geography4Kids, 
http://www.geography4kids.com/files/land_foodchain.html. Copyright 1997-2012 
Andrew Rader Studios, All rights reserved.  

 
 

b) Air Cycle 

                         
 “A Simple Tree” by Peter M., OpenClipArt, http://openclipart.org/detail/80/tree-by-peterm  

 “Color Drawing of A Lion” by Steve Lambert, OpenClipArt, http://openclipart.org/detail/6950/lion-
by-stevelambert-6950  

 
 

 Plants use sunlight and carbon dioxide to make food and release oxygen into 
the atmosphere (Photosynthesis) 

 Animals use oxygen for energy and release carbon dioxide into the 
atmosphere (Respiration) 

OXYGEN 

CARBON DIOXIDE 

Photosynthesis 

Respiration  
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c) Water cycle 
 

 
 

 The water cycle is an example of a naturally occurring system in which the 
substance can change form and location.  

 Land topography influences the distribution of water and pollutants.  
 Water pollution is caused by point and non-point sources.  
 The quality of water sources, such as streams and drinking water, can be 

determined by measuring factors such as temperature, pH, turbidity, dissolved 
oxygen, and total dissolved solids. 

 
 

 
 U.S. Geological Survey, Wikimedia Commons, 

 http://commons.wikimedia.org/wiki/File:Water_cycle.png 
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Activity 1: Eco-Jar 
 
Objective:  The students should be able to identify the life forms in the Eco-Jar and how 
they sustain each other.   

 
 
Take a close look at the jar your instructor is passing around and answer the following 
questions 
 
Does the Jar represent an Ecosystem? 
 
 

i. List the Producers, Consumers and Decomposers in the Eco-Jar 
 
 
Consumers: 
 
 
 
Producers: 
 
 
 
Decomposers: 

 
 
 

ii. Sketch a food, air and water cycle for the Ecosystem in the Eco-Jar 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

sahitya� 1/22/13 2:46 PM
Comment [38]: Materials	  Required:-‐	  
oEco-‐Jar	  
	  
Let	  the	  students	  take	  a	  close	  look	  at	  the	  jar	  and	  its	  
contents.	  Draw	  an	  analogy	  between	  the	  jar	  and	  the	  
earth.	  Ecosystems	  have	  no	  fixed	  size. An	  ecosystem	  
can	  be	  as	  large	  as	  a	  desert	  or	  a	  lake	  or	  as	  small	  as	  a	  
tree	  or	  a	  puddle	  or	  a	  jar!	  
	  
Identify	  the	  contents	  of	  the	  jar	  before	  the	  students	  
start	  
Living	  
Shrimp	  
Algae	  
Bacteria(not	  visible)	  
Non-Living 
Air	  (Oxygen	  and	  Carbon	  Dioxide)	  
Water	  
Organic	  Waste	  
Stones	  
Shells	  
Guide the students through the questions 
The	  picture	  below	  is	  not	  available	  to	  the	  students	  
and	  is	  for	  your	  reference.	  You	  may	  share	  it	  with	  
them	  after	  the	  activity.	  
 
(Removed picture of “How EcoSpheres Work”, 
copyrighted to 1997 - 2013 Abundant Earth, Inc., 
accessible at: 
http://www.abundantearth.com/store/ecosphere.html
) 
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Make your own Eco-Jar at home! 
 

 Reference: Exercise adapted from “How to Make a Marine Ecosphere,” CC BY 
NC SA WikiHow, available at http://www.wikihow.com/Make-a-Marine-Ecosphere 

  
 
Materials Required: 

• Glass Jar 
• Sand or Gravel 
• Ocean water or de-chlorinated water and ocean salt 
• Small ocean live rock 
• Coral or other marine plant 
• Shrimp, Plankton 
• Sea shells 

 
Steps: 

1. Grow algae with the sun on a few rocks, which you will add to the Jar. Take an algae 
sample (from a river or pond area) put it on the rocks and place it in the sun for a few 
days. 

2. Get a Jar and make sure it's transparent so that sunlight can pass through. 
3. Wash the jar with ONLY warm water as soap will kill the organisms. Then dry your 

jar using a towel. 
4. Collect sand from either the playground, or a very clean beach. Then wash it with 

water for 70 seconds WITHOUT draining the sand. And dry it. 
5. Add ocean water. It can be made by mixing de-chlorinated water & ONLY ocean salt. 

Table salt is too poisonous to organisms in your "ocean". 
6. After you put sand in (about 1" deep), fill you jar with seawater, leaving about 2" of 

airspace on the top. Then add a small live sea rock, which should have both phyto & 
zooplankton.  Now add the plants (algae). 

7. Always include small seashells. It will not only stabilize pH levels, but also it stimulates 
the ocean floor. 

8. Now add animals (shrimp). 
9. After you add the animals into your jar, seal it up and never open it again. Just put 

on your windowsill and watch it. 
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III. Agriculture 

 
According to Wikipedia (http://en.wikipedia.org/wiki/Agriculture), agriculture id defined 
as: “the cultivation of animals, plants, fungi, and other life forms for food, fiber, and 
other products used to sustain life.” 
 

o Prior to agriculture 
 People spent most of their time hunting and gathering food 

 Known as “Hunters and Gatherers” 
 Populations tended to be lower 
 People had to travel nearly all the time 

 Food sources would become depleted 
 Referred to as “nomadic” 
 Lived in non-permanent shelter 

o The start of agriculture… 
 People began to plant seed and tame animals 

 Called “Domestication” 
 Soon after, they searched for better ways to grow food 

 Much early progress was made by “trial and error” 
 Began about 10,000 years ago 
 Allowed humans to settle down, develop villages, and form a society 

o Modern Day Agriculture 
 Affordability  

 The goal of modern agriculture practices is to help farmers provide an 
affordable supply of food to meet the demands of a growing 
population. 

 With modern agriculture, more crops can be grown on less land 
allowing farmers to provide an increased supply of food at an 
affordable price. 

 Sustainability 
 Current farming methods have resulted in over-stretched water 

resources, high levels of erosion and reduced soil fertility. There is not 
enough water to continue farming using current practices; therefore 
how we use critical water, land, and ecosystem resources to boost crop 
yields must be reconsidered.  

 Technological advancements help provide farmers with tools and 
resources to make farming more sustainable.   

sahitya� 6/22/12 2:00 PM
Comment [39]: Introduce	  the	  evolution	  of	  
agriculture.	  Remember	  to	  introduce	  the	  concept	  of	  
societal	  need	  driven	  evolution	  (e.g.	  the	  need	  for	  
mechanized	  farming	  (tractors)	  came	  into	  being	  due	  
to	  increased	  food	  demand	  which	  could	  not	  be	  met	  
by	  conventional	  farming	  techniques	  (cattle).)	  
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Activity 2: Timeline 
Place the agricultural history events cards in the order in which you think they might have 
occurred. Along with your group, think and discuss about which event might have followed or 
led to which other event. Once you think you have the correct sequence of events get it checked 
by your instructor. Then attach the events together with a masking tape in the correct order. 
 

 
Genetically modified plants are cultivated 
around the world. 

 

 

With the market for agriculture produce 
growing beyond small communities, farmers 
looked to improving yields and efficiency of 
farming. Chemical fertilizers and gasoline 
powered tractors made an appearance. 

 
 
People soon realized the potential of 
domesticating animals for food and as beasts 
of burden. First signs of domestication of 
cattle and chicken were found in India. 
 
 

 

 
 
The first global exchange of crops also called 
the Medieval green revolution occurred. This 
led to the establishment of a global economy as 
traders travelled all over the world exchanging 
crops and farming ideas. 

 

sahitya� 6/22/12 2:00 PM
Comment [40]: Materials Required:- 
oActivity	  Sheet	  
oMasking	  Tape	  
Prepare students for an activity called Timeline, a 
game where they will guess the correct order of 
events in Agricultural History.  Separate students 
into teams of two or three.  They will then call you to 
verify their answers.  If they have any incorrect 
answers, guide them through the sequence of events 
rather than pointing out the incorrect answers. The 
letters at the top left corner of each event spell 
KEYSMITH when put in the correct order. This is to 
serve as your key and should not be revealed to the 
students. 
After the activity discuss the significance of each 
event 
	  

sahitya� 6/22/12 2:00 PM
Comment [41]: Notes about the event: 
K: Hunters and Gatherers 
E: Agriculture began in 9800 BC. About 12000 years 
ago!  
Y: Animal domestication and agriculture go hand in 
hand, since the beginning! 
S: Irrigation: Construction of canals, optimization of 
water usage; who is at work? Engineers! 
M: Agriculture gave rise to trade, economy and 
engineering 
I: Chemical fertilizers and tractors are being used 
since 1890 
T: Industrial agriculture is a form of modern 
farming that refers to the industrialized production 
of livestock, poultry, fish, and crops. The methods of 
industrial agriculture are technoscientific, economic, 
and political. They include innovation in agricultural 
machinery and farming methods, genetic technology, 
techniques for achieving economies of scale in 
production, the creation of new markets for 
consumption, the application of patent protection to 
genetic information, and global trade.  
H:	  Genetically	  modified	  organisms	  are	  organisms	  
whose	  genetic	  characteristics	  have	  been	  altered	  by	  
the	  insertion	  of	  a	  modified	  gene	  or	  a	  gene	  from	  
another	  organism	  using	  the	  techniques	  of	  genetic	  
engineering.	  They	  have	  been	  developed	  for	  various	  
purposes:	  resistance	  to	  pests,	  herbicides	  or	  harsh	  
environmental	  conditions;	  improved	  shelf	  life;	  
increased	  nutritional	  value	  -‐	  and	  many	  more.	  
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Birth of industrial agriculture. Industrial 
agriculture is a form of modern farming that 
refers to the industrialized production of 
livestock, poultry, fish and crops. 
 
 

 
 
The earliest evidence of cultivation was 
found to have occurred in 9800BC. Wheat 
was grown in now what we call Syria. 
 

 
As the supply of food from cultivation and 
domestication of animals grew, the population 
increased. The water from rains could no 
longer sustain the demand for cultivation; 
hence organized irrigation systems like canals 
began to emerge. 

 
Humans at first obtained all their food from 
wild animals and plants (hunters and 
gatherers) and did not grow their own food.  
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Image sources from table: 
• Genetically modified plant:  Seb951, Wikimedia Commons, 

http://en.wikipedia.org/wiki/File:Transformation_with_Agrobacterium.JPG 
• Plow:  Gas Power Age, Winnipeg, 1910. Provided by the Manitoba Historical Society, 

http://www.mhs.mb.ca/docs/features/timelinks/imageref/ref0419.shtml. 
• Domestication:  Image by Jan van Gool, 

http://www.wikigallery.org/wiki/painting_208774/Jan-van-Gool/Cattle-in-a-Meadow 
• Crop Trade:  Vincenzo Campi, 1580, Wikimedia Commons, 

http://commons.wikimedia.org/wiki/File:Vincenzo_Campi_-_The_Fruit_Seller.jpg 
• Industrialization:  Image: Richard Croft, Wikimedia Commons, 

http://commons.wikimedia.org/wiki/File:Agriculture_and_Industry_-_geograph.org.uk_-_209054.jpg 
• Egyptian tomb:  Anonymous Egyptian tomb artist(s), Wikimedia Commons, 

http://commons.wikimedia.org/wiki/File:Egyptian_harvest.jpg 
• Irrigation:  by Nigel Mykura, Wikimedia Commons, 

http://commons.wikimedia.org/wiki/File:Watercress_Bed_Irrigation_channel_-_geograph.org.uk_-
_723290.jpg 

• Hunter Gatherers:  by Pierre Barrère, Wikimedia Commons, 
http://commons.wikimedia.org/wiki/File:Kalina_hunter_gatherer.jpg  
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Lesson 3: Disciplines in Engineering 

• Society’s Problems/Needs 
• Disciplines of Engineering 
• Meet the Disciplines Worksheet 
• Identify the Problem and Assign Engineers 

 

Word Bank 
Fill in the blanks below 

 
Construction 

Electrical/computer engineering 
Geology 

Mineral deposits 
Civil 

Diverse 
 
 

Electrical engineer 
Computer engineering 

Demanding 
Biology and medicine 

Environment 
 

Society’s Problems/Needs 

Societies face a variety of problems that need to be addressed. One community may have issues 
that range from harvesting their crops to communicating with the nearby town. Just as in the 
physical sciences, where there are various disciplines for the wide range of specialties (a 
physicist may have a hard time doing the work of a biologist), engineering is also divided into 
many subjects. Having various groups of engineers that specialize in a certain field makes 
addressing the problems we face much easier to solve, since each group can focus on a specific 
problem, instead of everyone trying to spread their resources across all the problems.  

For example, a community may be helped by one type of engineer to address their crop-
harvesting issues, and another type of engineer to help them communicate with the nearby town. 
Other issues that can be addressed by engineers are: 

• Accessing clean water 
• Building a bridge 
• Telecommunication 
• Energy solutions 
• Food shortages 
• Better medical equipment 

• Recycling and reusing materials 
• Planning the layout of a city 
• Waste management 
• Transportation 
• Treating of diseases 
• Designing a building 
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Figure 1: A circuit board like the one shown here is 
crucial to almost all complex electronic devices, and is 
designed by electrical/computer engineers.  
 

 Image by Jörgen Nixdorf, source: 
http://en.wikipedia.org/wiki/File:MOS_Technologies_large.jpg     

 

As you can see, the fields where engineers are needed is very _____________________ and 
___________________, and that is why we need a variety of different types of engineers. Let’s 
take a look at the main disciplines of engineering and see how they each contribute to society.  

Engineering Disciplines 

____________/___________ 
Engineering:  

As an ______________________ 
_______________________, you 
could develop components for 
some of the most fun devices 
(MP3 players, digital cameras, or 
roller coasters) as well as the most 
essential to life (medical tests or 
communications systems). The 
largest field of engineering 
encompasses the macro (huge power grids that light up cities, for example) as well as the micro 
(including a device smaller than a millimeter that tells a car’s airbags when to inflate).  As an 
electrical engineer, you might work on robotics, computer networks, wireless communications, 
or medical imaging—areas that are at the very forefront of technological innovation (Fig. 1). 
___________________ _____________________, a sub-field of electrical engineering, is the 
design, construction, implementation, and maintenance of computers and computer-controlled 
equipment for the benefit of humankind. 

______________  Engineering:  

What would it feel like to have the expertise to build a school that could withstand an 
earthquake, a road system that puts an end to chronic traffic jams, or a sports stadium that offers 
everyone a great view? As a civil engineer, your job would be to oversee the -
_________________________ of the buildings and infrastructure that make up our world: 
highways, skyscrapers, railways, bridges, and water reservoirs, as well as some of the most 
spectacular and high-profile of all engineering feats—think of the world’s tallest building, the 
towering Taipei 101 in Asia, or the Chunnel, the 31-mile-long tunnel beneath the English 
Channel. Civil engineers are fond of saying that it’s architects who put designs on paper, but 
engineers who actually get things built.  

Sibu Kuruvilla� 6/17/12 1:50 PM
Comment [42]: Diverse;	  demanding	  

Sibu Kuruvilla� 6/17/12 1:50 PM
Comment [43]: Talk	  through	  the	  disciplines,	  
making	  sure	  to	  give	  a	  brief	  overview	  of	  each.	  Be	  
careful	  though,	  because	  it	  may	  take	  a	  lot	  of	  time	  to	  
go	  through	  each.	  So	  try	  to	  be	  brief,	  but	  make	  sure	  
they	  fill	  in	  their	  blanks.	  

Sibu Kuruvilla� 6/17/12 1:50 PM
Comment [44]: Electrical/Computer	  Engineering	  

Sibu Kuruvilla� 6/17/12 1:50 PM
Comment [45]: Electrical	  engineer	  

Sibu Kuruvilla� 6/17/12 1:50 PM
Comment [46]: Computer	  engineering	  

Sibu Kuruvilla� 6/17/12 1:50 PM
Comment [47]: Civil	  

Sibu Kuruvilla� 6/19/12 10:45 PM
Comment [48]: construction	  
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Figure 2: The beautiful city of Hong Kong is lined with dozens of 
skyscrapers and buildings, all planned and designed by civil engineers.  
 

  Image by Kent Wang, source: 
http://commons.wikimedia.org/wiki/File:Hong_Kong_skyline_night_lights.jpg  

 

Geological and Geophysical Engineering: 
Geological and Geophysical Engineers draw on the science of ___________________ to study 
the earth, using engineering principles to seek and develop deposits of natural resources and 
design foundations for large buildings, bridges, and other structures. (Related engineering fields 
include Civil, Mineral, Mining, and Petroleum.) 

Mining Engineering: 
Mining engineers study all phases of extracting ___________________ ___________________ 
from the earth. They design mines and related equipment and supervise their construction and 
operation. They also work to minimize the environmental effects of mining. These engineers 
supply energy and rare materials to meet the world's needs. 
 
Agricultural and Biological 
Engineering: 
Agricultural engineers apply knowledge of 
engineering technology and science to 
agriculture and the efficient use of 
biological resources. In addition to 
creating advances in farming and 
agriculture, agricultural engineers apply 
engineering design and analysis to 
protecting natural resources, develop 
power systems to support agriculture, and 
provide environmental controls. 
 

 

 
Figure 3: Tractors built by agricultural 
engineers have revolutionized the farming 
industry.  
 

 Image by Lucarelli, source: 
http://commons.wikimedia.org/wiki/File:Same_Tiger_Si
x_105_tractor.jpg.  
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Mechanical Engineering:  
As a mechanical engineer, you might develop a bike lock or an aircraft carrier, a child’s toy or a 
hybrid car engine, a wheelchair or a sailboat—in other words, just about anything you can think 
of that involves a mechanical process, whether it’s a cool, cutting-edge product or a life-saving 
medical device. Mechanical engineers are often referred to as the general practitioners of the 
engineering profession, since they work in nearly every area of technology, from aerospace and 
automotive to computers and biotechnology. 
 

Chemical Engineering: 
Everything around us is made of chemicals. Chemical 
changes can be used to produce all kinds of useful 
products. Chemical Engineers discover and 
manufacture better plastics, paints, fuels, fibers, 
medicines, fertilizers, semiconductors, paper, and all 
other kinds of chemicals.  Chemical Engineers also 
play an important role in protecting the environment, 
inventing cleaner technologies, calculating 
environmental impacts, and studying the fate of 
chemicals in the environment. 
 
Environmental Engineering: 
Environmental Engineering is the study of ways to 
protect the _____________________. Most of us 
care deeply about stopping pollution and protecting 

our natural resources.  Imagine yourself having more than just a passion for saving our 
environment, but also possessing the actual know-how to do something about these alarming 
problems!  As an environmental engineer, you’ll make a real difference in the survival of our 
planet by finding ways of cleaning up our oceans, rivers, and drinking water, developing air 
pollution equipment, designing more effective recycling systems, or discovering safe ways to 
dispose of toxic waste. 
 
Bioengineering/Biomedical Engineering: 
Bioengineers study living systems and apply 
that knowledge to solve various problems. 
They study the safety of food supplies, keep 
desirable organisms alive in fermentation 
processes, and design biologically based 
sensors. Bioengineering is widely used to 
destroy wastes and clean up contaminated 
soil and water. These engineers contribute 
greatly to human health and the 
environment. 
Biomedical Engineers study 
_____________________ and 
______________________ to develop 

 
Figure 4: Together with electrical 
engineers, mechanical engineers build 
robots like the one pictured here.  
 

 Image by Milky, source: 
http://commons.wikimedia.org/wiki/File:Robot
_Asimo.jpg  

 

 
Figure 5: Biomedical engineers work with 
mechanical and materials engineers to 
develop prosthetic (artificial) limbs, such as 
the leg fitted to the man in this picture. 
 

 Image by Virginia Reza, source: 
http://commons.wikimedia.org/wiki/File:Army.mil-
2007-02-07-103140.jpg  
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technologies related to health care. They develop medical diagnostic machines, medical 
instruments, artificial organs, joint replacement parts, and prosthetic devices. Rapid advances in 
these areas will probably continue throughout your lifetime. 

                    
Materials Engineering: 
Materials Engineers solve problems by relying on their creative and technical skills - making 
useful products in many forms from common as well as exotic materials. Every day we use a 
multitude of these products. Each time we talk on the phone, use a computer, or heat food in a 
microwave oven, we are using products made possible by the inventions and designs of 
engineers working with ceramics and other materials. 
 
Aerospace Engineering:  
Aerospace engineers design, analyze, model, simulate, and test aircraft, spacecraft, satellites, 
missiles, and rockets. Aerospace technology also extends to many other applications of objects 
moving within gases or liquids. 
Examples are golf balls, high-speed 
trains, hydrofoil ships, or tall 
buildings in the wind. 
As an aerospace engineer, you might 
work on the Orion space mission, 
which plans on putting astronauts 
back on the moon by 2020. Or, you 
might be involved in developing a 
new generation of space telescopes, 
the source of some of our most 
significant cosmological discoveries. 
But outer space is just one of many 
realms to explore as an aerospace 
engineer. You might develop 
commercial airliners, military jets, or 
helicopters for our airways. And 
getting even more down-to-earth, you 
could design the latest ground and sea 
transportation, including high-speed 
trains, racing cars, or deep-sea vessels that explore life at the bottom of the ocean.  
 
Nuclear Engineering:  
Finally, nuclear engineers harness the power of the atom to benefit humankind. They search for 
efficient ways to capture and put to beneficial use those tiny natural bursts of energy resulting 
from sub-atomic particles that break apart molecules. As a nuclear engineer, you may be 
challenged by problems in consumer and industrial power, space exploration, water supply, food 
supply, environment and pollution, health, and transportation. Participation in these broad areas 
may carry you into many exciting and challenging careers. These may include interaction of 
radiation with matter, radiation measurements, radioisotope production and use, reactor 
engineering, and fusion reactors and materials. 
 

 
Figure 6: Aerospace engineers develop the 
machines that allow us to fly through air, and into 
space. 
 

 Image by Kirbstr, source: 
http://commons.wikimedia.org/wiki/File:Space_Shuttle_Dis
covery_Transport.jpg.  
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University of Liberia offers: 
− Civil engineering 
− Mining engineering 
− Electrical engineering  
− Geology 
− Mechanical Engineering 

 
Class Activity: Meet the Disciplines Worksheet 
Now that you have an introduction to the various disciplines of engineering, let us see if you can 
identify which ones would do certain jobs. To help you, you can use the flashcards provided for 
you at the end of this section. These flashcards have pictures to help identify what each 
discipline of engineering does. Take a look through them and see if you can point out the 
different things these specific engineers can create.  
 
Once you have gone through the flashcards, work through the “Meet the Disciplines” worksheet 
at the end of this section. This worksheet is meant to help you guys identify the roles of the 
engineering disciplines, and how each one would be applied to certain situations. Go ahead and 
work on them together in your group, and see who can fill them out the fastest. The first 2 groups 
to get them completed with 3 or less wrong will get a prize! 
 
Class Activity: Identify Problems and Assign Engineers 
We have already mentioned a variety of problems that society faces, as seen in the following list 
in your handbook, as well as up on the board. Can you identify what the particular problem is? 
What engineers may be useful for solving these problems? Try filling out the following table and 
write down both the issue and the engineering disciplines that may be most useful.  

• Accessing clean water 
• Building a bridge 
• Telecommunication 
• Energy solutions 
• Food shortages 
• Better medical equipment 

 

• Recycling and reusing materials 
• Planning the layout of a city 
• Waste management 
• Transportation 
• Treating of diseases 
• Designing a building 

Keep in mind, there definitely is not one right answer, and in fact almost every process would 
require at least a few different types of engineers. 
Finally, can you identify 2 issues you face here in Liberia? What is the problem and what type of 
engineers would it take to solve it? 

 

Sibu Kuruvilla� 6/19/12 11:07 PM
Comment [53]: Explain	  to	  the	  students	  which	  of	  
these	  disciplines	  are	  the	  prominent	  ones	  at	  the	  
University	  of	  Liberia.	  
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Comment [54]: Have	  the	  students	  cut	  out	  the	  
flashcards	  at	  the	  end	  of	  the	  section,	  and	  let	  them	  
look	  through	  the	  various	  pictures	  on	  them.	  Then	  
have	  them	  do	  the	  “Meet	  the	  Disciplines”	  worksheet	  
that	  is	  also	  found	  at	  the	  end	  of	  the	  section.	  	  
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Comment [55]: Go over the answers with the 
group, asking if other disciplines could be applied to 
certain situations, if applicable, and make sure all 
students understand why. Then for the fastest 2 
groups with 3 or less wrong, give them a prize. 	  

Sibu Kuruvilla� 6/17/12 1:50 PM
Comment [56]: Write the problems listed above 
in the first section up on the board so all students can 
see it, and leave room next to each one. Fill the table 
out on the board, while the students fill out their 
own.  
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Comment [57]: Have students volunteer their 
answers for each row in the table. When they 
answer, ask them why/how a certain engineer would 
be useful. If they don’t have ideas at first, offer 
examples:   
1. Agricultural engineers would be needed to help 
with food supply because they grow and ship food.  
2. Environmental engineers and mechanical 
engineers would be needed to develop an electric 
car.  
3. Biomedical, materials, and chemical engineers 
would all be needed to develop better and lighter 
prosthetic limbs.  
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Identify Problems and Assign Engineers  

 
Task Issue/Problem Disciplines of 

Engineering 
 

Accessing clean water 
Contamination 

Disease 
Famine 

Chemical 
Agricultural 

Environmental 

 
 

Building a bridge 

  

 
 

Telecommunication 

  

 
 

Energy solutions 

  

 
 

Food shortage 

  

 
 

Better medical equipment 

  

 
Recycling and reusing 

materials 

  

 
 

Planning the layout of a city 

  

Sibu Kuruvilla� 6/19/12 10:00 PM
Comment [59]: Problem:	  Travel,	  accessing	  
resources,	  connecting	  communities	  
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Sibu Kuruvilla� 6/19/12 10:00 PM
Comment [63]: P:	  disease,	  lack	  of	  adequate	  
medicine,	  current	  expensive	  treatment	  methods	  
	  
D:	  biomedical,	  chemical,	  materials	  

Sibu Kuruvilla� 6/19/12 10:02 PM
Comment [64]: P:	  lack	  of	  resources,	  saving	  the	  
Earth,	  conserving	  energy,	  high	  cost	  of	  making	  new	  
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Waste management 

  

 
Transportation 

  

 
 

Treating of diseases 

  

 
 

Designing a Spaceship 

  

 
Building a Mine 

 

  

 
Problem #1: 

 

  

 
Problem #2: 

 

  

                         
 

Meet the Disciplines Flashcards 
 
 

Reference: eGFI cards for types of engineering. Copyright 2012 American Society for 
Engineering Education, All Rights Reserved. Workshop is accessible at: http://teachers.egfi-
k12.org/wp-content/uploads/2010/12/cards-worksheet-elementary-school.pdf. Images for 
matching professions are accessible at: http://www.egfi-k12.org/engineer-your-path/on-the-job/.  
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Sibu Kuruvilla� 6/19/12 10:12 PM
Comment [67]: P:	  efficient	  travel,	  pollution,	  lack	  
of	  resources	  (oil)	  
	  
D:	  Mechanical,	  materials,	  civil	  (planning	  city	  layout)	  

Sibu Kuruvilla� 6/19/12 10:12 PM
Comment [68]: P:	  disease,	  famine,	  hunger	  
	  
D:	  biomedical,	  materials,	  mechanical	  

Sibu Kuruvilla� 6/19/12 10:14 PM
Comment [69]: P:	  Lack	  of	  efficient	  travel	  to	  
outer	  space,	  space	  race,	  search	  for	  the	  unknown,	  
power	  struggle	  between	  countries	  
	  
D:	  aerospace,	  materials,	  mechanical	  

Sibu Kuruvilla� 6/19/12 10:18 PM
Comment [70]: P:	  Need	  for	  more	  resources	  
(gold,	  oil,	  coal,	  etc.),	  need	  for	  newer,	  better	  
materials	  
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Comment [71]: Don’t	  give	  students	  the	  answers.	  
Make	  sure	  they	  are	  creative	  and	  offer	  ideas.	  These	  
hints	  below	  are	  only	  provided	  in	  case	  there	  is	  
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Some	  ideas:	  
•HIV/AIDS	  and	  Malaria	  
o	  P:	  expensive	  sexual	  protection,	  lack	  of	  knowledge	  
of	  self-‐contamination	  
o	  D:	  biomedical	  engineers	  for	  cheaper	  tests,	  
materials	  for	  cheaper	  protection	  
•Poverty/Hunger	  
•Environmental	  Sustainability	  
•More	  efficient	  transportation	  (bikes,	  bus	  system,	  
train)	  
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Lesson 4: Disciplines in Agriculture 
 

I. Agriculture is more than just growing plants.  
 

Agriculture can be broadly divided into seven different disciplines.  

• Agribusiness systems 
• Animal systems 
• Environmental Service Systems 
• Food Products and Processing Systems 
• Natural Resource Systems 
• Plant Systems 
• Power, Structural and Technical Systems 

   
1. Agribusiness Systems: Agribusiness is the coordination of all activities that contribute to the 

production, processing, marketing, distribution, financing and development of agricultural 
commodities and resources. This includes food, fiber, wood products, natural resources, 
horticulture, and other plant and animal products and services. Agribusiness is a high-tech 
industry that uses satellite systems, computer databases and spreadsheets, biotechnology and 
many other innovations to increase efficiency and profitability. Sample occupations 
 Agricultural marketing specialists:  Agricultural marketing specialists assist producers and 

distributors of agricultural products by providing product promotional services, monitoring 
and reporting economic conditions and coordinating and channeling information among 
producers, distributors and buyers 

 Agricultural Loan Officer or Insurance agent: Agricultural Loan Officers are the link 
between farmers and funding agencies. They help farmers plan for upcoming money needs 
by advising them about available loan opportunities and helping them complete financial 
records. They also educate farmers about crop insurances. 

 

2. Animal Systems: People who work in the animal systems discipline work to develop better, 
more efficient ways of producing and processing meat, poultry, eggs and dairy products. They 
study genetics, nutrition, reproduction, growth and development of domesticated farm animals.  
 Animal Geneticist: Animal geneticists try to understand gene functions and how these 

affect important traits such as growth, reproduction, disease resistance, or behavior 
 Aquaculturist: Aquaculturists cultivate marine or freshwater food fish, such as salmon and 

trout, or shellfish, such as oysters and clams, under controlled conditions. 
 Animal Nutritionist: Animal nutritionists formulate diets for food, companion, and zoo 

animals. They work with mammals, birds, and fish. The diets they create must be 
nutritionally sound, good tasting, and economical for the ages and types of animals that will 
use them. 

 

sahitya� 6/22/12 2:03 PM
Comment [73]: Use	  the	  Timeline	  activity	  (Lesson	  
2:	  Introduction	  to	  agriculture,	  Activity	  2:	  Timeline)	  to	  
identify	  different	  aspects	  of	  agriculture	  apart	  from	  
growing	  plants.	  For	  instance	  
oIrrigation	  
oTrade	  
oAnimals	  
oMachinery	  to	  harvest	  
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Comment [74]: This	  lesson	  will	  proceed	  by	  
introducing	  each	  of	  the	  disciplines	  and	  then	  
identifying	  a	  few	  occupations	  which	  each	  discipline	  
leads	  to.	  The	  occupations	  discussed	  are	  a	  few	  of	  
many	  options,	  be	  free	  to	  introduce	  any	  other	  
occupation	  you	  know	  about	  and	  which	  may	  fit	  into	  a	  
particular	  discipline.	  
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3. Environmental service Systems: People who work in the environmental service systems 
discipline are involved in water and air pollution control, recycling, waste disposal and public 
health issues. They design municipal sewage and industrial wastewater systems.  
 Toxicologist: Toxicologists study the adverse effects of chemicals on living organisms 

 Environmental Engineer: Environmental engineers and technicians conduct hazardous-
waste management studies, evaluate the significance of the hazard, offer analysis on 
treatment and containment, and develop regulations to prevent mishaps. 

 Environmental Compliance Assurance Manager: Environmental Compliance Assurance 
Managers analyze scientific data, develop environment compliance policies and perform 
quality control checks 

 
4. Food Products and Processing Systems: People who work in the food products and 

processing discipline discover new food sources, analyze food content and develop ways to 
process, preserve, package or store food according to industry and government regulations. 
They create new food products to meet consumer needs and inspect food-processing areas to 
ensure that sanitation, safety, quality and waste management standards are met 

 Food Bacteriologist: Food bacteriologists assist in controlling food pathogens by analyzing 
food and dairy products for contamination with microorganisms, biological toxins, and 
antibiotic residues 

 Food and Drug Inspector: Food and drug inspectors impose federal (national) grading 
standards on food and drug products for the purpose of ensuring consumer safety and fair 
pricing 

 Food Engineer: Food engineers develop and operate manufacturing, packaging and 
distribution systems for food products 

 
5. Natural Resource Systems: This discipline works towards development and maintenance of 

natural resources like forests, wildlife, water bodies, soil etc. The protection and conservation of 
these natural resources is the challenge faced by people working in this discipline of agriculture.  

 Soil Scientist: Soil scientists examine the scientific composition of soil as it relates to plant 
or crop growth, and investigate effects of alternative soil treatment practices on crop 
productivity. They develop methods of conserving and managing soil that farmers and 
forestry companies can use.  

 Forestry: Conservation scientists and foresters manage, develop, use and help protect 
forests and rangelands, which supply wood products, livestock forage, minerals and water; 
serve as sites for recreational activities; and provide habitats for wildlife. 
  

6. Plant Systems: People who work in the plant systems discipline study plants and their growth, 
helping producers of food, feed and fiber crops continue to feed a growing population while 
conserving natural resources and maintaining the environment. Individuals in this pathway also 
develop ways to improve the nutritional value of crops and the quality of seeds. They use 
genetic engineering to develop crops resistant to pest and drought.  
 Plant Breeder: Plant Breeders work with researchers to improve agricultural crops. They 

plant seeds, water and weed plant beds, plant-rooted plants, and nurture root cuttings for 
future planting.  They monitor the plant's growth, the plant’s productivity, and its pest 
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infestations and report observations back to the research team. They also make quality 
seeds and saplings available to farmers 

 Plant Pathologist: Plant pathologists deal with the symptoms, causes, damage, spread, and 
control of plant diseases. They study disease processes and look for genetic, biological, 
chemical, or cultural controls for diseases of the plants we use for food and fiber. 

 

7. Power, Structural, and Technical Systems: This discipline applies the knowledge of 
engineering, hydraulics, pneumatics, electronics, power, structure, and controls to the field of 
agriculture.  They develop canal systems for irrigation, machinery for harvesting and 
processing of agricultural produce etc.  

 Agricultural Engineer 
 Civil Engineer 

 Chemical Engineer 
 

II. University of Cuttington  
 
The University of Cuttington in the College of Agriculture and Sustainable development 
offers the following three majors: 

• Plant and Soil Science, BS Degree program 

• Animal Science and Health, BS Degree program 
• Natural Resource Management, BS Degree Program 

 
  

 
 

Jose Alfaro� 3/13/13 8:55 PM
Comment [75]: Chemical	  Engineers	  develop	  the	  
machinery	  necessary	  to	  transform	  food	  items	  to	  be	  
sold	  as	  value	  added	  products.	  	  Some	  examples	  are	  
pasteurization	  for	  milk	  and	  cheese,	  fermentation	  for	  
yeasts,	  beer,	  and	  drinks,	  and	  separation	  for	  creams,	  
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Activity 1: Team Product 
 

You will work as a team in for this activity.  
 Each member in your team should pick one discipline of agriculture from the seven 

disciplines introduced in today’s lecture.  
 Each member should pick a different discipline.  
 Now pick one occupation each 
 You can pick any occupation you know of if you think it can contribute to the product 

your team picks 
 Complete Worksheet 1 

 
 

sahitya� 6/22/12 2:08 PM
Comment [77]: Prepare the students for the 
activity called Team Product. Group the students 
into teams of 3 or 4. The students will pick a 
discipline from the seven disciplines introduced; 
then pick an occupation. The teams will then work 
together to come up with a product which uses 
services of all the occupations within the team.  
Make	  sure	  that	  the	  every	  team	  member	  picks	  a	  
unique	  discipline.	  Occupations	  can	  overlap	  but	  the	  
scope	  of	  work	  will	  be	  dictated	  by	  the	  discipline.	  (E.g.	  
An	  Environmental	  Engineer	  can	  find	  work	  under	  the	  
environmental	  services	  systems	  or	  natural	  resources	  
systems)	  
Below	  is	  an	  example	  solution	  to	  the	  activity	  for	  
your	  reference	  
Discipline	  Occupation	  
Agri-‐business-‐	  Loan	  officer	  
Food	  Processing	  Systems	  Food	  Engineer	  
Plant	  Systems	  Plant	  Breeder	  
Power	  structural	  and	  technical	  systems	  Civil	  
Engineer	  
	  
Team	  Product:	  Rice	  grains	  
Occupation:	  Loan	  Officer	  
Contribution:	  
i.Contacted	  farmers	  interested	  in	  growing	  rice	  
ii.Advised	  farmers	  on	  available	  loans	  for	  buying	  
seeds	  and	  fertilizers	  
iii.Helped	  farmers	  in	  completing	  paper	  work	  to	  
approach	  funding	  agencies	  
	  
Occupation:	  Food	  engineer	  
Contribution	  
i.Developed	  efficient	  packaging	  techniques	  for	  rice	  
grains	  
	  
Occupation:	  Plant	  Breeder	  
Contribution	  
i.Grew	  and	  monitored	  	  rice	  seeds	  for	  pests	  
resistance	  	  
ii.Reported	  results	  of	  best	  performing	  seeds	  to	  
researchers	  	  
	  
Occupation:	  Civil	  Engineer	  
Contribution	  
i.Designed	  and	  constructed	  canals	  to	  provide	  a	  
water	  source	  for	  the	  rice	  crop	  
ii.Constructed	  store	  houses	  to	  store	  grains	  after	  
harvest	  
	  

sahitya� 6/22/12 2:09 PM
Comment [78]: Guide	  the	  students	  through	  
the	  activity	  by	  giving	  them	  suggestions	  for	  products	  
and	  occupations	  
You	  can	  make	  teams	  compete	  for	  the	  fastest	  
team,	  most	  innovative	  team	  (award	  points	  for	  
occupations	  outside	  this	  lecture)	  
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Worksheet 1 

 Name Discipline Chosen Occupation 

Member 1 

   

Member 2 

   

Member 3 

   

Member 4 

   

 
 

 Now identify any product which can be produced by the combined efforts of the 
occupations in your team 

 Identify the contributions by each occupation in your team towards the development of 
your product 

 Complete worksheet 2 
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Worksheet 2 

Team Product: 

 Occupation Contribution 

Member 1 

  

Member 2 

  

Member 3 

  

Member 4 
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Lesson 5: Interdependency of Engineering and Agriculture 
 

Word Bank 
Fill in the blanks using the words below:    

chemical 
Decrease 
Pollution 
chemical 
filtration 

genetic engineering 

Watermill 
Chemical 

water cycle 
irrigation systems 
production costs  
insect-resistant 

drip irrigation 
mechanical 

boiling 
chlorination 

genetically modified 

 
 
Introduction 
So far, we have learned extensively about both engineering and agriculture by themselves. We 
know that engineering is the creation of solutions for society’s problems, while agriculture is the 
cultivation of animals and plants to provide for the community. Each of these fields has their own 
disciplines – electrical, mining, and mechanical fields for engineering, agriculture has its waste 
management, food safety, crop and livestock managing, etc.  
 
Class Discussion: What do these fields have in common? Are they related to each other at all? Do 
they actually depend on one another? 
 
Engineering in Agriculture 
Tractors 
Indeed agriculture and engineering are extremely interdependent, and they rely on each other to 
thrive and succeed. For example, in the early days, soil on a farm was cultivated and aerated by 
the use of a horse-drawn plow (Fig. 1a). When farmers noticed that this technique required a lot 

of time and manpower, they imagined a machine that would require less energy and allow more 
efficient plowing. Engineers then invented the tractor in 1868, using a steam engine (Fig. 1b). 
This was a machine that strikingly increased the efficiency and production of agriculture, and is a 

a)   b)  c)  
Figure 1: a) A horse-drawn plow used up until the invention of the tractor. b) An early 
tractor powered by a steam engine. c) The modern day tractor, a remarkable engineering 
feat that is so crucial to agriculture. 
 

 “Horse-drawn plow” by Ferox Seneca, source: 
http://commons.wikimedia.org/wiki/File:Chinese_farmer_1.jpg  

  “Old tractor powered by steam engine” 
http://commons.wikimedia.org/w/index.php?title=File:Photograph_with_caption_%22Excavator_on_Mile_52
_being_pulled_by_traction-engine,_plow_side._August_8,_1904.%22_-_NARA_-_282335.tif&page=1  

 “Modern tractor” by Brian Robert Marshall, source: 
http://commons.wikimedia.org/wiki/File:A_field_near_Winterbourne_Monkton_-_geograph.org.uk_-
_970926.jpg  

Sibu Kuruvilla� 6/17/12 2:25 PM
Comment [79]: Comment	  on	  the	  fact	  that	  we	  
have	  talked	  about	  agriculture	  and	  engineering	  as	  
separate	  fields	  thus	  far,	  but	  they	  may	  in	  fact	  be	  very	  
related	  to	  each	  other.	  Lead	  into	  the	  discussion	  of	  
how	  they	  may	  be	  similar,	  and	  whether	  they	  depend	  
on	  each	  other.	  	  

Sibu Kuruvilla� 6/17/12 2:25 PM
Comment [80]: Try	  to	  initiate	  discussion	  about	  
how	  they	  are	  similar,	  and	  how	  they	  depend	  on	  each	  
other.	  	  

Sibu Kuruvilla� 6/17/12 2:25 PM
Comment [81]: Explain	  the	  engineering	  of	  a	  
tractor	  and	  its	  roll	  in	  agriculture.	  Talk	  about	  before	  
and	  after	  the	  tractor.	  	  
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marvelously engineered system. Modern day tractors are able to plough even more land at one 
time, and are accordingly even more efficient at their task (Fig. 1c).  
 
Water  
The necessity for water in agriculture is obvious, to feed the plants and animals, to run processes 
through the use of flowing water, and to maintain machinery and the farmers running them. But 
water is not just available whenever and wherever it is needed, right? Usually, it is either located 
in rivers, swamps, or provided by the rain. But a lake and or river may not be nearby, and who 
knows when it might rain next? So how do farmers actually get water to their plants and animals? 
Let’s discuss this.  
 
Class Discussion: Can you tell us how water has been stored and transported throughout the past 
in agriculture? Are there ways that are better than others (collecting rainwater vs. transporting 
from the river)?  
 

Many people have 
used engineering skills 
to figure out how to 
best provide water to 
their crops and 
animals, as well as 
how to use water for 
various mechanical 
processes. For over 
2000 years, people 
have used the energy 
of flowing water to 
drive processes in their 
houses or industries, 
such as in textile 
production, through 
the use of a 
_____________ (Fig. 
2). For farmers that do 
not rely only on 
rainwater, 
________________ 
_________________ 
have been created, 
which provides water 

to the animals and crops through an engineered system (Fig. 3a). In such a system, water is 
transported from a main source and distributed throughout the entire plantation, allowing each 
plant to access water. One type of irrigation, called “_________ _____________________,” 
literally “drips” water over each plant (Fig. 3b). This method was engineered because farmers 
noticed that water was being wasted when sprayed in large amounts, and the plants were not 
absorbing it all completely. Drip irrigation provides a way to minimize the water expenditure, 
while maximizing the water absorption by the plants. This is yet another example of how 
engineering is so essential to the development and advancement in agriculture.  
 

   
Figure 2: The watermill (left) used in Belgium converts the 
translational energy of the flowing water into mechanical energy that 
can be used to run various processes, through the mechanism seen in 
the right picture. 
 

 “Water Mill in Belgium” by Spotter2, source: 
http://commons.wikimedia.org/wiki/File:Schorisse_%28Maarkedal%29_-
_Water_mill.jpg  

 “Water Mill Mechanism” by Chrkl, source: 
http://commons.wikimedia.org/wiki/User:Chrkl  

Sibu Kuruvilla� 6/17/12 2:25 PM
Comment [82]: Next example is the role of water 
in agriculture, and how engineering has provided 
ways to transport and store it for use on the farm.	  

Sibu Kuruvilla� 6/17/12 2:25 PM
Comment [83]: Try	  to	  get	  the	  students	  to	  think	  
of	  ways	  that	  water	  has	  been	  captured	  and	  used	  on	  
farms	  in	  the	  past.	  They	  should	  have	  plenty	  of	  ideas,	  
since	  this	  is	  a	  general	  question	  that	  many	  of	  them	  
may	  have	  experience	  with.	  	  

Sibu Kuruvilla� 6/17/12 2:25 PM
Comment [84]: Relate	  the	  use	  of	  water	  in	  
agriculture	  to	  engineering.	  

Sibu Kuruvilla� 6/17/12 2:25 PM
Comment [85]: watermill	  

Sibu Kuruvilla� 6/17/12 2:25 PM
Comment [86]: irrigation	  systems	  

Sibu Kuruvilla� 6/17/12 2:25 PM
Comment [87]: drip	  irrigation	  



	   46	  

 
Water Purification 
During our introduction to agriculture class, we learned about the ____________ __________. 
Basically, water in lakes and rivers evaporate into the atmosphere, and then precipitate back down 
as rain, creating the cycle. Ideally, this means that all 100% of the water on the planet is recycled 
during this process. However, not all of this water is “renewable.” This is because of the 
contamination that we as humans put into the water; once pollutants are introduced into the water 

from industrial and agricultural processes, it cannot evaporate in the proper manner. This leads to 
a net ______________ in the supply of freshwater around the world.  
Water ___________________ may be very relevant to all of us. If we wash our clothes in the 
river, we are contaminating the rest of the river for anyone down the stream. If someone bathes in 
the river upstream of us, we are then drinking and bathing in already dirty water. Accordingly, 
there is an urgent need for purifying water, in order for it to be safe to drink and use in our 
everyday life, as well as promote its recycling in the water cycle.  
A variety of engineering techniques has been useful for this. Before we go into them, let’s have a 
class discussion about it.  
 
Class Discussion: Do you know of ways that water is purified? How do you make water safe to 
drink?  
 
As we mentioned, there are many ways of purifying water. __________________ is the use of 
chemicals to kill the bacteria within the water in order to make it safe. This is a form of 
______________ engineering. _______________ is a mechanical process where only water 
molecules can pass through the openings, but larger molecules like dirt and bacteria are left 
behind. This is a process that draws from principles of __________________ and 
_________________ engineering. Finally, the third way we talked about was through 
_________________. This works similar to chlorination, in that it kills the bacteria in the water, 
but through the use of high temperatures. This is a form of ________________ engineering.  
 
Class Discussion: What are other forms of engineering in agriculture?  

 

Figure 3: Irrigation systems have been engineered to provide water to crops without having to 
depend on rainfall. This engineering feat is greatly useful for the agricultural community. 
Various types of irrigation systems include (A) large sprinkler systems, and (B) small, focused 
drip systems, where water drips directly on to the root of the plant.  

 
 “Irrigation” by Paulkondratuk3194, source: http://en.wikipedia.org/wiki/File:Irrigation1.jpg  
 “Drip Systems”, source: http://greenfieldgeography.wikispaces.com/Irrigation+and+agriculture  
 “Drip Emitter” by Alan.ca, source: http://commons.wikimedia.org/wiki/File:Drip_emitter.jpg  

A 
 

 
B 

Sibu Kuruvilla� 6/17/12 2:25 PM
Comment [88]: Staying	  on	  topic	  of	  water,	  we	  
need	  to	  discuss	  its	  contamination,	  and	  how	  
engineering	  helps	  deal	  with	  that.	  	  

Sibu Kuruvilla� 6/17/12 2:25 PM
Comment [89]: Water	  cycle	  

Sibu Kuruvilla� 6/17/12 2:25 PM
Comment [90]: decrease	  

Sibu Kuruvilla� 6/17/12 2:25 PM
Comment [91]: pollution	  

Sibu Kuruvilla� 6/17/12 2:25 PM
Comment [92]: See	  if	  the	  students	  can	  come	  up	  
with	  current	  purification	  methods.	  Three	  big	  ones	  
that	  stand	  out:	  Boiling,	  Chlorination,	  Filtration	  (by	  
soil,	  sand,	  artificial	  materials,	  etc.)	  

Sibu Kuruvilla� 6/17/12 2:25 PM
Comment [93]: Chlorination;	  Chemical;	  
Filtration;	  mechanical;	  chemical;	  boiling;	  chemical.	  

Sibu Kuruvilla� 6/17/12 2:25 PM
Comment [94]: Tools	  and	  Machinery:	  hoe,	  plow,	  
tiller,	  loader,	  refrigerator,	  bean	  harvestor.	  
Milking/Feeding:	  grain	  cart,	  milking	  machine.	  	  	  	  
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Agriculture in Engineering 
It is obvious from our discussion that agriculture depends on engineering, but even though it may 
not be as obvious, engineering also depends on agriculture. When thinking about the general 
nature of engineering, it arises from the need to improve and fix problems faced in various 
industries, including agriculture. For example, when farmers noticed that their crops weren’t 
getting enough water from just the normal rainfall, they set forth to invent a system that would 
allow them to provide water not supplied by the rain. Thus, they engineered the irrigation system. 
If the agricultural problem hadn’t originated for the farmers, there would have been no need for 
any engineering. This clearly identifies the dependency of engineering on agriculture: without 
agriculture and its shortcomings, engineering would not be required nor useful to the industry.  
 
Genetic Engineering 
In another example, we can look at the development of ________________________ 
____________________ and its dependence on agriculture (Fig. 4). Many areas, like Liberia, that 
depend on rice as their main source of nutrition, were noticing a common vitamin A deficiency in 
the diets. A vitamin A deficiency can lead to early blindness, and therefore was a problem that 
needed to be taken care of efficiently and quickly. This problem was not easily solvable, however; 
in poorer countries, it would be hard to establish a new diet, or add a rare component, that would 
increase the amount of vitamin A the citizens would receive. Thus arose a problem for 
engineering. Luckily, two scientists, Drs. Ingo Potrykus and Peter Beyer, who are genetic 
engineers, were able to transfer the genes for vitamin A into a strain of rice, thereby making the 
rice develop a valuable amount of vitamin A when grown. This strain of rice can then be 
crossbred with various strains from all over the world, allowing virtually all rice farmers access to 
vitamin A-containing rice. This would serve to be crucial to the countries where rice is the main 
diet, providing sufficient vitamin A for the citizens, and helping them avoid blindness.  
 
        

From this example, it is evident that a problem 
faced in agriculture developed the need for an engineered solution. In general, the industry of 
genetic engineering relies heavily on agriculture, providing solutions to common problems that 
arise. Another example is the ________________ __________________, _________________-
__________________ crops (Fig. 5). An insecticide gene, or gene that causes a natural repulsion 
to harmful insects, was transferred from a bacterium to cotton plants, so that the cotton plants 
would naturally resist harmful insect pests. This would prevent the plant from being infected and 
eventually killed by the pest, and thereby avoid future generations of plants from being infected 
as well.  

 
 Source: DNA-Project-Cydney, http://dna-

project-cydney.wikispaces.com/Part+3  
 

Figure 4: The general process of 
genetic engineering. In order to force a 
plant to express a certain chemical or 
property, scientists transfer the 
necessary gene into the plant by 
extracting them from things that do 
express them (like bacteria). They then 
breed the original plant with plant cells 
that express the target property, and the 
resulting plant has the trait that they 
want! 
 

Sibu Kuruvilla� 6/17/12 2:25 PM
Comment [95]: This	  section	  focuses	  on	  the	  vice	  
versa:	  how	  engineering	  depends	  on	  agriculture.	  
Although	  its	  dependence	  isn’t	  as	  obvious,	  stress	  the	  
fact	  that	  engineering	  would	  not	  exist	  if	  it	  weren’t	  for	  
the	  problems	  experienced	  in	  agriculture.	  	  

Sibu Kuruvilla� 6/17/12 2:25 PM
Comment [96]: Talk	  about	  how	  the	  field	  of	  
genetic	  engineering	  thrives	  due	  to	  the	  
improvements	  that	  can	  be	  made	  in	  agriculture.	  

Sibu Kuruvilla� 6/17/12 2:25 PM
Comment [97]: Genetic	  engineering	  

Sibu Kuruvilla� 6/17/12 2:25 PM
Comment [98]: Example	  1:	  Vitamin	  A	  deficiency	  
overcome	  by	  genetically	  modified	  rice	  that	  contains	  
more	  vitamin	  A,	  leading	  to	  reduced	  blindness	  in	  3rd	  
world	  countries	  

Sibu Kuruvilla� 6/17/12 2:25 PM
Comment [99]: Explain	  this	  figure.	  Point	  out	  the	  
bacterium	  that	  has	  a	  certain	  gene;	  then	  scientists	  
can	  cut	  out	  that	  gene	  and	  place	  into	  plant	  cells.	  
After	  allowing	  the	  plants	  to	  grow,	  they	  then	  exhibit	  
the	  trait	  that	  the	  gene	  carried.	  

Sibu Kuruvilla� 6/17/12 2:25 PM
Comment [100]: Example	  2:	  Insecticide-‐
expressing	  crops	  were	  given	  the	  gene	  from	  bacteria,	  
and	  they	  now	  prevent	  infection	  from	  pests.	  	  

Sibu Kuruvilla� 6/17/12 2:25 PM
Comment [101]: genetically modified, insect-
resistant	  

Sibu Kuruvilla� 6/17/12 2:25 PM
Comment [102]: Talk	  about	  the	  figure	  and	  
compare	  the	  two	  images.	  On	  the	  left,	  farmers	  use	  
toxic	  chemicals	  that	  are	  harmful	  to	  humans	  (poison	  
3	  million	  people	  a	  year!),	  and	  also	  cost	  a	  lot	  of	  
money.	  On	  the	  right,	  genetically	  modifying	  plants	  to	  
express	  insecticides	  prevents	  them	  from	  being	  
eaten	  by	  pests.	  	  
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A resistance to insects comes with many benefits for the farmer and the consumer: the reduction 
in need for insecticide would starkly decrease, consequently lowering the _________________ 
______________ of the crop. Also, having a natural resistance to pests will increase the crop’s 
yield, ultimately leading to much lower purchasing costs for the consumer. It is estimated that the 
toxicity of the chemicals used to fend off bugs from plants leads to 3 million people being 
poisoned in the developing world (World Health Organization). Minimizing the use of these 
chemicals can clearly be beneficial for everyone.  
It is thereby obvious the impact agriculture has on engineering. Engineering would not be 

necessary, nor possible, if there weren’t problems arising in the agricultural field that needed 
solutions. 
 
Class Discussion: The field of genetic engineering is very controversial. Can you think of why? 
 
Summary  
In summary, the interdependency of engineering and agriculture is highly important, and evident. 
Agriculture depends on engineering to provide the right equipment and techniques useful to 
improve the industry and become more efficient. Irrigation systems created by engineers help 
farmers regulate the supply of water to their crops, without having to depend on rainfall. On the 
other hand, engineering depends on agriculture to provide problems that require solutions. The 
field of genetic engineering thrives substantially because of the needs of agriculturalists. In both 
cases, without one, the other would be severely hindered in its development and progress.  

 
 
 

 
 
 
 
 
 

   
Figure 5: (A) Thai farmers spray chemical insecticides on their crops to prevent harmful pest 
infestation. The protective gear they were indicates the toxicity of such chemicals. (B) The 
genetic modification of crops by adding an insecticide gene prevents and kills any harmful pests 
that try to infect the plants. 
 

 “Thai farmers spray insecticides”, source: http://ricehoppers.net/2011/05/what-stimulates-farmers-
in-chainat-thailand-to-apply-prophylactic-sprays-of-resurgence-causing-insecticides/    

 “Bacillus Thuringiensis” by Hardy Hall, source: http://www.scq.ubc.ca/bt-corn-is-it-worth-the-risk/  
 

Sibu Kuruvilla� 6/17/12 2:25 PM
Comment [103]: Talk	  about	  how	  a	  resistance	  to	  
pests	  can	  be	  beneficial	  to	  both	  the	  farmer,	  and	  the	  
consumer.	  	  

Sibu Kuruvilla� 6/17/12 2:25 PM
Comment [104]: production costs	  

Sibu Kuruvilla� 1/23/13 12:14 AM
Comment [105]: have	  the	  students	  try	  to	  
identify	  why	  the	  use	  of	  pesticides	  and	  genetically	  
engineered	  crops	  is	  opposed	  by	  many	  people.	  	  
−Unnatural	  
−Unknown	  side	  effects	  
−Chemicals	  pollute	  Earth	  
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Class Activity: Match the various engineering tools used in agriculture today. 
 
 

    mining machine    milking machine           
cotton picker           windmill 
plow/plough         greenhouse 

 
         
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 

Sibu Kuruvilla� 3/13/13 7:52 PM
Comment [106]: Have	  the	  students	  rip	  out	  the	  
sheets	  at	  the	  end	  of	  the	  lesson/book	  with	  the	  
flashcards	  for	  the	  activity	  “Engineering	  in	  
Agriculture”	  

Sibu Kuruvilla� 6/19/12 11:00 PM
Comment [107]: Answers:	  
A	   	  plow/plough	  
B	   	  milking	  machine	  
C	   	  greenhouse	  
D	   	  cotton	  picker	  
E	   	  windmill	  
F	   	  mining	  machine	  

Sibu Kuruvilla� 6/19/12 11:01 PM
Comment [108]: Have	  the	  students	  cut	  the	  
flashcards	  out	  from	  below,	  as	  well	  as	  the	  6	  word	  
bank	  (6	  words),	  and	  try	  to	  match	  the	  words	  with	  the	  
item.	  If	  time	  allows,	  have	  the	  students	  explain	  why	  
each	  thing	  was	  engineered,	  and	  how	  it	  helps	  
agriculture.	  
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A. 

 

B. 

 
 

C. 

 

D. 

 
E. 

 

F. 

 

 
Flashcard image attributions: 
 
A:  by Martin Pettitt, source: http://www.flickr.com/photos/mdpettitt/8024352315/ 
B:  by David Monniaux, source: 

http://en.wikipedia.org/wiki/File:Cow_milking_machine_in_action_DSC04132.jpg 
C:  by Alex Kamweru, source: http://www.flickr.com/photos/alexkamweru/4330285210/  
D:  by kimberlykv, source: http://www.flickr.com/photos/kimberlykv/4087951240/  
E:  by Martin Pettitt, source: http://www.flickr.com/photos/mdpettitt/5427899973/  
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F:  by Mycael, source: http://www.flickr.com/photos/mycael/3356655880/  

 

Lesson 6: Resources, Economics and Feasibility 
Engineering and agriculture are two different fields, which are combined to together to obtain 
results that meet the needs of society. 
 
Can you think of a few basic needs of society (or yourself)? 

i.   
 

ii.   
 

iii.  

What are the resources needed to meet these demands? 
 Raw materials 
 Technology to process raw materials to products as per demand 
 Human expertise 

What happens if there is a shortage of any of the resources? 
 Product cannot be supplied 
 Resources have to be bought from external sources to meet demand 
 If there is any product produced, price of product increases 

Therefore the kind and amount of products produced should meet the consumer demands. 
 
Supply and Demand 
Demand refers to the quantity of a good that is desired by buyers.  
Supply is defined as the total quantity of a product or service that the marketplace can offer.  
Surplus condition occurs when the quantity of a product supply is greater than the quantity of the 
product demand. 
Deficit condition occurs when the quantity of a product supply is less than the quantity of the 
product demand. 
Equilibrium occurs when the quantity supplied equals the quantity demanded.   
 
Value addition 
Value addition is to add economic value to a product by changing its current place, time, and form 
characteristics to characteristics more preferred in the marketplace.  
As a specific example, a more narrow definition would be to economically add value to an 
agricultural product (such as wheat) by processing it into a product (such as flour) desired by 
customers (such as bread bakers). 
Engineering finds application in adding value to agriculture products.  
What are the benefits of adding value? 

 The price of the product increases; i.e. economic value increases 
 A more desirable product is made available to the consumers 

Activity: Let’s add value 
Fill in the following table by identifying any value added final product available in the market, 
which has been processed from the given agriculture products. Also think about what engineering 

sahitya� 6/22/12 1:45 PM
Comment [109]: Recap on the needs of society. 
Food, shelter, infrastructure etc. 

sahitya� 6/22/12 2:12 PM
Comment [110]: Conduct a small exercise to 
illustrate what these terms mean. For example, ask 
the students if they would like to have bicycles. 
Count the number of students who would like to have 
bicycles and note the number as demand. Then vary 
the quantity of supply to show a deficit, surplus and 
equilibrium situation. 
Discuss what could be the causes and effects of each 
situation 
Deficit: Lack of resources, Buy resources from an 
external source 
Surplus: Sell to an external party to make it 
profitable 
	  

sahitya� 6/22/12 2:16 PM
Comment [111]: Teacher’s	  Key	  
	  
Agriculture	  Product	  Value	  added	  product	  
Engineering	  technology/expertise	  needed	  
	  
Wheat	  Bread	  Machinery	  to	  grind	  wheat,	  bake	  
bread	  
Cassava	  Chips	  Machines	  for	  drying,	  packaging	  
Rubber	  Tires	  Manufacturing	  plants,	  chemicals	  
RiceFlour	  Machinery	  to	  grind	  
Palm	  KernelsOilOil	  Press	  
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aspects were involved in the processing of the value added product. 
 
 
 
Agriculture Product Value added product Engineering technology/expertise 

needed 
Wheat Bread Machinery to grind wheat, bake 

bread 
Cassava  

 
 

Rubber  
 

 

Rice  
 

 

Palm kernels  
 

 

 
Feasibility of a proposed plan 
What is feasibility? 
A plan is said to be feasible if it can be carried out successfully to meet a set of basic 
requirements. 
Example: The basic requirements for an automobile will be to move, carry load and use as less 
fuel as possible. If a plan proposes a new automobile that can move very fast and carry a lot of 
load but requires very high cost fuel, it is feasible?  
 
If you want to go to school faster, which of the following is more feasible?  

   
 “Bike wheel” by Carlos Asmat, source: http://openclipart.org/detail/7902/bikewheel-by-carlitos  
  “Bicycle”, source: http://openclipart.org/detail/18072/bicycle-by-lescinqailes  
  “Beetle”, source: http://openclipart.org/detail/4454/beetle-%28car%29-by-chrisdesign-4454  

 
The following questions should be evaluated to determine the feasibility of a proposed production 
plan 

• Resource feasibility 
o Are all the raw materials needed for a particular product available?  
o Is the necessary technology for processing available? 
o Is human expertise readily available? 

• Economic feasibility 
o Will the selling price of the product be greater than the cost price 
o Will the profits be enough to continue the production of the products? 

• Demand feasibility 
o Does the community desire the product? 

sahitya� 6/22/12 1:45 PM
Comment [112]: Discuss	  the	  additional	  costs	  
going	  into	  the	  cycle	  and	  car	  as	  a	  trade	  off	  

sahitya� 6/22/12 1:45 PM
Comment [113]: Cost	  price	  of	  product	  is	  the	  
price	  of	  all	  the	  resources.	  If	  the	  resources	  are	  
limited	  the	  cost	  of	  the	  resources	  will	  increase	  and	  
the	  cost	  price	  of	  the	  product	  will	  also	  increase	  and	  
profits	  will	  decrease.	  

sahitya� 6/22/12 1:45 PM
Comment [114]: If	  there	  is	  no	  desire	  for	  a	  
product	  in	  the	  market,	  no	  sales	  can	  be	  made	  and	  
the	  production	  becomes	  unfeasible	  	  
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o How much of the product is desired? 

Lesson 7: Case Studies 
 
Given below are 4 different case studies in the field of agriculture where sustainability, 
engineering and feasibility all play a role. As a group, choose and read one case study. Analyze 
the problem in the case study and find a solution. Then present your case to the other groups. The 
questions at the end of your case study will guide you to come up with a solution. For your 
presentation you can follow the order of the questions. Your instructor will clarify any doubts you 
may have while reading the passages. 
 
Case Study 1: Thongdee’s energy crisis! 

Thongdee Nantha owns a farm in the town of Abala in Uganda. He works the farm with his wife 
and children and produces more than enough for their needs. They have rice fields, a fishpond and 
a garden. 

The main crop is rice, which occupies about two-thirds of the land. The other one third is not 
cultivated. Ducks and chickens provide eggs and meat for the family and some eggs for sale – 
they eat the weeds from the rice fields, vegetable waste and leftover food. There are seven 
different varieties of fish. Rice bran, duck and pig manure, and aquatic weeds from the rice fields 
are fed to the fish; insect- and fish-eating fish are kept in a separate pond in the corner. 

Thongdee also grows trees on the farm, mostly mango, custard apple, banana and papaya. Then 
there are some cotton plants from which thread is spun and cloth woven for use by the family. 
Thongdee’s integrated farming techniques with a combined production cycle of rice, fish, ducks 
and pigs are lucrative and stable.  

But most of Thongdee’s profit goes into buying electricity from the local power plants. What in 
your opinion could be a solution to Thongdee’s problem? Remember Thongdee is a sustainable 
farmer! 

Answer the questions below to help Thongdee: 

1. Describe the situation in your own words (not more than 3 sentences) 
2. Proposal 

a. What can Thongdee do to overcome his energy crisis? 
b. Is this a feasible option? Discuss Resource, Demand and Economic feasibility of 

the proposed solution 
3. Engineering and Agriculture advise  

a. What engineering services are involved in setting up the proposed solution? 
b. What type of Engineers will be required to design and setup the proposed solution 
c. What agriculture expertise will Thongdee need?  

4. Value addition 
a. Does the new system add value to his farm? 
b. What are the reasons to your answer in part (a) 

5. Other options 
a. What alternative ideas can you suggest for Thongdee? 
b. Compare your proposed solution to this alternative. Why is your proposed solution 

sahitya� 6/22/12 1:45 PM
Comment [115]: The	  amount	  of	  product	  
demanded	  determines	  the	  amount	  of	  sales.	  If	  only	  a	  
small	  part	  of	  the	  community	  desires	  the	  product,	  it	  
may	  be	  more	  feasible	  to	  buy	  the	  product	  from	  an	  
external	  source	  than	  to	  manufacture/produce	  it.	  

sahitya� 6/22/12 2:18 PM
Comment [116]: This	  lesson	  is	  a	  complete	  group	  
activity.	  Divide	  the	  class	  into	  four	  groups	  and	  assign	  
a	  different	  case	  study	  to	  each	  group.	  After	  analyzing	  
the	  case	  study	  and	  answering	  the	  questions	  the	  
groups	  will	  have	  to	  present	  their	  case	  to	  the	  other	  
groups.	  Make	  sure	  to	  keep	  at	  least	  30mins	  for	  
presentations.	  And	  make	  sure	  every	  group	  gets	  a	  
chance	  to	  present	  their	  case	  at	  least	  

sahitya� 6/22/12 2:18 PM
Comment [117]: Agricultural	  systems	  that	  
integrate	  livestock	  and	  crop	  production	  

sahitya� 6/22/12 2:18 PM
Comment [118]: Solar	  energy	  /	  Bio	  gas	  	  

sahitya� 6/22/12 2:18 PM
Comment [119]: Solar	  could	  be	  the	  best	  option	  
cause	  he	  has	  barren	  land	  where	  he	  can	  install	  solar	  
panels.	  Buying	  cattle	  or	  more	  animals	  for	  biogas	  
could	  also	  contribute	  to	  his	  farming	  income.	  Yet	  
again	  solar	  maybe	  a	  better	  option	  cause	  he	  is	  in	  
Uganda	  which	  receives	  high	  intensity	  solar	  energy	  
all	  year	  round.	  

sahitya� 6/22/12 2:18 PM
Comment [120]: Resource:	  Yes	  lots	  of	  sunlight	  
available,	  barren	  land.	  But	  is	  solar	  technology	  
readily	  available?	  
Demand:	  Yes	  Thongdee	  has	  a	  farm	  to	  power	  and	  he	  
can	  also	  sell	  electricity	  to	  others	  at	  a	  lower	  price	  
than	  the	  power	  plant	  and	  increase	  his	  income	  
Economic:	  Cannot	  say,	  Solar	  energy	  has	  high	  capital	  
cost	  and	  may	  take	  a	  long	  time	  to	  recover	  the	  money	  
spent.	  

sahitya� 1/23/13 12:14 AM
Comment [121]: 1.	  Designing	  of	  solar	  panels	  
2.	  Placement	  of	  the	  panels	  
3.	  Technical	  advisor	  for	  Thongdee	  to	  use	  and	  
maintain	  the	  solar	  panels	  

sahitya� 6/22/12 2:18 PM
Comment [122]: Mechanical,	  Electrical,	  etc	  
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Comment [123]: He	  may	  have	  to	  re	  plan	  his	  
farm,	  He	  may	  need	  loans	  to	  install	  the	  new	  systems,	  
He	  will	  need	  advice	  on	  how	  the	  new	  system	  may	  
affect	  his	  farm	  animals	  and	  crops	  

sahitya� 6/22/12 2:18 PM
Comment [124]: Yes!	  Saving	  money	  is	  also	  
adding	  value.	  If	  the	  solar	  energy	  is	  cheaper	  than	  
electricity	  bought	  from	  the	  power	  plant,	  Thondee	  is	  
increasing	  his	  earnings	  by	  spending	  less,	  therefore	  
the	  new	  system	  will	  add	  value	  
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better?  

 
Case Study 2: Jim’s plants need water! 
Jim’s farm is entirely dependent on annual rainfall. If rain is consistent, the family will have a 
steady income and food all year round or else they are forced to survive on their savings during 
the no rain periods. But Jim no longer wants to be a victim to weather patterns and is looking for 
advice on how he can improve his farm conditions. Jim has a well on his farm. He had decided to 
surface irrigate his farm with the well water, but he is not sure if the well water can sustain his 
farm on a long-term basis without drying up. While trying to look for solutions Jim came across 
an advertisement for a new kind of irrigation system called Drip Irrigation. Can you help Jim 
decide if adapting this system in his farm will free him of his dependence on rain?  Given below 
is the advertisement Jim found.  
 
Drip Irrigate! Save Water! 
Buy your Drip irrigation kit now and conserve water to grow more. 
Drip irrigation is an improved irrigation system, which draws water from a well and sends it 
directly to the plants through a series of pipes, which are pierced with hundreds of small holes, 
restricting the overall flow of water, so that there is reduced waste. Drip irrigation systems are 
operational for 5-10 years, resulting in more profits for farmers long after the systems have been 
installed and paid for. With a drip system, the plant uses upwards of 90 percent of the water, 
while with surface irrigation this rate drops below 60 percent. 
 
Advantages 

• Drip irrigation uses precious water more efficiently - reducing runoff and evaporation and 
increasing percolation at the plant roots 

• Reduces water contact with crop leaves, stems, and fruit, reducing diseases 
• Increased yield and quality 
• Agricultural chemicals can be applied more efficiently with drip irrigation 

Answer the questions below to help Jim: 

1. Describe the situation in your own words  
2. Proposal 

a. Do you think Jim landed on the right solution to his problem? 
b. Is this a feasible option? Discuss Resource, Demand and Economic feasibility of 

the proposed solution 
3. Engineering and Agriculture advise  

a. What engineering services are involved in setting up the proposed solution? 
b. What type of Engineers will be required to design and setup the proposed solution 
c. What agriculture expertise will Jim need?  

4. Value addition 
a. Does the new system add value to his farm? 
b. What are the reasons to your answer in part (a) 

5. Other options 
a. What alternative ideas can you suggest for Jim? 
b. Which option is more sustainable? 

Case study 3: Milk to Ice cream 
Mike has a 1-acre farmland where he keeps 30 cows. A quarter of the farm is used to grow hay 
and silage to supplement the cows’ diet and feed them in the off-season. Mike rotates the cows 

sahitya� 6/22/12 2:18 PM
Comment [125]: Surface	  irrigation	  is	  defined	  as	  
the	  group	  of	  application	  techniques	  where	  water	  is	  
applied	  and	  distributed	  over	  the	  soil	  surface	  by	  
gravity.	  It	  is	  by	  far	  the	  most	  common	  form	  
of	  irrigation	  throughout	  the	  world	  and	  has	  been	  
practiced	  in	  many	  areas	  virtually	  unchanged	  for	  
thousands	  of	  years.	  
Surface	  irrigation	  is	  often	  referred	  to	  as	  flood	  
irrigation,	  implying	  that	  the	  water	  distribution	  is	  
uncontrolled	  and	  therefore,	  inherently	  inefficient	  
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Comment [126]: Yes!	  Looks	  like	  the	  best	  option	  
with	  his	  current	  situation.	  He	  could	  try	  surface	  
irrigation	  for	  some	  time	  to	  see	  if	  his	  well	  can	  provide	  
water	  for	  his	  entire	  farm.	  Remember	  drip	  irrigation	  
will	  cost	  Jim.	  	  	  
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Comment [127]: Resources:	  Yes	  the	  
advertisement	  says	  that	  a	  drip	  irrigation	  kit	  is	  
available.	  Jim	  has	  a	  well	  in	  his	  farm	  which	  in	  needed	  
by	  the	  drip	  system	  
Demand:	  Yes	  Jim	  needs	  a	  water	  management	  plan	  
immediately	  
Economic:	  Cannot	  say,	  a	  drip	  irrigation	  system	  can	  
be	  expensive	  and	  it	  will	  add	  to	  Jim’s	  economic	  
burden.	  Jim’s	  well	  maybe	  enough	  to	  sustain	  his	  farm	  
during	  a	  drought	  season	  (during	  a	  normal	  year	  Jim	  
can	  continue	  to	  use	  rain	  water,	  in	  which	  case	  the	  
drip	  system	  maybe	  useless)	  

sahitya� 6/22/12 2:18 PM
Comment [128]: Pipeline	  design,	  installing	  the	  
system	  

sahitya� 6/22/12 2:18 PM
Comment [129]: Civil	  engineers,	  Agricultural	  
engineers	  
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Comment [130]: Jim	  will	  need	  guidance	  on	  how	  
to	  use	  the	  system	  efficiently.	  Appropriate	  planning	  
of	  crop	  rotation	  to	  maximize	  on	  rainfall	  and	  the	  
irrigation	  system	  
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Comment [131]: Yes!	  Saving	  water	  is	  also	  
adding	  value.	  The	  water	  Jim	  saves	  can	  be	  used	  to	  
grow	  more	  crops,	  and	  increase	  his	  income.	  

sahitya� 6/22/12 2:18 PM
Comment [132]: Setting	  up	  surface	  irrigation	  for	  
his	  farm.	  No	  capital	  cost	  involved	  and	  the	  well	  may	  
be	  sufficient	  to	  sustain	  his	  farm	  during	  the	  low	  rain	  
seasons.	  But	  is	  this	  Sustainable?	  
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daily on pastures seeded in orchard grass, clover and ryegrass. The grazing season usually lasts 
from April through October. Through the winter, the cows eat from hay rings on the pasture. 
Mike also collects manure and composts it. Mike’s cows are well fed and well taken care of, and 
hence give Mike milk to sell and make a profit. Mike owns five mechanized milking machines 
and also employees to farm helpers.   
 
As this was a profitable industry, many other such dairy farmers started setting up farms in that 
area. The demand for milk fell as the number of suppliers grew and Mike was left with lots of 
milk and no buyers.   
 
Mike then decided to invest more in his milk and convert it to a different product desired by 
consumers and which will increase his income. Mike invested in an ice cream machine! Mike 
bought 2 ice cream machines and two commercial freezers with the help of a loan and setup an ice 
cream parlor right on his farm. He employed 2 more workers and started creating more than 75 
ice cream flavors all summer long. In 2010, Mike’s ice cream parlor produced 25,000 gallons of 
ice cream. It’s a lot of ice cream, and so is the gross revenue from $9 per gallon wholesale and 
$21 per gallon retail. 
 
Mike also converted a small part of his farm to a picnic area where customers can enjoy their ice 
cream and children can see the cows and other farm animals.  
 
The frozen dairy product is the icing for the farm. Without adding value to his milk, the dairy 
business wouldn’t have lasted, Mike says. 
 
“To be honest, I thought we could make a living just grazing and milking, but we’re so limited on 
space and the size of the herd, we couldn’t keep up with the rest of the new farmers,” he says. “I 
was ready to sell the cows, but thought I would try ice cream. “We’re profitable, but we weren’t 
always. It’s the ice cream that makes us so.” 
 
Apart from profits Mike’s farm also has environmental benefits. On the pastures, the herd spreads 
its own manure during daily rotations, which keeps the pastures healthy without any chemical 
fertilizers. Mike also collects manure from the cowsheds and composts it and sells the compost to 
nearby gardeners. Mike also employees more than two-dozen from his community — four full-
timers in the ice cream parlor and milking stations, and up to 25 teenagers part time in the 
summer in the ice cream parlor. 
 
Answer the following questions: 

1. Describe the situation in your own words  
2. Proposal 

a. Do you think Mike landed on the right solution to his problem? 
b. Is this a feasible option? Discuss Resource, Demand and Economic feasibility of 

the proposed solution 
3. Engineering and Agriculture advise  

a. What engineering services are involved in setting up the proposed solution? 
b. What type of Engineers will be required to design and setup the proposed solution 
c. What agriculture expertise will Mike need?  

4. Value addition 
a. Does the new system add value to his farm? 
b. What are the reasons to your answer in part (a) 

5. Other options 

sahitya� 6/22/12 2:18 PM
Comment [133]: Yes!	  He	  had	  a	  lot	  of	  milk	  and	  
no	  market	  for	  it.	  So	  he	  had	  to	  change	  his	  marketing	  
strategy	  
NO.	  He	  could	  have	  looked	  for	  other	  market	  options,	  
maybe	  bought	  a	  few	  trucks	  to	  transport	  the	  milk	  to	  
an	  area	  with	  more	  demand.	  But	  that	  would	  add	  cost	  
to	  Mike’s	  milk	  and	  he	  may	  not	  get	  returns	  for	  it	  as	  
the	  product	  has	  not	  changed	  so	  consumers	  will	  not	  
pay	  extra	  
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Comment [134]: Resource:	  Yes!	  He	  had	  milk	  
readily	  available.	  Though	  he	  needed	  to	  buy	  ice	  
cream	  machines	  	  
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Comment [135]: Construction	  of	  the	  ice	  cream	  
parlor,	  Setting	  up	  of	  ice	  cream	  machines	  
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Comment [136]: Civil	  engineers,	  Mechanical	  
engineers	  
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Comment [137]: Marketing	  his	  new	  value	  added	  
product,	  setting	  up	  picnic	  areas	  to	  attract	  customers	  

sahitya� 6/22/12 2:18 PM
Comment [138]: Yes!	  Lots	  of	  value	  addition.	  
Increased	  income,	  He	  saved	  his	  business	  by	  adding	  
value.	  Lots	  of	  environmental	  benefits	  (see	  last	  para	  
of	  case	  study)	  
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a. What alternative ideas can you suggest for Mike? 
 

 

Case study 4: Permaculture 
Permaculture is a branch of ecological design and engineering that develops self-sustaining 
agricultural systems modeled from natural ecosystems. 
 
In this exercise your team is a group of Permaculturists who are required to design a farmhouse 
for a family of 5. The farm should be able to sustain itself by producing the energy needed and 
using any waste produced. In case an essential commodity should be purchased from an external 
source, the farm should be able to produce to sustain a barter system. For example, if you need to 
buy electricity from an external source, the farm should be able to produce enough grains to 
exchange for the electricity. Remember the farm’s electricity needs will be year round so different 
types of grains should be produced to maintain a constant flow of electricity. Most importantly 
the farm should feed the family!  
 
Farmland Specifications: 
Size of the land for the new farm is 2 acres. The land has two wells, which together can irrigate 1 
acre by surface irrigation. Water and electricity can be bought from a nearby municipality. There 
are big markets for food crops around the farm.   
 
The following questions will guide you in designing your farm: 

1. Describe the case in your own words 
2. Initial Analysis 

a. What the 3 basic requirements for the farm and the family 
b. How can these requirements be supplied? 

3. Grow it 
a. What do you plan to grow on the farm? Remember the family would like to eat a 

variety of food (Grains, fruits, Vegetables etc). Also remember to have more than 
one type so that they have food all round the year. (At least 2 types of grains, fruits 
etc.) 

b. Which crop will provide to buy commodities that cannot be produced on the farm? 
Remember to grow more of that crop.  

c. How do you plan to irrigate the land? 
d. How do you plan to fertilize the farm and get better yields? 
e. What animals do you plan to have on the farm? 

4. Produce it 
a. What will is the source of energy?  
b. What machinery will the farm need?  
c. What fuel will the machinery run on? (Do you want to grow something more 

now?) 
5. Engineering 

a. What type of engineers will you need to construct this farm? 
6. Value addition 

a. Pick a product of your farm and discuss how you can add value to the product. 
What are the negative impacts of adding value? (Example: Machines will be 

sahitya� 6/22/12 2:18 PM
Comment [139]: Finding	  a	  market	  else	  where	  
may	  have	  been	  cheaper	  than	  taking	  loans	  to	  setup	  
the	  new	  business.	  
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Comment [140]: The	  solution	  to	  this	  exercise	  is	  
going	  to	  be	  almost	  irrational	  but	  the	  objective	  for	  
this	  case	  study	  is	  to	  make	  the	  students	  think	  about	  
how	  they	  can	  develop	  a	  farm	  if	  they	  had	  all	  the	  
resources	  available	  and	  then	  look	  at	  the	  feasibility	  
of	  the	  design.	  Therefore	  there	  aren’t	  too	  many	  
design	  constraints.	  In	  case	  the	  students	  are	  slightly	  
over	  ambitious	  about	  their	  farm,	  feasibility	  
questions	  from	  the	  Instructors	  will	  be	  a	  good	  
learning	  tool	  
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Comment [141]: Food,	  water,	  energy	  
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Comment [142]: Food:	  can	  be	  grown	  
Water:	  Has	  to	  be	  obtained	  externally	  
Energy	  can	  be	  harnessed	  or	  obtained	  externally	  
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Comment [143]: Buy	  water	  for	  which	  something	  
has	  to	  be	  exchanged.	  Or	  try	  drip	  irrigation!	  
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Comment [144]: Solar	  and	  wind:	  They	  will	  have	  
to	  allocate	  farm	  land	  to	  it.	  Biogas	  is	  a	  good	  option	  if	  
they	  have	  enough	  animals	  

sahitya� 6/22/12 2:18 PM
Comment [145]: Tractors,	  Harvesting	  machinery	  

sahitya� 6/22/12 2:18 PM
Comment [146]: Bio	  fuels.	  Fuels	  can	  be	  really	  
expensive	  to	  be	  bought	  from	  outside.	  
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required, if machines are needed then more energy will be needed to run the 
machines) 

7. Feasibility 
a. Do you think the amount of energy and water available is enough to produce food 

for the family and sustain the farm? 
 
 
 
 
 
 
 

 

sahitya� 6/22/12 2:18 PM
Comment [147]: If	  one	  of	  their	  products	  is	  
banana,	  they	  can	  make	  banana	  chips	  and	  they	  will	  
need	  a	  machines	  

sahitya� 6/22/12 2:18 PM
Comment [148]: Maybe	  not	  because	  2	  acres	  is	  a	  
small	  area	  to	  grow	  crops	  for	  food	  and	  energy	  and	  
have	  animals.	  The	  amount	  of	  water	  available	  also	  
seems	  insufficient.	  	  
This	  sort	  of	  farming	  technique	  has	  a	  better	  chance	  
of	  survival	  in	  bigger	  farms	  or	  community	  of	  farms.	  
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Lesson 8: Hands-on Exhibition 
 
Up until now, we have only been talking and reading about what engineering and agriculture are. 
Maybe now it is time to actually see the fruits of these disciplines in real life!  
 
Today’s lesson is a hands-on exhibition – basically a day for everyone to go around the classroom 
and play with the demonstrations we have set up. Each of these demonstrations shows the 
remarkable nature of engineering and agriculture, and aims to point out what lies beneath these 
items that makes them so useful to society today. The demos available to you today are the 
following: 
 
1. Opened-up electronics 

 
Each of these electronic pieces is a highly complex system that has been opened up for you to 
take a look at and go through. Notice the intense hardware and the small scale of all the 
components – it really goes to show the remarkable nature of electrical engineering! 

 

 
 

Personal Computer Diagram: 1. Scanner, 2. CPU (Microprocesser), 3. Main memory (RAM), 4. Expansion Cards, 5. 
Power supply unit, 6. Optical disk drive, 7. Hard Disk Drive (HDD), 8. Motherboard, 9. Speaker, 10. Monitor, 11. 
System software, 12. Application software, 13. Keyboard, 14.  Mouse, 15. External disk drive, 16. Printer. 

 Image by HereToHelp, source: 
http://en.wikipedia.org/wiki/File:Personal_computer,_exploded_6.svg  

 
2. Lemon-battery 

 
We learned that engineering is so important because it can use simple components to make a 
system that solves problems. So do you think you could power an electronic device, such as your 
cell phone, without using a battery? Could you make some kind of battery-like system from 
simple components, such as a few lemons? This demonstration will give you the answer. 
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 Image by Jbruso, source: http://commons.wikimedia.org/wiki/File:4LemonCircuit.jpg  
 

 
3. Ferrofluids 
 
You probably already know what magnets are: a material that produces a magnetic field. Magnets 
have very interesting properties because of these magnetic fields – sometimes two magnets repel each 
other, sometime they attract one another, it all depends on how the magnetic fields are aligned. But 
you cannot see any kind of field coming out of the magnet, can you? Then how do you know it’s 
there? Well, we can use a cool material called ferrofluids to show us the presence of magnetic fields! 

 

 
 by Gregory F. Maxwell, source: 

http://commons.wikimedia.org/wiki/File:Ferrofluid_Magnet_under_glass.jpg  
 

4. Ecosphere 
 
Have you ever thought about how the Earth sustains itself? Why doesn’t our planet just run out of 
“gas” to run on, and end up destroying itself? The Earth exists forever because it is a self-
sustaining system, or an ecosystem. An ecosystem is an environment where each of the 
components within that environment is able to provide for another, creating a cycle that is 
everlasting. In other words, the network of interactions between organisms and their environment 
create an ongoing nutrient and energy cycle. You can see an example of this in the Ecosphere. 
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 by Helfmann, source: http://commons.wikimedia.org/wiki/File:Ecosphere_Kugel.jpg  

 
5. Non-Newtonian Fluid 
What happens when you pour water out of a cup? It flows right? How about when you punch it? 
It splashes everywhere right? That’s because water behaves like a normal liquid, which was 
termed a Newtonian fluid. But have you ever seen a liquid that also behaves like a solid? Well, 
for a non-Newtonian fluid, if you were to pour it slowly out of a cup, it would behave like a 
liquid, just like water. But if you were to punch it, it would behave like a solid! Check this demo 
out and see for yourself! Also, see the directions at the end of this section to see how you can 
make the demo at home for your friends and family! 

 

 
 by Rory Macleod, source: http://www.flickr.com/photos/macrj/5393221639/  

 
6. Aerogel 
An aerogel is the world’s lightest solid material. It is made up of 99.98% air by volume! It is 
essentially a gel in which the usual liquid (which makes up most of the volume) has been replaced 
by air. This results in an extremely funky material that looks and feels like nothing, but can 
actually be very useful in technology today! 
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 Source: http://commons.wikimedia.org/wiki/File:Aerogel_hand.jpg  

 
 

7. Shape Memory Alloy 
A shape memory alloy is a metal alloy, or something made up of two or more different metals 
together, that you can bend and distort at one temperature but then return it to its original shape by 
heating it to another temperature. This “memory” does not actual depend on the memory we 
know, but it depends on the crystal structure of the material. At a low temperature, the material is 
soft and bendable, but after crossing a certain temperature, the crystal structure inside the material 
changes, and reverts to its original shape. Check it out! 

 

 
 by Wiertz Sébastien, source: http://www.flickr.com/photos/wiertz/6111633558/ 

 
 

Non-Newtonian Fluid Demo at Home! 
 
 

Reference: Activity: Lumpy Liquids and Squishy Solids in CHEMICAL 
DEMONSTRATIONS: A Handbook for Teachers of Chemistry, Volume 3 by Bassam Z. 
Shakhashiri. Copyright 1989 University of Wisconsin Press, All Rights Reserved. Accessible at: 
http://scifun.chem.wisc.edu/homeexpts/lumpyliquids.htm. 
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Exploratory Lab 
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Exploratory Timeline  
 

Day Lesson Activity 
1 Getting to know you: Ice-breakers 

Introduction to Exploratory Lab and what it is all about! 
Introduction to Agriculture and Engineering 
 

Human Rube Goldberg 
Activity 
Other Ice-breakers i.e. 
‘Reach & Grab’ or ‘All 
Aboard’ 

2 Renewable vs. Non-renewable energy 
Goals vs. Practice 
Millennium Development Goals (MDGs) 
 

 

3-10 
 

***Class 
divided into 4 
groups, with 

smaller groups 
within those, 
focusing on 
one entire 

system. Will 
rotate through 

systems as 
they complete 
each one*** 

Systems Group Work with Large Experiments:  
 
Group One: 
a. Food (Plants/Agriculture) 
b. Food (Animals) 
 
Group Two: 
a. Water (Collection – Rain &Ground) 
a. Water (Purification & Distribution) 
 
 
Group Three: 
b. Energy (Solar) 
 
Group Four: 
a. Energy (Wind & Hydro) 
b. Energy (Biogas) 
 

 
 
 
Farming Scenario 
Sugar Cane Activity 
 
The Water Cycle  & and 
Aquifer 
Water Distribution 
Exercise 
 
 
The Hot Box 
 
 
Turbines 
Manure, Food Scraps in 
Bottles 

10 
 

Summarize & Farewell Farewell Activity 
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Exploratory Lab 
 
Course Objectives: 
To give students opportunities to learn about topics in food, 
water, and energy in light of agriculture and engineering 
through lessons, demonstrations, experiments, and group 
activities.   
 
Course Description: 
Students will be divided into their 4 groups and will work 
through the 3 systems (food, water and energy). When they 
have finished one experiment, they will move into the next, 
making sure they complete all experiment stations, over the 8-
day period.  
 
Important Concepts: 
• Renewable vs. Non-Renewable Energy 
• Millennium Development Goals 
• Sustainability 
• Food (Plants & Animals) 
• Water (Collection, Purification & Distribution) 
• Energy (Hydro, Wind, Solar & Biogas) 
• Incorporating and applying core subjects of Math and English (WAEC) into practical 

experiments  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 by Sammo, source: 

http://openclipart.org/detail/172076/
inspector-by-sammo241-172076  
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Lesson 1: Exploratory Lab - Introduction to Agriculture & 
Engineering 

Objective: 
• Students will understand how to apply agricultural and engineering strategies to real-world 

situations through hands-on activities. 

 
Everything has energy but we need … 
Think of yourselves as a machine. What happens when you don’t eat and drink? This can be 
scaled up to an entire country. What do you need energy for? Food for? Water for? 
Agriculture helps us grow food and harness energy we can use to grow it, particularly if it’s 
sustainable. There are so many benefits from economic and environmental standpoints. As a 
class, discuss and list some below: 
 

Economic Environmental 

  

  

  

  

  

  

 
Engineering is a way of implementing methods of harnessing universal forms of energy in ways 
we can use them to do stuff, like mechanical – solar, wind, water energies. 

Melissa Kemp-Downes� 6/17/12 2:45 PM
Comment [149]: (1 Hour) Instructor Note - In 
this lesson students will: 
*Get to know peers through Ice-breakers (30 minutes 
and ice breaker of your choice) 
*Be introduced to Exploratory Lab and what it is all 
about! 
*Introduction to Agriculture and Engineering 
 
If facilities available, can also watch an introductory 
Video (5 Min) “It’s All About You” 
http://www.cfaitc.org/  
	  

Melissa Kemp-Downes� 1/23/13 12:14 AM
Comment [150]: 	  
Environmental	  
•Avoids	  the	  release	  of	  pollution	  into	  the	  
environment	  
•Restoring	  degraded	  landscapes,	  protecting	  
biological	  diversity	  and	  slowing	  climate	  change	  
•Recycling	  of	  nutrients	  and	  the	  reduction	  in	  energy	  
to	  diminish	  both	  indirect	  and	  direct	  emissions	  of	  
greenhouse	  gases	  
•Maximizing	  diversity	  through	  planned	  crop	  
rotations,	  intercropping,	  and	  companion	  planting;	  
protecting	  water	  quality;	  composting;	  year	  round	  
soil	  cover;	  integrating	  crop	  and	  animal	  production;	  
soil	  conservation	  practices;	  and	  attracting	  beneficial	  
wildlife.	  
 
Economic	  
•Diversifying	  the	  farm	  with	  several	  crops	  and	  
markets	  helps	  to	  reduce	  financial	  risk.	  	  
•Over	  time,	  improved	  soil	  and	  water	  quality,	  as	  well	  
as	  other	  environmental	  benefits	  from	  sustainable	  
practices,	  may	  raise	  the	  value	  of	  the	  farm.	  	  
•Selling	  products	  directly	  to	  local	  markets	  in	  the	  
community	  reduces	  shipping	  and	  fuel	  costs	  and	  can	  
potentially	  decrease	  transportation	  costs	  
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Lesson 2: Millennium Development Goals 
 
Objectives: 

o Understand the relevant systems (food, water and energy) in regards to agriculture and 
engineering, and how to apply them to real-world situations 

o Understand the origins of, and reasons for, the Millennium Development Goals (MDGs) 
o Be able to describe the Millennium Development Goals in their own words 
o Introduce the MDGs as a means of exploring concepts of development & sustainability 
o Understand the context for the MDGs & become familiar with the eight goals 
o Examine goal in more detail and make explicit the local-global connection  

 
Lesson: 
Renewable energy – comes from sources that do not run out or that can be replenished within a 
short period of time. Sources of renewable energy include: Wind, water, sun, biomass (energy 
obtained from plants, animals or their products such as wood, corn, grasses and manure) and 
geothermal (heat from deep within the earth). 
 
Non-renewable energy – comes from sources that cannot be replenished within a short period of 
time. Sources of non-renewable energy include: oil, natural gas, coal, nuclear energy 
 
 Activity: What is sustainability?                                                              
 

 

Reference: “Three Pillars of Sustainability,” http://yadadrop.com/about/sustainability. Copyright 
2011 Yada Drop LLC. All rights reserved. 

 

 

 
 by Majin Cline, source: http://openclipart.org/detail/29188/globe-by-majincline-29188 

Melissa Kemp-Downes� 6/17/12 2:45 PM
Comment [151]: *Explanation of the problems: 
Not everyone has access to these resources, Not 
everyone can afford them, Natural Resources are 
limited and explain why it’s bad to use a limited 
resource, Need to harness natural abundant 
renewable sources of energy as opposed to these 
  
*Why food, energy, water are important examples of 
use in daily life 
 
Talk about sustainability 

Melissa Kemp-Downes� 6/17/12 2:45 PM
Comment [152]:  Provide students with a simple 
definition of sustainability and have them explore 
how it can be met within their own communities in 
small groups. Ask them to explain and provide at 
least 5 examples on poster board/butchers paper: 
*In what ways are your communities sustainable? 
*In what ways are they not? 
*How can engineering and agriculture be used to 
improve these? 
 
Have the students bring their sheets up to the front 
and hang them up to discuss briefly to the class what 
their group came up with. Then ask the class critical 
questions relating to what they come up with. Some 
examples include: 
*Does it make sense to import the majority of rice? 
*Does it make sense to use generators for energy? 
*Does it make sense to only grow one crop? 
 
Students can write notes in their journals if 
necessary. 
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 by Andrew, source: http://commons.wikimedia.org/wiki/File:Sustainability-diagram-v3.png  

 
Goals versus Practice 
Profitable economics, healthy environment, and vital communities are all goals. They are what 
we are trying to achieve. Practices are actions we take to achieve those goals. Why don't we 
define sustainable agriculture in terms of practices? There are two important reasons: First, we 
expect that our knowledge will increase in the future, so practices used now may not be 
considered the best practices ten years from now. Second, the effect of a practice can vary 
enormously depending on how and where it is performed. For example, plowing on a steep 
hillside is unsustainable because it causes too much soil erosion. However, occasional plowing on 
level ground can be a sustainable tool for some cropping systems. 

 
In order to attain our goals, we need to take certain actions, that is, follow certain practices. So 
one of the things we'll explore in the next few days are examples of sustainable practices, such as 
crop rotation, riparian buffer strips, rotational grazing, and direct marketing. Keep in mind, 
though, that these are not all the possible practices and if they don't help us achieve our goals, 
they are not sustainable, no matter what the practice. 
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Millennium Development Goals 
 

 Reference: The following texts and images are adapted from “Millennium Development Goals,” UNDP, 
http://www.undp.org/content/undp/en/home/mdgoverview.html, Copyright 2011 United Nations Development 
Program, All Rights Reserved. Extracts of the information in the web site may be reviewed, reproduced or translated 
for research or private study but not for sale or for use in conjunction with commercial purposes. 

 
The United Nations Millennium Development Goals are eight goals that all 191 UN member 
states have agreed to try to achieve by the year 2015. The United Nations Millennium 
Declaration, signed in September 2000 commits world leaders to combat poverty, hunger, 
disease, illiteracy, environmental degradation, and discrimination against women. The MDGs are 
derived from this Declaration, and all have specific targets and indicators.  
The MDGs are inter-dependent; all the MDG influence health, and health influences all the 
MDGs. For example, better health enables children to learn and adults to earn. Gender equality is 
essential to the achievement of better health. Reducing poverty, hunger and environmental 
degradation positively influences, but also depends on, better health. 

  
Poverty and Hunger 
Cut the number of people in half who live on less than one US dollar a day and who suffer from 
hunger. 

 
Education   
Make sure that all children start and finish primary 
school. 
  

Gender Equality  
Be sure that as many girls as boys go to school. 
  
   
Reduce Child Mortality   
Cut back by two-thirds the number of children who 
die before they reach the age of five. 
 

   
Improve Maternal Health   
Cut back by three-quarters the number of women who die when they are having babies. 
    

 
Disease   
Stop terrible diseases like HIV/AIDS, malaria, TB, from spreading and make them less common. 
   
 
Environment   
Cut in half the number of people who lack clean water, improve the lives of people who live in 
slums, and promote policies that respect the goods of creation. 
      
Global Partnership  
Promote greater cooperation among all nations with special concern for fairer deals for poor 
countries in trade, aid, debt, new technologies, etc. 

 
 by kattekrab, source: 

http://openclipart.org/detail/16340/hand-
prints-by-kattekrab-16340  

Melissa Kemp-Downes� 6/17/12 2:45 PM
Comment [153]: 	  
Icebreaker:	  
	  
	  
Introduce	  how	  MDG	  come	  about:	  In	  2000,	  189	  
countries	  including	  Ireland,	  signed	  up	  to	  achieve	  the	  
Millennium	  Development	  Goals	  (MDGs).	  The	  MDGs	  
are	  8	  goals	  to	  help	  the	  world’s	  poorest	  people	  meet	  
their	  needs.	  The	  aim	  of	  the	  Goals	  is	  try	  to	  overcome	  
the	  biggest	  problems	  that	  face	  the	  world’s	  poorest	  
people.	  We	  are	  going	  to	  learn	  what	  these	  Goals	  are.	  
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Achieving the Millennium Development Goals in Liberia 

Reference: Republic of Liberia: Millennium Development Goals 2010 Report: Progress, 
Prospects and Challenges towards Achieving the MDGs. Copyright 2010 Government of Liberia, 
United Nations Development Program, All Rights Reserved. Accessible at: 
http://www.lr.undp.org/Documents/RecentPublic/MDG%20Report%20_Final.pdf. 
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The MDGS in Our Own Words 

 
Images below are adapted from http://www.undp.org/content/undp/en/home/mdgoverview.html, Copyright 2011 
United Nations Development Program, All Rights Reserved. Extracts of the information in the web site may be 
reviewed, reproduced or translated for research or private study but not for sale or for use in conjunction with 
commercial purposes. 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

                               
 

 
 

MY/OUR MDG IS: 

MY/OUR MDG MEANS IN OUR 
OWN WORDS: 

Melissa Kemp-Downes� 6/17/12 2:45 PM
Comment [154]: Divide your class into 8 teams. 
Give each team an MDG from the MDGs ‘In my 
own words’ worksheet. Ask each team to put their 
MDG into their own words. They can use dictionary 
to find out what the words mean. While your pupils 
put the MDGs into their own words, write the full 
MDGs list – with logos – on the board. Ask each 
group to feed back to the other groups. Each group 
reads out their own explanation, which is written up 
as a parallel list on the blackboard/whiteboard. 
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The MDGS Linking Worksheet 

 

Reference: Matching facts to MDGs in Integrated Literacy Activities. Copyright 2012, 
Irish Aid, All Rights Reserved. Accessible at: http://ourworldirishaidawards.ie/wp-
content/uploads/2013/01/5th-6th-class-Our-World-Awards-lessons-with-logos.pdf, page 10. 
 
Group Activity 
If you had a chance to attend the United Nations Summit on Millennium Development Goals, 
what would you like say to the Governments, journalists and development organizations 
attending?  
 
 
Write a speech or design a poster, which sends a message to the world’s adults about what you 
would like in the future.  
 
Notes: 
______________________________________________________________________________

______________________________________________________________________________

______________________________________________________________________________

______________________________________________________________________________

______________________________________________________________________________

______________________________________________________________________________

______________________________________________________________________________

______________________________________________________________________________

______________________________________________________________________________

______________________________________________________________________________

______________________________________________________________________________

______________________________________________________________________________

______________________________________________________________________________

______________________________________________________________________________

______________________________________________________________________________

______________________________________________________________________________

______________________________________________________________________________ 

 

 

 

Melissa Kemp-Downes� 6/17/12 2:45 PM
Comment [155]: Writing activity – linking 
problems to the MDGs: This activity can be done in 
groups, or each pupil can do it individually. Hand 
out the MDG Linking worksheet (one per group/per 
pupil). Ask each group/pupil to link each problem to 
an MDG. (e.g. PROBLEM: OVER HALF THE 
WORLD'S CHILDREN ARE BORN INTO 
POVERTY = MDG 1)  
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Lesson 3: Food (Plants, Animals & Agriculture) 
 
Objectives: 

• Be able to define the term “sustainable” 
• Distinguish between the goals and the practices used to achieve the goals of sustainable 

agriculture and food systems 
• Demonstrate awareness of economic, environmental, and community impacts of 

agriculture.  
• Understand the steps in the food system between the farm and their plates and the global 

nature of the food system 
• Identify that machines can be used to make work progress more easily and quickly 
• Introduce the idea that some things that are considered waste can be used for alternate 

purposes 

 
What is Sustainable Agriculture? 
Sustainable agriculture is a journey rather than a destination. The word “sustainable” comes from 
the word “sustain” which means to maintain, support, or to endure. People involved in sustainable 
agriculture are trying to identify and solve the problems in our current agricultural system in order 
to provide food and fiber in a healthy environment for people over the long term. And that’s not 
to say agriculture necessarily has to be all about food. At least for now, no one has developed a 
fully sustainable agriculture, and for the foreseeable future there will always be room for 
improvement. 
 
Activity 
As a group, brainstorm ideas about what you believe subsistence farming and commercial 
agriculture to be: 
 

 

 

Subsistence Farming 

Commercial Agriculture  

 
 

 “Goat” by Gerald_G, source: http://openclipart.org/detail/16228/goat-by-gerald_g  
 “Medal” by Peter M, source: http://openclipart.org/detail/3972/medallion-by-peterm  

Melissa Kemp-Downes� 6/17/12 2:45 PM
Comment [156]: Sustenance farming is when 
you farm only to sustain yourself or those that 
depend on you. It is farming for survival, one group 
of people working to feed themselves. 
  
Modern, or commercial farming is made to feed the 
masses, be they people or grain for livestock. A 
commercial farmer makes a profit, other than just 
food for his family. Commercial farming is a 
business, where a few feed thousands and does not 
necessarily neglect the pillars of sustainability.   
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Important Sustainable Farming Terms & Definitions 
 

Reference: “Aquaculture,” http://www.clearsprings.com/school/lesson-plans/aquaculture/. 
Copyright 2012-2013, Clear Springs Food, All rights reserved.  

 

Reference: “Ethnobotany,” http://extension.uga.edu/k12/science-behind-our-food/lesson-
plans/Ethnobotany.pdf. Copyright 2011-2012, University of Georgia Cooperative Extension, All rights 
reserved.  

 

Reference: “Medicines that Changed the World,” 
http://www.accessexcellence.org/RC/Ethnobotany/page4.php. Copyright 1996-2012, Stephen R. King, All 
rights reserved.  

 

Reference: “The Science of Ethnobotany with Dr. Paul Cox,” http://sciencestage.com/v/16006/the-
science-of-ethnobotany-with-dr-paul-cox-.html or http://youtu.be/9UYl6kmS8fQ. Copyright 2010, 
ScienceStage.com, All rights reserved.  
 

Ethnobotany & Medicine 
 
What is composting? 
According to the Commonwealth of Massachusetts Department of Environmental Protection, “In 
nature, soil organisms called decomposers digest organic material such as leaves, dead plants and 
animals.” 
 

 
 by Alan Levine, source: 

http://www.flickr.com/photos/cogdog/347553199
2/  

 
 by Kessner Photography, source: 

http://commons.wikimedia.org/wiki/File:Real_Com
post.jpg  
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 Reference: “Composting Lesson Plan,” http://www.thegreenteam.org/pdf/AdditionalLessonPlan-
Compost.pdf. Copyright 2012, Commonwealth of Massachusetts Department of Environmental Protection, 
All rights reserved.  

 

Reference: “The Dirt on Soil,” http://school.discoveryeducation.com/schooladventures/soil/. 
Copyright 2012, Discovery Education, All rights reserved. 

 

Reference: “Soil Basics,” Lindsay DeHartchuck, 
http://edu.earthday.org/sites/default/files/Soil%20Basics_Lesson%20Plan.pdf. Copyright 2012, Discovery 
Education, Earth Day Network, All rights reserved. 
 

 

Reference: “Types of Soil,” http://www.provident-living-today.com/Types-of-Soil.html. Copyright 
2009-2013 Provident-Living-Today.com, All rights reserved. 

 

 

 

 

 

 

Farming Simulation Game 

     
 

 Sandy soil by Tess Watson, source: http://www.flickr.com/photos/63603238@N00/3217753126  
 Silt soil by Mongo, source: http://commons.wikimedia.org/wiki/File:Silt_at_Boyers_Chute.jpg  
 Clay soil by Rowena R., source: http://commons.wikimedia.org/wiki/File:Clay_soil.jpg  

 
 
 
 

 
 

 
Source: 
http://openclipart.or
g/detail/16947/farmi
ng-food-by-
johnny_automatic-
16947  

Melissa Kemp-Downes� 5/29/13 12:37 AM
Comment [157]: Feel	  free	  to	  demonstrate	  a	  
simple	  compost	  using	  food	  scraps	  from	  dinner,	  
lunch	  etc.	  over	  the	  2	  weeks	  to	  students	  and	  show	  
how	  it	  can	  be	  used	  in	  sustainable	  agriculture	  (may	  
be	  more	  difficult	  for	  day	  camps	  to	  do).	  
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Reference: Farming Simulation Game, Irish Aid, 
http://www.irishaid.gov.ie/media/irishaid/allwebsitemedia/50teachingandlearning/teaching-
and-learning-primary-5th6th-class-environment-lessonplan4.pdf. The information 
published on this website is the copyright of the Office of the Information 
Commissioner unless otherwise stated. The information on this website may be re-used in any 
format, without application and free of charge. Retrieved on Nov. 10, 2012. 

 
In teams, your class becomes African villages. The aim of the game is for your group to grow as 
much as they can for their village. Over 2 rounds, each team decides which crops to grow, and on 
a roll of dice, find out if they have a good or poor year for their harvest depending on the weather. 
At the end of each round each team is given a card outlining something, which will either increase 
or decrease their yield. The team with the biggest harvest for their village at the end of the 2 
rounds wins the game.  
 
Round 1: 

a) Divide into groups of 2 people. Each group represents a village. On the following 
worksheet are the crops that  you will grow (Yams, Cassava, Maize, Millet, Groundnuts, 
Peas). 

b) Your village has 10 fields to plant. You must plant at least 3 different crops.  
c) Decide as a group which crops to grow and how many fields per crop. Fill in the number 

of  fields for each crop in the ‘No. of Fields’ column on the worksheet. On the worksheet 
you’ll see that some crops grow better in dry conditions, others in the wet conditions. Now 
roll the dice to find out if you have a wet or dry year. If you get a 1, 2, 3, 4 you have a dry 
year. If you roll a 5, 6 you have a wet year.  

d) If you have a wet year you calculate your yield (the amount of crops your village 
produces) by multiplying the number in the ‘No. of fields’ column with the figure in the 
‘Wet yield’ column. Fill in your yield in the ‘Total Yield’ column.  

e) If you have a dry year, you calculate your yield (the amount of crops your village 
produces) by multiplying the number in the ‘No. of fields’ column with the figure in the 
‘Dry yield’ column. Fill in your yield in the ‘Total Yield’ column.  

f) To find out how much your village has grown add up your ‘Total Yield’ column.  
g) Now, sometimes other things happen 

which can affect (have an impact on) 
your crops. These Impact Cards tell you 
what happens. Someone from each 
village in turn comes up to choose an 
Impact card and reads it out so that all 
the other villages can hear what has 
happened. (Ask your teacher for a card). 

h) Each village must now fill out the 
‘Impact loss’ line on the worksheet and 
calculate the ‘Total Yield After Impact’. To do this, you subtract the loss on the Impact 
Card from the Total Yield.  

 

 
 by USDA Farm Service Agency, 

source: 
http://openclipart.org/detail/26160/veggies-by-
johnny_automatic-26160  

Melissa Kemp-Downes� 6/17/12 2:45 PM
Comment [158]: Tell the group they are going to 
do an activity to simulate subsistence farming in 
villages in a country in Africa. Divide them into 
small groups of 2-3. Explain that each group 
represents a village in Africa. Ask each group to 
choose a name for their village. The village grows 
subsistence crops. Your aim is to grow as many 
crops as possible, but in the most sustainable way 
possible - don’t forget to integrate the pillars of 
sustainability.   
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Ground Nuts And Chickpeas: 

 
 

 
 

 
 

 
 

Groundnuts and chickpeas provide people with a very important source of protein. Fish and meat 
are also a very good source of protein, but can be expensive for poor communities. Protein is a 
very important part of the diet to maintain health as it allows the body to grow and repair damage.
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Round 2: 
Repeat the process (a-h) for Year Two 

j) In Year Two substitute Solution Cards for Impact cards. 
Solution Cards provide a positive surprise for the 
villages. Pupils calculate their ‘Total Yield After 
Impact’ by adding the gain from the Solution Card with 
the Total Yield figure. 

 
Evaluation Questions 
How did the Impact Cards affect their yield and how did they feel about this? 
______________________________________________________________________________

________________________________________________________ 

 
How did the Solution Cards affect their yield and how did they feel about this? 
______________________________________________________________________________

________________________________________________________ 

 
What were the main environmental factors affecting the amount of crops the villages could grow? 
______________________________________________________________________________

______________________________________________________________________________

______________________________________________________________________________

__________________________________ 

 
What other factors affected the amount of crops the villages could grow?  
______________________________________________________________________________

______________________________________________________________________________

______________________________________________________________________________

__________________________________ 

 
Where does our food come from? 
______________________________________________________________________________

________________________________________________________ 

 
What happens if a certain food is not available here? 
______________________________________________________________________________

______________________________________________________________________________

______________________________________________________________________________

__________________________________ 

 

 

 
 Source: 

http://openclipart.org/detail/19589
/little-green-tractor-by-yman  

Melissa Kemp-Downes� 6/21/12 4:07 PM
Comment [159]: Pollution,	  Deforestation,	  
Climate	  Change,	  Weather	  

Melissa Kemp-Downes� 6/21/12 4:10 PM
Comment [160]: Social	  (war,	  education,	  Income)	  
and	  	  Health	  (Malaria)	  etc	  

Melissa Kemp-Downes� 6/21/12 3:56 PM
Comment [161]: Not	  just	  from	  the	  
supermarkets…discuss	  from	  ‘paddock	  to	  plate’	  -‐	  
From	  local	  and	  international	  farmers	  ,	  plants,	  
animals	  etc.	  

Melissa Kemp-Downes� 6/21/12 3:53 PM
Comment [162]: Food	  prices	  increase	  due	  to	  
transportation	  costs,	  may	  be	  limited	  availability	  etc.	  
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Impact Cards 
 
Normal Harvest 
 
Your village brings in a good harvest. But 
your village’s storage has become damp, 
causing rot in half your yield. 
 
Your village loses half its crops 

Climate Change 
 
Changes in the climate have caused the rain 
patterns to change. All of the villages 
experience very heavy rain. But your village 
is next to a river, which bursts its banks and 
floods your yields.  
 
Your village loses 50 units 

War 
 
War breaks out in the region and soldiers 
from both sides overrun the fields in your 
village. They take stored crops and seeds for 
the following year. 
 
Your village loses 75 units 

Soil Problems 
 
Deforestation has left the soil around your 
village lacking nutrients, co your crops don’t 
grow as well as expected. 
 
Your village loses 70 units 

Water Pollution 
 
Waste chemicals from a factory have leaked 
into the water. The water comes into your 
field through your irrigation system. Some of 
your crops die. 
 
Your village loses 50 units 

Normal Harvest 
 
Your village brings in a normal harvest. But a 
local government official has demanded a 
bribe from your food supply. 
 
Your village loses 40 units 

Elephant 
 
An elephant has come into your village at 
night and walked through a field of crops. 
 
Your village loses 20 units 

Malaria Outbreak 
 
Several villages have become sick with 
malaria, reducing the number of workers 
available to harvest the crops. 
 
Your village loses 70 units 
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Solution Cards 
Farming Cooperative 
 
Your village sets up a cooperative with 
nearby villages to learn and share new 
farming practices. You have help from a local 
agricultural scientist whose work is funded by 
the UN. 
 
Your yield increases by 50 units 

A Community Well 
 
Your village has had several years of drought. 
A development organization offers to work 
with your village to build a well. 
 
Your yield increases by 60 units 

Tree Planting 
 
You plant your maize fields with fertilizer 
trees. The trees help the soil; they prevent 
erosion and provide nutrients to the maize 
crops. 
 
Your village loses 75 units 

Literacy Classes 
 
Several women in your village join a literacy 
class. They are now able to read the 
directions on a natural pesticide sack and find 
that you need less than you have been using.  
 
Your yield increases by 60 units 

New Seeds 
 
Your village decides to plant a new type of 
drought resistant seed. These seeds grow 
better in dry conditions. 
 
Your village doubles its dry crop units 

Mosquito Nets 
 
A charity has bought mosquito bed nets for 
the village. This reduces the number of 
people who get malaria during the year, and it 
means that everyone is able to work. 
 
Your yield increases by 70 units 

Water Supply 
 
Your government helps your village to build 
an irrigation system, which brings water to 
the fields. It also means that women don’t 
have to carry the water to the fields anymore 
and can go to literacy classes.  
 
Your yield increases by 50 units 
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Practical Exercise 
 
Create a model using play dough to show a system with different things growing and how it can be split to sustain 
everything. When you have finished, draw a rough sketch in the space provided below: 
 
 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 

 

 
 by Viscious Speed, source: 

http://openclipart.org/detail/168743/african-
women-with-vessels-by-viscious-speed  
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Oil Press Activity 
 
Oil is a very common and important food source.  The fats contained in oil are necessary for good 
nourishment of the body.  Traditional methods of producing oil, such as palm kernel oil, are very 
labor intensive.  This activity explores a machine called an oil press, which can make oil 
production much easier. 
 
How is palm kernel oil produced?   
 
Discuss with your group and list the steps in the space below: 
 
 

1.  

2.  

3.  

4.  

5.  

6.  

7.  

8.  

9.  

10.  

 
Think about it:  
Which steps of this process are most difficult and why? 
______________________________________________________________________________

______________________________________________________________________________

______________________________________________________________________________

__________________________________ 
 
One job for engineers, especially mechanical engineers, is to take 
tasks that are difficult or time consuming, and find ways to make 
them easier.  Machines, such as an oil press, or an oil expeller, 
can help us do our worker easier and quicker than by other 
methods. In the picture below, you can see that we feed seeds in 
the top, and two products come out.  One is oil, the other is 
called the “press cake.”   
 

 
 Source: 

http://openclipart.org/detail/2
7362/postcard-by-coredump-
27362  

Melissa Kemp-Downes� 6/17/12 2:45 PM
Comment [163]: Ask students to explain how 
their families make palm kernel oil…list out the 
steps 
 
Highlight and discuss the steps which are most 
tiresome/tedious and write in the allocated space. 
	  

David Robert Johnson� 1/23/13 12:14 AM
Comment [164]: Should	  be	  something	  like	  
1.	  Gather	  kernels	  	  
2.	  Crush	  the	  kernel	  with	  mortar/pestil	  
3.	  Boil	  the	  crushed	  kernels	  in	  water	  
4.	  Skim	  oil	  off	  the	  surface	  of	  the	  boiling	  water	  
Fairly	  subjective,	  and	  there	  will	  probably	  be	  other	  
steps.	  

David Robert Johnson� 6/20/12 8:55 AM
Comment [165]: This	  is	  fairly	  subjective	  –	  
mostly	  for	  their	  own	  reflection.	  	  Trying	  to	  get	  them	  
to	  think	  about	  using	  machines	  instead	  of	  doing	  
things	  by	  hand.	  
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Now use your imagination.  How does this machine work?  How can it take the seeds and change 
them into oil and press cake simply by turning the crank?  What is going on inside?  Using the 
box below, draw what you think the inside of this machine looks like.  Label the parts and use 
arrows to indicate any motion.  When you finish, share your drawing with a neighbor and 
compare. 

 
 by Gerard van de Garde, source: http://commons.wikimedia.org/wiki/File:Piteba_oliepers_-

_Help_Ghana_op_gang.JPG  

Oil Seeds 
 Crank 

 Oil drips 
into cup 

Press cake  



	   84	  

 

 

 

 

Let’s take this machine apart and see what’s really going on inside.  Ask an instructor to help you 
get started.  Inspect each component and figure out its purpose.  Each component is designed for a 
purpose!  This process of taking a machine apart to understand how it works is called reverse 
engineering.  Reverse engineering is very helpful for inspiration.  You can reverse engineer 
anything - even nature!  For example, how did someone find out that oil can come from the palm 
kernel?  They took one apart! 

 
 

David Robert Johnson� 6/17/12 2:45 PM
Comment [166]: Instructor note: Students will 
ask you to help them take the oil press apart.  Help 
them identify the components and what they do. 
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We see that the press produces oil, which is good for food.  What do we do with the press cake?  
Come up with some creative ideas and write them below: 
 

o  

o  

o  

o  

o  

o  

 

Discuss your ideas with your classmates.  Ask an 
instructor to review your list and suggest any other 
ideas.  Write different ideas from your class and 
teachers below. 
 
 
 
 
This is a concept under the umbrella of sustainability: 

finding ways to use everything we produce, even if it looks like waste.  Even though the main 
goal was to squeeze oil out of the palm kernel, our efforts produced the press cake also.  The basic 
options are to pile it in a corner somewhere, or put it to good use.  The former option gives us 
nothing but a pile we don’t know what to do with; the later allows us to use creative energy to 
make something out of nothing. 
 
Extended Activities: 
What is the purpose of the flame?   
______________________________________________________________________________

______________________________________________________________________________

__________________________________________ 

Math activity: Calculate the percent by weight of oil produced compared with the initial weight of 
the seed fed into the press.  This is “percent extraction efficiency.”  Higher extraction efficiency 
means you get more oil for every turn of the crank. 
 

• Get a scale and use it to measure the weights of 3 small containers.  Record the weights 
and a simple description of each container (e.g., blue, smallest, plastic, etc.).  The weight 
of an empty storage container is called the tare weight.  

o W1tare =  
o W2tare =  
o W3tare =  

 
• Put a handful of oil seeds/nuts into container 1 and weigh it.  The total weight of a 

container full of something is called the gross weight.  
o W1gross= 

 
 

• We don’t want to use the weight of the container in our future calculations; we just want 
to know the weight of the seeds.  The weight of the something inside the container is 

                
 by Haarvey, source: 

http://commons.wikimedia.org/wiki/File:Oil_pres
s_FAES.jpg  

Melissa Kemp-Downes� 6/20/12 8:55 AM
Comment [167]: Explain that the press cake, 
which is usually thrown away in the traditional oil 
expelling method, is still food – e.g.. It can be used 
to feed their animals.  

David Robert Johnson� 1/23/13 12:14 AM
Comment [168]: “Right”	  answers:	  
1.Press	  cake	  is	  typically	  high	  in	  protein	  and	  can	  be	  
used	  to	  feed	  animals	  
2.Fertilizer:	  it	  is	  rich	  in	  nitrogen,	  phosphorus,	  potash	  
and	  magnesium	  
3.	  Fuel	  for	  cooking,	  etc.	  
Ref:	  http://www.piteba.com/eng/index_eng.htm	  

David Robert Johnson� 6/17/12 3:29 PM
Comment [169]: Instructor note: The flame 
provides heat, which makes the oil flow more easily 
out of the seed.  Same concept as adding the ground 
seeds to boiling water instead of cold water. 

Melissa Kemp-Downes� 6/17/12 3:29 PM
Comment [170]: Have	  working	  out	  example	  for	  
students	  to	  see	  and	  apply	  their	  data	  to	  
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called the net weight.   
o Wseeds = W1gross – W1tare = 

 
• Now grind the oil seeds through the press.  Carefully collect the oil in container 2 and the 

press cake in container 3. 
 

• Use the force gauge and measure the weight of the oil and the press cake that you 
produced.  (Hint: you need to come up with a formula to find the net weight of the oil and 
the press cake.  Ask an instructor if you need help, but try to do it yourself!) 

o Woil =  
o Wcake =  

 
• Now we can find the percent extraction efficiency (%EE), which is a property of the oil 

seed and the press that was used to expel the oil. 
o %EE = (Woil)/(Wseeds) x 100% =  

 
Percent extraction efficiency gives us a number to compare the amount of oil which comes from 
certain types of seeds and certain oil extraction methods.  High percent extraction efficiency 
means for the same amount of work, we get more oil than for lower percent extraction efficiency 
methods. 
 
Compare your results with the oil press manufacturer supplied data, given below.  Circle the value 
that the manufacture predicts you will achieve for the type of seed you used.  Were you close or 
far?  Why? 
___________________________________________________________________

___________________________________________________________________

__________________________________________________________________ 
 

 

 

 
“Performance of the PITEBA Oil Expeller with various oilseeds”, 
http://www.piteba.com/eng/performance.htm. Copyright 2012 Piteba, All Rights Reserved. 

 
 

David Robert Johnson� 6/17/12 3:29 PM
Comment [171]: Instructor	  note:	  Woil = W2gross – 
W2tare. Wcake = W3gross – W3tare	  

David Robert Johnson� 6/20/12 9:00 AM
Comment [172]: I	  left	  lots	  of	  data	  on	  the	  sheet	  
(too	  much	  information).	  	  Students	  will	  have	  to	  pick	  
out	  the	  right	  piece	  of	  data	  from	  the	  large	  list.	  

David Robert Johnson� 6/20/12 9:08 AM
Comment [173]: They	  should	  be	  fairly	  close.	  	  If	  
they	  are	  outside	  of	  10%,	  they	  may	  have	  made	  a	  
math	  or	  measurement	  error.	  
	  
To	  answer	  the	  “why”	  question,	  other	  sources	  of	  
error	  (deviation	  from	  published	  values)	  include	  
slight	  measurement	  errors,	  health	  of	  the	  plant	  
where	  the	  kernels	  came	  from,	  variations	  in	  palm	  
tree	  types,	  and	  outside	  temperature.	  
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Lesson 4: Water (Collection - Rain & Ground) 
 
Objective: 

• Students will learn about the water cycle and how water can evaporate 
• Students will then understand how this water evaporation can be collected as a water 

source 
• Students will learn how water can become a source of energy 
• To illustrate how water is stored in an aquifer 
• Show how groundwater can become contaminated, and how this contamination ends up 

in the drinking water well. 
• Students should get a clear understanding of what happens above the ground can 

potentially end up in the drinking water below the ground. 

 
 
The Water Cycle (Rain) 
We know that water can be a liquid, a gas, or a solid. Outside, water is always changing from 
liquid to gas and back again. This process is called the water cycle. You can see how the water 
cycle works. 
 
The sun's heat causes water to evaporate from streams, lakes, rivers, and oceans. The water vapor 
rises. When it reaches cooler air, it condenses to form clouds. When the clouds are full of water, 
or saturated, they release some of the water as rain. 

 

 !

 
 U.S. Geological Survey, Wikimedia Commons, 

 http://commons.wikimedia.org/wiki/File:Water_cycle.png 
 



 

88	  
	  

 

 

Water Cycle Experiment 
 

 Reference: “Make a Mini Water Cycle,” The Water Project, 
http://thewaterproject.org/resources/lesson-plans/create-a-mini-water-cycle.php, Copyright 2012 The Water 
Project Inc., All Rights Reserved.  

 
Groundwater  
(  Excerpt from: “Build Your Own Aquifer”, Louisiana Department of Environmental Quality, 
 http://www.deq.louisiana.gov/portal/Default.aspx?tabid=1966) 

Many communities obtain their 
drinking water from 
underground sources called 
aquifers. Water suppliers or 
utility officials drill wells 
through soil and rock into 
aquifers for the groundwater 
contained therein to supply the 
public with drinking water. 
Home-owners who cannot 
obtain their drinking water 
from a public water supply, 
will have their own private 
wells drilled on their property 
to tap this supply. 
Unfortunately, the groundwater 
can become contaminated by 
harmful chemicals, including 
improper disposal of household 
chemicals such as lawn care 
products and cleaners and any 
number of other pollutants. 

These chemicals can percolate down through the soil and rock and into the aquifer - and 
eventually the well. Such contamination can pose a significant threat to human health. The 
measures that must be taken by well owners and operators to either protects or clean up 
contaminated aquifers is quite costly. 
 

	  	  
 Image: U.S. Geological Survey, Wikimedia Commons, 

http://commons.wikimedia.org/wiki/File:Aquifer_en.svg.  

Melissa Kemp-Downes� 6/17/12 2:45 PM
Comment [174]: Introduce Groundwater and 
explain how it can be beneficial to areas where there 
is not a lot of rainfall 
  
Explain how ground water can easily be 
contaminated. 
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Aquifer Experiment 

 Reference: “Build Your Own Aquifer”, 
http://www.deq.louisiana.gov/portal/Default.aspx?tabid=1966, Copyright 2012 Louisiana Department of 
Environmental Quality, All Rights Reserved.  

 
 
 
Water & Energy  

 (Excerpt from: “Renewable Energy Activities - Choices for Tomorrow”, National Renewable 
Energy Laboratory, 2001, http://www.nrel.gov/docs/gen/fy01/30927.pdf) 
 
When water is collected behind dams on large rivers, it provides 
a source of energy for the production of electricity. The 
enormous power of falling water is capable of turning giant 
turbines. These turbines drive the generators, which produce 
electricity. The degree of power is determined by the amount of 
water and the distance it falls. Hydroelectric power plants do not 
cause pollution, but there are fewer and fewer places to build 
dams. The environmental problem arises because a dam is 
typically built on a river creating a lake where land once stood. 
Water is a renewable energy source. 

 

Reference: Water Crossword Puzzle, www.groundwater.org/kc/docs/water_crossword_puzzle.pdf. 
Copyright 2012 The Groundwater Foundation, All Rights Reserved.  

 

Reference: Groundwater Word Search, 
www.groundwater.org/kc/docs/groundwater_word_search.pdf. Copyright 2012 The Groundwater 
Foundation, All Rights Reserved.  

 
 
 
 
 
 
 

 
 by Alberto 

Miranda Dencowski, source: 
http://openclipart.org/detail/170
124/ecology-by-mrallowski  

Melissa Kemp-Downes� 6/17/12 2:45 PM
Comment [175]: Briefly	  explain	  to	  students	  how	  
water	  can	  also	  create	  energy	  (which	  other	  groups	  
will	  be	  focusing	  on,	  this	  group	  is	  just	  working	  on	  
water	  collection,	  but	  all	  systems	  interlock	  and	  are	  
closely	  related).	  

Melissa Kemp-Downes� 6/19/12 5:01 PM
Comment [176]: 	  
DOWN 
1. gecko 
2. recharge 
4. clouds 
6. wetland 
7. aquifer 
9.	  well	  
	  
ACROSS 
1. groundwater 
3. cycle 
5. ocean 
8. river 
10. pollute 
11. clean 
12.	  drink	  
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Lesson 5: Water Distribution (Purification & Irrigation)  
 
Objectives: 

• Understand the process of condensation and evaporation in the purification of water 
• Understand how and why solar energy can also be used to purify water 
• Understand and develop effective water distribution strategies 
• Explore civil engineering, engineering design, planning, construction, teamwork, and 

working in groups. 
• Operationally define irrigation, while observing and classifying irrigation systems. 
• Infer the need for irrigation systems & describe the different types. 
• Construct a model and identify the model by observing the characteristics 

 
 
 

Water Purification Experiment 
 
 
 

Reference: “Water Purification Experiment”, 
http://learningtogive.org/lessons/unit389/lesson2.html. Copyright 2012 LearningtoGive.org. All rights 
reserved. Permission is granted to freely use this information for nonprofit, noncommercial, educational 
purposes only.  

 
 
 
Materials: 

• Large Strainer 
• Coffee Filter 
• ½ inch layer of sand  
• 1 Inch of topsoil 
• Clear glass for water 

 
Directions 

1. Line a medium-size strainer with a coffee filter. Add a 1/2 inch layer of sand and an inch 
of topsoil. Put the strainer over a clear jar. Tell the students that this demonstration 
represents the natural water treatment process. This is how nature treats storm water 
flowing over a natural area with healthy drainage. Stir 2 tablespoons of dirt into a cup of 
water, then pour the dirty water through the sand and soil in the filter. Ask the students to 
observe the water in the bottom of the container and the condition of the sand and soil. 

2. How does the water look different after it goes through the ground filter? 

 
 Source: 

http://openclipart.org/detail/388
57/water-droplet-by-mbalax  

Melissa Kemp-Downes� 6/17/12 2:45 PM
Comment [177]: Students experiment with a 
natural water filtration process. 
  
They review the water cycle and come to an 
understanding about the need to sustain the quality 
of the world's water for the common good.  
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3. What other kinds of dirt or waste do you think this filter system will clean up? Try some 
of the students proposals/ideas, if possible. 

 
Questions: 
What kinds of pollution do you think might not be filtered out by this natural process?  
 
_____________________________________________________________________________________________________ 
 
_____________________________________________________________________________________________________ 
 
_____________________________________________________________________________________________________ 
 
_____________________________________________________________________________________________________ 
 
The Earth is a closed system—no water is ever added to the system over time, and we share the 
water with everyone in the world. For that reason, we need to be responsible with the water we 
use. Look at a glass of filtered water. The H2O molecules of water in this glass may have fallen 
on the heads of dinosaurs, washed the hands of Civil War soldiers, satisfied the thirst of Olympic 
athletes or flowed down the Amazon River along with the crocodiles. 
 
How can this be?  
 
_____________________________________________________________________________________________________ 
 
_____________________________________________________________________________________________________ 
 
 
Polluted water affects us all now and in the future because water is a common resource we share 
with all people and animals. What we do locally ends up in the global water system. Water is 
never created; it is recycled and shared repeatedly.  Water is a common resource and its quality 
must be sustained for the common good. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Melissa Kemp-Downes� 6/21/12 4:13 PM
Comment [178]: The	  Water	  Cycle,	  water	  is	  
constantly	  circulating	  through	  condensation,	  
evaporation	  and	  precipitation.	  	  
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Water Distribution Experiment 
 
 

Reference: Lesson Focus, Lesson Synopsis, Student Worksheet including Ethical Implications and 
Design Your Own Irrigation Systems, http://tryengineering.org/lesson_detail.php?lesson=53. Copyright 
2012 IEEE, All rights reserved.  

 

Reference: The Different Irrigation Systems and Their Uses, http://www.crwcd.org/page_144, 
Copyright 2012 Colorado River Water Conservation District, All rights reserved.  

 
 
 
 

 
 
 

 
 by cybergedeon, 

source: 
http://openclipart.org/detail/170521/
eco-green-watering-icon-by-
cybergedeon-170521  

 
 by Brendel, source: 

http://commons.wikimedia.org/wiki/
File:Irrigation_system.JPG  
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Lesson 6: Energy (Solar) 
 
Objectives: 

• Review the basic needs for alternative energy sources.  
• Identify at least 3 different materials that will produce maximum heat. 
• Identify at least 3 different colors that will produce maximum heat.  
• Solve a design problem for a solar hot box. 

 
Lesson: 
Brainstorm as many energy sources as you can in the space below: 
 
 
 
 
 
 
 
 
 
 
 
       
   
 
Discuss which of the energy sources are used every day and which ones are alternative 
sources. Why do we consider some energy sources alternate and some not? 
 

_____________________________________________________________________________________________

_____________________________________________________________________________________________

_____________________________________________________________________________________________

________________________ 

___________________________________________________________

__________________________________________ 

 

Energy 
Sources 

 
 by Alberto 

Miranda Dencowski, source: 
http://openclipart.org/detail/169592
/green-earth-by-mrallowski  

Melissa Kemp-Downes� 6/17/12 2:45 PM
Comment [179]: This lesson will begin with a 
review of what alternate energy sources are. Each 
student will be required to brainstorm as many 
energy sources as they can in a set time limit. At the 
end of the time limit the students will discuss which 
of the energy sources are used every day and which 
ones are alternative sources. Ask the students to 
discover for themselves why we consider some 
energy sources alternate and some not. 
 
Explain to the students that today they will 
experiment with solar heating. 
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Solar Experiment 
 

 
 

Reference: “Solar Oven”, http://www.energyforeducators.org/lessonplans5/solaroven.pdf. 
Copyright 2009 Idaho National Laboratory, All Rights Reserved. 

 

 
Today you will experiment with solar heating. During this 
activity you will be able to: 

 
o Predict and discuss why/which colors will absorb or reflect 

heat. 
o Define what a solar hotbox is. 
o Define what a solar collector is. 

 
 

Predict and discuss why/which colors you feel will absorb or 

reflect heat.  

______________________________________________________________________________

______________________________________________________________________________

______________________________________________________________________________

______________________________________________________________________________

____________________________________________________________ 

 

Define what a solar hotbox is. 

______________________________________ 

______________________________________ 

______________________________________ 

______________________________________ 

 
 Source: 

http://openclipart.org/detail/2
2012/weather-symbols:-sun-
by-nicubunu  

 
 Source: 

http://commons.wikimedia.org/wiki/File:Fours
_solaires_ULOG_sun_oven_horno_solar.jpg  

Melissa Kemp-Downes� 6/21/12 4:42 PM
Comment [180]: Dark colors absorb a lot 
more heat than lighter ones because they 
absorb more light energy. In fact, the closer to 
black a color is, the more heat it absorbs from 
light sources. The key is that colors do not 
absorb different amounts of heat, only heat from 
light. Dark and light colored clothes coming out 
of a dryer will be the same temperature. 
However, because light clothes reflect more 
light when a person is outside, the 
accompanying heat from the sun is reflected as 
well. Since dark clothes reflect little solar light, 
they reflect little solar heat and are hotter as a 
result. 
	  

Melissa Kemp-Downes� 6/21/12 4:41 PM
Comment [181]: Colors like pink or yellow are 
often called "bright" because of the high degree 
of light they reflect back. Visual light is 
composed of numerous different colored 
wavelengths which make a white light when 
combined. Therefore light colors such as pastel 
yellows or pinks are perceived that way 
because most light wavelengths are reflected 
back to our eyes. Since most light is reflected, 
little light (or heat) is absorbed. 
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Define what a solar collector is.  

______________________________________________________________________________

______________________________________________________________________________

______________________________________________________________________________

_____________________________________________ 

 
Experiment: 
 

Reference: Solar Oven Experiment, Mrs. Adams, 
http://mrsadamsthirdgradeclass.blogspot.com/p/science.html. All Rights reserved. 

 

Activity: 

List conditions outside that would help or hinder the solar heating process: 

Help Solar Heating Hinder Solar Heating 

  

  

  

  

  

  

  

 

 
 Source: http://openclipart.org/detail/110173/face-

house-by-mlampret  

Melissa Kemp-Downes� 6/21/12 4:38 PM
Comment [182]: A solar hot box differs from a 
solar collector only in the respect that the solar heat 
is collected and contained in the box is not purposely 
transferred. The heat from a solar collector is usually 
transferred from the collector by a heated air or 
water medium to another location	  

Melissa Kemp-Downes� 6/17/12 2:45 PM
Comment [183]: Procedure: 
1.     Students will build their own hot box using the 
colors and materials they choose. Students can work 
in smaller groups to build their boxes and conduct 
the experiment. 
2.     Explain that each hotbox groups will go outside 
and complete a temperature experiment to determine 
the maximum temperature it will reach. 
3.     Have each group set their experiment up with a 
thermometer on the inside. 
4.     At one-minute intervals have each group record 
the temperature of the hot box. Do this for ten (10) 
minutes. 
5.     Bring the results into the classroom and record 
the temperatures for each group on the board. 
6.     Ask the students which hotbox achieved the 
highest temperature the fastest. 
	  

Melissa Kemp-Downes� 6/17/12 2:45 PM
Comment [184]: When the students have 
decided which box worked the best and which one 
didn’t work ask them to brainstorm conditions 
outside that would help or hinder the solar heating 
process. Optional: Make a list on a large piece of 
paper and hang it in the room. 
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Lesson 7: Energy (Wind & Hydro) 
Objectives: 

• Analyze the importance of energy and how we use energy in our daily lives 
• Describe difference between renewable and non-renewable sources of energy  

 
Hydropower 
 

 Reference: Excerpt from Water Power Program, U.S. Department of Energy, 

http://www1.eere.energy.gov/water/how_hydropower_works.html.  
 
Hydropower is using water to power machinery or make electricity. Water constantly moves 
through a vast global cycle, evaporating from lakes and oceans, forming clouds, precipitating as 
rain or snow, and then flowing back down to the ocean. The energy of this water cycle, which is 
driven by the sun, can be tapped to produce electricity or for mechanical tasks like grinding 
grain. Hydropower uses a fuel—water—that is not reduced or used up in the process. Because 
the water cycle is an endless, constantly recharging system, hydropower is considered a 
renewable energy.  We learned about this in Lesson 4: Water (Collection - Rain & Ground).  
This is called the hydrologic cycle, also known as the water cycle. 
 
When flowing water is captured and turned into electricity, it is called hydroelectric power or 
hydropower. There are several types of hydroelectric facilities; they are all powered by the 
kinetic energy of flowing water as it moves downstream. Turbines and generators convert the 
energy into electricity, which is then fed into the electrical grid to be used in homes, businesses, 
and by industry. 
 
Hydropower Experiment 
This activity will let you investigate the water wheel, one of the simplest and oldest methods for 
capturing the energy, which is stored in flowing water.  The image below shows a water wheel.  
Water flows over the wheel, making it turn.  In this case, the turning motion is converted to 
reciprocating (back and forth) motion, which drives a pair of saws for cutting wood. 

 

Saws powered by a water wheel.  

  by Chris, source: 
http://en.wikipedia.org/wiki/File:R%C3%B6mische_S%C3%A4gem%C3%BChle.svg  



 

97	  
	  

 

The water wheel you will investigate looks like one the image below.  Use a container to slowly 
pour water onto the water wheel from the top.  Pour it so the sections of the water wheel fill up 
with water, and watch the system as a whole as each section fills up.  This causes the wheel to 
turn, and then the section empties out the water near the bottom.  This cycle continues as long as 
you keep pouring water! 
 

 
Photographs of water wheels for experiment  

 Photo by University of Michigan 
 
Play with it a little bit.  Pour water near the edge of the wheel or closer to the center.  Where is 
the best location to direct the flow of water to get the fastest wheel speed?  Why? 
 
_____________________________________________________________________________________________

_____________________________________________________________________________________________

_____________________________________________________________________________________________ 

 
Now pour water faster or slower.  Again, what makes the wheel spin the fastest?  Why? 
 
_____________________________________________________________________________________________

_____________________________________________________________________________________________

_____________________________________________________________________________________________ 

 
Can you think of any other factors, which could make the wheel spin faster?  Write your ideas 
below, try them out, and record your results and observations. 
 
_____________________________________________________________________________________________

_____________________________________________________________________________________________ 

Now use the water wheel to try to do some work.  Get a light object, such as a partially filled 
water bottle, and tie one end of a string around the top of the bottle and the other end of the string 
around the output shaft of the water wheel (see the images below).  Make sure to wind the string 

David Robert Johnson� 6/20/12 9:54 AM
Comment [185]: Direct	  the	  water	  as	  far	  from	  
the	  center	  of	  rotation	  as	  possible.	  The	  water	  stream	  
has	  more	  leverage	  against	  the	  rotating	  shaft	  near	  
this	  outer	  edge.	  

David Robert Johnson� 6/20/12 9:55 AM
Comment [186]: Faster	  moving	  water	  moves	  
the	  wheel	  faster	  because	  there	  is	  more	  energy	  in	  a	  
faster	  flow	  than	  a	  slower	  flow.	  	  That’s	  a	  very	  
“sciency”	  reason	  –	  the	  kids	  may	  come	  up	  with	  
something	  a	  little	  more	  down	  to	  earth.	  

David Robert Johnson� 6/20/12 9:57 AM
Comment [187]: Subjective.	  	  One	  thing	  to	  try	  
would	  be	  spinning	  the	  wheel	  either	  forward	  (as	  the	  
wheel	  is	  designed)	  or	  backward.	  
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around the output shaft a few times.  Pour water over the wheel as you did before and see if the 
rotation of the wheel can lift the object. 
 

 

 

 

Images of tying a string to the water wheel in order to lift a light object, such as a water bottle.  
 Photos by University of Michigan 

 

Were you successful in lifting your object?  Why or why not? 
 

_____________________________________________________________________________________________

_____________________________________________________________________________________________

_____________________________________________________________________________________________ 

 
Could you change anything to make your attempt at lifting the object more successful?  If so, 
what could you do?  If you have time, try it! 
 
_____________________________________________________________________________________________

_____________________________________________________________________________________________

_____________________________________________________________________________________________ 

 

David Robert Johnson� 6/20/12 9:57 AM
Comment [188]: The	  object	  may	  be	  too	  heavy	  
to	  lift	  if	  they	  were	  not	  successful.	  

David Robert Johnson� 6/20/12 9:59 AM
Comment [189]: Ideas	  include	  removing	  some	  
weight,	  doing	  a	  better	  job	  of	  directing	  the	  water	  
flow,	  and	  pouring	  water	  faster.	  
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Wind Power 
Blow a puff of air out of your mouth – using your muscles, you created an area of high pressure 
inside your lungs.  Pressure means that a fluid has been pressed – energy is stored inside it.  You 
can contain this pressure by keeping your mouth closed instead of letting the puff of air out!  
When you open your mouth, the pressurized air flowed out into the atmosphere and the pressure 
was balanced.  Fluids such as air always travel from regions of high pressure to regions of low 
pressure in an effort to balance pressure. 
 
In the Earth’s atmosphere, regions of high pressure are created by the heat of the sun.  Air in 
high pressure regions flows to regions of lower pressure, and this flow is known as wind.  Unlike 
the puff of air you produced using your mouth, the wind around the world never stops!  Solar 
heating of our planet keeps the air moving.  Therefore, like hydropower, wind power is also 
considered a renewable energy source. 
 
To harness this power, wind turbines are constructed in locations where wind speeds are high.  
Wind flows over the blades, creating a force which turns the rotor disk.  This turning rotor disk 
supplies power which can be harnessed and used in many different ways. 
 

 
  “Windmills in Spain” by Jesus Martinez, source 

http://en.wikipedia.org/wiki/File:Toro_de_osborne.jpg. 
 
 
Wind Power Experiment 
This experiment will give you the opportunity to explore how wind power can be harvested to do 
useful work.  You will use the same experimental setup as you used for the hydropower 
experiment, but you will need to reconfigure it.  Use the images below to help you make the 
conversion. 

 



 

100	  
	  

  

  

  

Steps to convert from hydropower experiment to wind power experiment.  

 Photos taken by the University of Michigan 

 
Place the windmill in front of a fan and turn the fan on.  If it is a windy day, just take it outside 
and let the wind drive the windmill.  Watch how the blades of the windmill are able to generate a 
force and spin in a circle.  Put your fingers on the driveshaft and feel the power generated.  When 
the windmill is spinning freely, after a few seconds, it reaches its maximum rotational speed. 
 
The blades on this windmill can pivot on the red hub.  Rotate the blades to different angles (try to 
keep them all nearly the same angle) and place the windmill in the airflow again. The angle 
between the wind direction and the lengthwise direction of the blade is called the angle of attack 
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– see the illustration below. The black lines are called streamlines – they indicate the direction of 
the flow.  In other words, the air flows along the streamlines.  The blue shape is a cross-sectional 
view of the blade – as if you were looking down the length of a single blade. 
 

 
 Illustration of angle of attack, indicated by Greek letter alpha (α).  
Source: http://en.wikipedia.org/wiki/File:Angle_of_attack.svg  

 
For different angles of attack, you will observe different maximum rotational speeds. Try 
extreme cases where the blades are perfectly parallel or perfectly perpendicular to the wind.  Try 
to find an optimal, or best, angle which produces the highest maximum rotational speed.  In the 
space below, draw a picture, similar to the illustration above, showing your blade orientation 
with respect to the wind.  Indicate the angle of attack also. 
 
Move the windmill closer to or farther away from the fan (if you are using a fan).  Can you find 
an optimal distance from the fan which produces the highest rotational speed of the blades?  
Please explain below. 
 
_____________________________________________________________________________________________

_____________________________________________________________________________________________

_____________________________________________________________________________________________

_____________________________________________________________________________________________ 

David Robert Johnson� 6/20/12 10:27 AM
Comment [190]: Too	  close,	  and,	  for	  a	  small	  fan,	  
the	  wind	  will	  only	  touch	  one	  blade	  at	  	  a	  time.	  	  Too	  
far	  and	  the	  wind	  will	  slow	  down	  and	  disperse.	  
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Similar to the hydropower experiment, fasten a string and a light object to the output shaft of the 
windmill.  Note that this time, the output shaft is on the inside of the frame (hint: it’s the shaft 
which has two gears on it).  Holding the setup in the wind, attempt to lift the object using wind 
power. 
 
Were you successful in lifting your object?  Why or why not? 
 
_____________________________________________________________________________________ 

_____________________________________________________________________________________________

_____________________________________________________________________________________________

_____________________________________________________________________________________________ 

 
Could you change anything to make your attempt at lifting the object more successful?  If so, 
what could you do?  If you have time, try it! 
 
_____________________________________________________________________________________________

_____________________________________________________________________________________________

_____________________________________________________________________________________________

_____________________________________________________________________________________________ 

 

David Robert Johnson� 6/20/12 10:27 AM
Comment [191]: Again,	  the	  object	  may	  be	  too	  
heavy.	  

David Robert Johnson� 6/20/12 10:28 AM
Comment [192]: Remove	  weight,	  move	  the	  
windmill	  closer	  to	  or	  farther	  from	  the	  fan,	  change	  
angle	  of	  attack	  of	  the	  blades,	  etc.	  
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Follow Up Questions 
Why are hydropower and wind power considered renewable forms of energy? 
 
_____________________________________________________________________________________________

_____________________________________________________________________________________________

_____________________________________________________________________________________________ 

 
Do you feel that hydropower or wind power is more effective?  Why?  Under what 
circumstances would the other one become more effective? 
 
_____________________________________________________________________________________________

_____________________________________________________________________________________________ 

Where does the water come from which drives a hydropower plant?  In other words, how does 
the hydrologic cycle, also known as the water cycle, work?  (You might want to review Lesson 4 
if you need some help) 
 
_____________________________________________________________________________________________

_____________________________________________________________________________________________

_____________________________________________________________________________________________ 

 
Why does wind exist and how is it created? 
 
_____________________________________________________________________________________________

_____________________________________________________________________________________________

_____________________________________________________________________________________________ 

 
In this lesson, we used hydropower and wind power to lift (or try to lift) an object.  What other 
uses can you think of for hydropower and wind power? 
 
_____________________________________________________________________________________________

_____________________________________________________________________________________________

_____________________________________________________________________________________________

_____________________________________________________________________________________________ 

 
Extension Activity 
 
Try to make your own windmill blades!  Look around in the camp and in nature and see what 
creative ideas you can come up with.  Build the blades, and if possible, try them out on the 
experimental setup to see if they work. 

David Robert Johnson� 6/20/12 10:29 AM
Comment [193]: Wind	  and	  moving	  water	  will	  
always	  be	  present	  on	  earth,	  so	  we	  can	  extract	  
energy	  from	  them.	  	  Nothing	  is	  used	  up	  or	  consumed	  
in	  the	  process	  in	  contrast	  to	  burning	  fuel.	  

David Robert Johnson� 6/20/12 10:31 AM
Comment [194]: Fairly	  subjective.	  	  I	  think	  most	  
students	  will	  find	  that	  hydropower	  is	  more	  effective	  
here	  because	  the	  energy	  in	  the	  flowing	  water	  is	  
higher	  than	  in	  the	  small	  amount	  of	  wind	  generated	  
by	  our	  battery	  powered	  fans.	  	  In	  a	  dry	  area	  with	  high	  
winds,	  wind	  power	  would	  be	  much	  more	  effective	  
than	  hydro.	  	  In	  a	  mountainous	  area	  with	  abundant	  
flowing	  water,	  hydropower	  would	  be	  more	  effective	  
than	  wind.	  

David Robert Johnson� 6/20/12 10:33 AM
Comment [195]: Water	  evaporates	  from	  bodies	  
of	  water,	  precipitates	  from	  the	  sky,	  and	  runs	  from	  
areas	  of	  high	  elevation	  to	  areas	  of	  low	  elevation.	  	  
Because	  this	  cycle	  is	  neverending,	  we	  always	  have	  
hydropower.	  	  (see	  lesson	  4	  and	  the	  text	  of	  this	  
lesson)	  

David Robert Johnson� 6/20/12 10:34 AM
Comment [196]: Wind	  is	  flowing	  air.	  	  The	  air	  
flows	  because,	  due	  to	  solar	  heating	  of	  the	  earth,	  
areas	  of	  high	  and	  low	  pressure	  are	  created	  in	  the	  
atmosphere.	  	  Air	  must	  flow	  from	  high	  to	  low	  
pressure,	  so	  wind	  is	  generated.	  	  (see	  the	  text	  of	  this	  
lesson)	  

David Robert Johnson� 6/20/12 10:35 AM
Comment [197]: Generating	  electricity,	  grinding	  
grain,	  sawing	  wood,	  etc.	  	  Anything	  that	  you	  need	  
power	  for!	  
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IMPORTANT NOTE!!! 
When you finish the activity, make sure you have all of the components for this activity.  The 
component list is below; use it as a checklist, and check in with your instructor.  Use the picture 
to help you. 
 
Component checklist: 
 
□ 1 Water wheel 

□ 1 Large frame piece 
□ 1 Small frame piece 
□ 2 Shafts (black) 

□ 1 Small gear (yellow) 
□ 2 Large gears (yellow) 
□ 1 Collar (black) 

□ 1 Rotor disk 
o 3 blades (blue) 
o 1 hub (red) 

 

 
Components in the wind/hydro experiment kits 

   Photos taken by University of Michigan 
 

 

 

 
 
 
 
 
 
 
 

Melissa Kemp-Downes� 6/19/12 5:58 PM
Comment [198]: 	  
1.	  Water	  
2.	  Water	  cycle	  
3.	  Water	  Vapor	  
4.	  Gravity	  
5.	  Penstock,	  Dam	  
6.	  Turbine,	  Electricity	  
7.	  Renewable	  
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Hydro Power Activity 
 
 

Reference: Hydro Power Activity. 
http://www.need.org/needpdf/Elementary%20Infobook%20Activities.pdf. Copyright 2012 National Energy 
Education Development, All rights reserved. NEED materials may be reproduced for non-commercial 
educational purposes. 
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Lesson 8: Energy (Biogas) 
 
Objective: 

• Analyze the importance of energy and how they use energy in their lives 
• Describe the difference between renewable and non-renewable energy 
• Experiment with creating and capturing biogas 

 
Lesson: 
Introduction 
In China, and in many other areas of the world, biogas digesters have been introduced into rural 
communities. People learn how to build and maintain biogas digesters to provide a cheap and 
simple way to get energy from a renewable source, that they have easy access to – animal 
manure. By using biogas digesters, people no longer need to cut down trees for firewood. This in 
turn helps stabilize and protect the environment. In addition, by not having to collect firewood, 
each household saves up to three hours a day of work that they can now direct towards other 
productive activities.  
 

Reference: Winter in Songming, https://shop.heifer.org/shop/books-and-dvds/winter-in-
songming.html, Copyright Heifer International, All rights reserved.  

 
Biogas as a form of Energy  
Zadou uses a gas burner to cook breakfast. Just like those in Songming County, people have 
recently started to use a source of energy called biogas to fuel their gas burners.   
 
What is biogas? What is methane gas?   
Biogas is a form of energy that comes from living things. Biogas is generally made from animal 
manure. In Songming County, the biogas comes from pig and cattle manure. The people use 
biogas digesters to convert the manure into methane gas, which is a type of biogas.  
 
Look at the “Diagram of Biogas Digester” on the below and, as a group, discuss how the biogas 
digester works 
 

Diagram of Biogas Digester 
 

 

Reference: “Biogas As A Source Of Energy”, http://www.heifer.org/PDF/GERK_Kits/Grades_3-
4_Lesson_3.pdf. Copyright 2012 Heifer International, All Rights Reserved.   

 
 

 

Melissa Kemp-Downes� 6/17/12 2:45 PM
Comment [199]: Revisit the main concept of 
energy – re-explain the concept of renewable energy 
vs. non-renewable energy (revisit lesson on day one). 
 
How do we use energy? What types of energy can 
you identify? When we move, we are using energy. 
When we talk or think, we are also using energy. 
Ask students to name five activities they do each 
day, which uses energy. Next, inquire if they can 
think of anything they do that does not require 
energy (No – everything requires energy!!!) 
  
Ask the students, ‘Where does this energy come 
from?’ Listen to their responses. Summarize 
statements by writing them on the board. Guide 
students to the conclusion that all energy comes from 
the sun. 
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Creating Biogas Experiment 

 

Reference: “Biogas As A Source Of Energy”, http://www.heifer.org/PDF/GERK_Kits/Grades_3-
4_Lesson_3.pdf. Copyright 2012 Heifer International, All Rights Reserved.   

 
 
 
 
 

Manure & Soil       Food Scraps & Soil             Just Soil 

           
 

 Source: http://simplytheclassroom.blogspot.com/2012/01/matter-experiments-or-magic-tricks.html 

          
 “Biogas plant sketch” Source: 

http://commons.wikimedia.org/wiki/File:Biogas_plant_sketch.jpg  
  “Biogas plant, South Africa” by SuSanA Secretariat, source: 

http://commons.wikimedia.org/wiki/File:Biogas_plant,_South_Africa_%282941813674%29.jpg  
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Methane Production Chart 

 
Question: What will happen if we combine microbes with food? ________________________ 
 
Group Hypothesis:  

______________________________________________________________________________

______________________________________________________________________________

______________________________ 

 
People can use methane gas to create energy to power their stoves and cook food. Let’s see if we 
can make methane gas. Follow your teacher’s directions for the experiment, and keep track of 
your data using this chart. 
 
Questions: 
As the days went by, what happened to the level of the mixture in the bottle?      
 
______________________________________________________________________________ 
 
As the days went by, what happened to the circumference of the balloon?      
 
______________________________________________________________________________ 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
What caused the level of the mixture to change?      
 
______________________________________________________________________________ 
 
 
What caused the circumference of the balloon to change?     
 
 
______________________________________________________________________________ 

Day Level of Mixture in Bottle Circumference 

   

   

   

   

   

   

   

Melissa Kemp-Downes� 6/19/12 5:59 PM
Comment [200]: Should	  decrease	  as	  it	  
breaksdown	  	  

Melissa Kemp-Downes� 6/19/12 6:00 PM
Comment [201]: Should	  expand/increase	  

Melissa Kemp-Downes� 6/19/12 6:00 PM
Comment [202]: Microbes	  in	  the	  soil	  

Melissa Kemp-Downes� 6/19/12 6:01 PM
Comment [203]: The	  gas	  emitted	  from	  the	  
microbes	  breaking	  down	  the	  soil	  
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How did microbes get into the bottle?      
 
______________________________________________________________________________ 
 
Was your hypothesis correct? How do you know?      
______________________________________________________________________________ 
 
Discuss biogas as a renewable form of energy… 
With your group, discuss how Zadou’s family was able to create energy by using manure from 
their pigs and water buffalo. They used this energy to cook their meals on their gas burner.  
 
______________________________________________________________________________

______________________________________________________________________________

______________________________________________________________________________

______________________________________________________________________________

______________________________________________________________________________ 

 
Is biogas a renewable source of energy or not?  
Discuss how this source of energy is a cheap and easy way for people in Songming County and 
in many parts of the world to get energy. 
______________________________________________________________________________

______________________________________________________________________________

______________________________________________________________________________

______________________________________________________________________________ 

 
 

 

 
!

 
 by Alberto Miranda Dencowski, source: 

http://openclipart.org/detail/169592/green-earth-by-mrallowski 
 

Melissa Kemp-Downes� 6/19/12 6:01 PM
Comment [204]: They	  live	  in	  the	  soil	  

Melissa Kemp-Downes� 6/17/12 2:45 PM
Comment [205]: At the end of the experiment, 
discuss with students how Zadou’s family was able 
to create energy by using manure from pigs and 
water buffalo. They used this energy to cook their 
meals on their gas burner. Explain to students what 
their stoves at home use. Zadou’s family has a 
similar type of burner, but it uses biogas instead. 
	  

Melissa Kemp-Downes� 6/17/12 2:45 PM
Comment [206]: Ask, ‘Is biogas a renewable 
source of energy or not?’ You must first consider 
what the source of energy is. The source of energy is 
from manure of animals. Is this source of energy 
renewable? Yes, because you can continue to get 
manure from the animals for as long as they are 
alive. Thus, this is a renewable source of energy. 
Discuss how this source of energy is cheap and easy 
for many parts of the world to get energy. 
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Extra Experiments & Activities  

(Time/Equipment Permitting) 
 
Ethnobotany 
 

Reference: Ethnobotany, http://extension.uga.edu/k12/science-behind-our-food/lesson-
plans/Ethnobotany.pdf. Copyright 2005, Georgia Agriculture Education, All Rights Reserved.  

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 
 Source: 

http://pixabay.com/en/tree-branches-aesthetic-
tribe-log-51367/  

Melissa Kemp-Downes� 6/17/12 2:45 PM
Comment [207]: This lab is an investigative lab 
activity that can also incorporate discussion 
regarding the importance of agriculture in our 
culture. Students will work in teams to prepare soil 
samples and other teams will develop a method for 
sorting and sifting out the plant material and then 
determining what the plant material says about the 
‘culture.’ 
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Computer Lab 
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Computer Lab (4 - 2 hour sessions) 

 
Objective: To introduce students to the use of computers and computer’s ability to simplify 
tasks of importance to engineers and agriculturalists.  
 
Lesson Summary: 
 
Lesson 1 – Introduction to computers 
Objectives: To get familiarized with computers and its use. 
Description: The topics will include: A) History of computers from its first invention and its 
evolution to modern global networks. B) Parts of a computer: Input Devices, Hardware, 
Software, Operating System. C) Exploring the operating system: File system, Accessories (paint, 
calculator, notepad), basic functionality like opening and closing programs and windows. 
Important concepts: Internet, Networks, Input Devices, Hardware, Vacuum Tubes, Transistors, 
Microprocessor, CPU, Software, Operating System, File System, Programs and Programming, 
Windows, File, Properties. 
 
Lesson 2 – Explore office programs 
Objectives: To learn how to use basic but important Microsoft Office or Open Office software. 
Description:  We will explore how to open: a) Writer (similar to Word), b) Calc (similar to 
Excel), c) Impress (similar to PowerPoint) and navigate throughout the Menu bars, explain the 
different commands, formatting a document, insert pictures, plot excel data, use functions to 
make calculations, edit text, set up a template for presentations, make figures, and basic 
PowerPoint animations. 
Important concepts: Menu Bar, Commands, Formatting, Plot, Formulas, Template, Animation. 
 
Lesson 3 – Typing tutor and Google Sketch up 
Objectives: To learn basic typewriting skills and drawing skills. 
Description: this will be a 30 min introduction/explanation and 30 min practice lesson for each 
topic. We will use open source/free software to teach the students basic typing skills and basic 
drawing skills. 
Important concepts: Typing, Typewriting, Sketch, Sketching, Draw, Drawing, Software, Lines, 
Contour. 
 
Lesson 4 – Internet and introduction to programming. 
Objectives: To learn basic concepts about the Internet and programming. 
Description: We will explore the use of internet for learning purposes, the use of search engines, 
Wikipedia and communication systems like MSN Messenger and Skype, we will also give an 
introduction to programming using Scratch, which is a tool to learn programming skills to kids, 
they will make their own small computer game using Scratch 
Important concepts: Internet, Intranet, Program, Programming, Search Engine, Web Page, 
Communication Systems 
 
 
NOTE: All screenshots in this section are included under Fair Use exceptions.  
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Lesson 1a: History of Computers 
 

Reference: History of Computers, 
http://www.computersciencelab.com/ComputerHistory/History.htm. Copyright 2002 John Kopplin, All 
rights reserved. 

 

Lesson 1b: Parts of a Computer 
 
We will show you a video that explains the parts of a Computer. 
 
II. Parts of a Computer 
  

Vacuum Tubes are devices that control electric current through a vacuum (no air) in a 
sealed container. They are very fragile and bulky. Thousands of theses had to be used in 
the ENIAC computers in the 1940s, which contributed to its gigantic size. 
 

 
 
 

Transistors are semiconductor devices (a 
material that allows electricity to flow 
through it) used 
to amplify and switch electronic signals 
and power. The reason we don’t have 100 
foot long computers anymore is because of 
the invention of the transistor! Since being 
developed in the 1950s, the transistor is 
the fundamental building block of 
modern electronic devices. It was the 
gateway to make computers miniature.  

 
Figure 2A. Miniature Vacuum Tubes  by Stefan Riepl, source: 

http://en.wikipedia.org/wiki/File:Elektronenroehren-auswahl.jpg  
 !

!
!
!
!

 
Figure 2B. Transistor  source: 
http://commons.wikimedia.org/wiki/File:Trans
istors.agr.jpg   
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Integrated Circuit (or micro chip) consists of many complex electrical circuits which 
have been etched onto tiny chips of semiconductor. They do the “thinking” and 
calculations that need to be done by a computer. 

Central Processing Unit (CPU) is the “brain” of the computer. A CPU’s job is to 
execute a sequence of stored instructions called a program. These instructions are carried 
out in the blink of an eye. 

Microprocessor incorporates the functions of a CPU on a single integrated circuit. This 
was another step into making computers and other electrical devices so small. 

Software is a term used to describe the computer programs and instructions used to tell 
the hardware what to do. 

Computer Programming is the iterative process of writing computer programs (or 
software). Programming involves testing, analyzing and refining the computer program. 

 Hard Disk Drive holds all of the computers information. 

 CD Drives use lasers to read (retrieve) data from a CD (just like a walkman). 

 A computer Monitor displays information in visual form. 

 A mouse is used to select objects on the monitor. 

 A keyboard is a board used to input data (numbers or letters) into the computer. 

Hardware is a term used to describe all the physical things on a computer that you can 
see and touch. 

Input Devices are any piece of computer hardware equipment used to provide data. A 
mouse and a keyboard are input devices that allow users to provide data to the computer. 

An operating system (OS) is a set of software that manages computer hardware 
resources and provides common services for computer programs. The operating system is 
a vital component of the system software in a computer system. Application programs 
require an operating system to function. 

 Common Operating Systems: Microsoft Windows and Apple’s Macintosh OS X 

A computer uses a File System as a way to organize its’ information. Each file has a 
name used to reference the storage location in the file system.  

Properties of a file show its’ location in the computer or network, the date that it was 
created or last modified, the size of the file (just like a book, each file has information in 
it and the amount of information determines the size of the file) 
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A Computer Network is a collection of computers interconnected by communication 
channels that allow sharing of resources and information 

The Internet is a worldwide collection of computer networks (worldwide web), 
cooperating with each other to exchange data using a common software standard. 
Through telephone wires and satellite links, Internet users can share information. 

 
Teachers: From the donated computers, let the students touch and feel the hard drive and the 
different parts inside the computer. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

116	  
	  

Lesson 1c: Exploring the Operating System 

 
Exploring the operating system: File system, Accessories (paint, calculator, notepad), basic 
functionality like opening and closing programs and windows. 
 
How to manage your files and folders  
To use a computer effectively, the user must learn how to navigate through its files and 
programs.  
Just like the things that you own, it is nice to know where to find things. Staying organized can 
be tedious, but after you have made countless amounts of files, stored all over your computer and 
you have many "New Folder"s, you'll see the point in being organized! 
 
The windows operating system helps to organize files for you by giving you several pre-made 
folders. One example is the folder called "My Documents." Inside this folder, you will find "My 
Music", "My Pictures," etc. You can also make your own folders for whatever category you 
desire. 
 
Double-click your "My Documents" icon on your desktop or in the START menu and you will 
see all the folders already provided for you. 

 

Figure 1C. My Documents icon as it appears on the Desktop  

 

Most information on a computer can be accessed from the Hard Disk Drive on the Local Disk 
(C:). If you know the file path (the files to look through to get to a certain file), you can start 
here. 
 
The section labeled Devices with Removable Storage is an example of an input device. 
 
The section labeled Network Drives is an example of how computers communicate with each 
other. 

To view the File System on the computer, click on the start menu,  >>My Computer 
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Figure 2C. Computer Storage Files  
 
To open a file, typically the user double clicks on the icon or the file. The following figure shows 
a typical view of a computer file. 
 

 
Figure 3C. Typical View of a Computer File  
 
At the top right of each file, there are usually 3 buttons that you can click. 

If you are done using the file, click the  to close the file. 

To maximize or adjust the view of a file, click  
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To minimize the screen so that the file name only appears in your toolbar, click  
 
Using computer programs 
 
Some of the most useful programs on a computer are very basic. These programs include 
Notepad, Paint, and Calculator. In Notepad, you can type a document. 
 
 

 
Figure 4C. Notepad  
 
In Microsoft Paint, you can test your creativity by drawing. See if you can draw animals as well 
as these people have! 
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Figure 5C. Microsoft Paint  
 
 

 
Figure 6C. Picture of a Woman drawn using Microsoft Paint  

 by Lindz Graham, source: 
http://www.flickr.com/photos/lindzgraham/1296071847/sizes/o/in/photostream/  
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Figure 7C. Picture of a Man and an Old Woman drawn using Microsoft Paint  

 by Paulinebalba, source: 
http://www.flickr.com/photos/paulinebalba/5011990606/sizes/m/in/photostream/  
 
You can use this calculator to do basic math. 
 

 
Figure 8C. Calculator  
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Lesson 2a: Writer tutorial 
 
Writer is a word processor, is very similar to Microsoft Office Word, which is used for many 
people in school and in work to make documents, homework or reports. Writer is a free program; 
you can do many features to make an impressive report using Writer. 
 
Question: For what purposes can you use Writer:______________________________________ 

__________________________________________________________________________ 

 
 

 Reference: The following tutorial is excerpted from Tutorials for OpenOffice, 
http://www.tutorialsforopenoffice.org/tutorial/No_Computer_Experience.html. 

     
First, let’s start by creating a new text document: 

1. IF on the desktop, click  > All Programs > OpenOffice.org 2.3 > OpenOffice.org Writer. 
 

2. IF you are in OpenOffice.org Writer, click File > New > Text Document. On the Main Menu 
 
Notice that the Main Menu is at the top of the screen. It has the words File, Edit, View etc. 

3. In either case, the text document  
appears on your screen. 
 

Screen 

  
The Screen is where you see things happen. The screen is like a TV screen. 
 
 

Keyboard 

 

 
4. The Keyboard has keys that can be pressed to make characters (letters, numbers, and 

symbols) appear on the screen. 
 

5. Press means to touch a key on the keyboard hard enough to cause the character to appear 
on the screen and then immediately release it. 

Alberto� 6/17/12 4:00 PM
Comment [208]: They should write here 
something like: Homework, Reports, Invitations, 
Letters, etc……. 
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6. Press the H key now. (An h appears on the screen) Next to the "h" is a flashing vertical 

line. That flashing line is the Cursor which indicates the place on the page where 
something will be placed when you press a key. Press the E key, then press the L key and 
the P key. (The word help appears on the screen) 

 

Space bar 
    

 
The Space Bar key is the long key in the middle at the bottom of the keyboard. Press the Space 
bar key. (The cursor moves one space to the right) 
 

Shift key 
 

The Shift Key causes letters to be capitalized. 
 

7. Type the word Help by doing the following: 
8. Press and hold down the Shift key as you press the H key. Release the Shift key. (The 

capitalized letter H appears on the screen) 
9. Press the E key, then press L, then press P. (the word Help appears on the screen) 

 
Mouse 

 
 
The device next to the keyboard is called a Mouse. 
 

10. Rolling the mouse causes the pointer,  to move on your screen. 

11. Roll the mouse up and down on the mouse pad. Notice that the pointer, , moves up or 
down on your screen as you rolled the mouse up or down. 

12. If you roll the mouse off of the mouse pad, pick up the mouse and place it back on to the 
mouse pad. 

13. Roll the mouse to the left and to the right on your desk. Notice that the pointer, , 
moves to the left or to the right on your screen as you rolled the mouse left or right. 

14. Roll the mouse so the pointer, , is somewhere on the word Help. 
15. Without moving the mouse, click with the mouse. (To click, put your right hand on the 

mouse. The mouse is divided into two or three parts. The parts are called buttons. Put 
your index finger (the finger that you use to point) on the left button and press the left 
button with your index finger then release the button.) 
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16. Notice that the cursor (flashing vertical line) moved to where you clicked the mouse. 
Press the letter X (an X will appear at the place where the flashing cursor is located) 
 

Optimize the Writer window 
You can increase or decrease the size of what you see on the screen 

1. Click View > Zoom > Optimal (A dot appears before the word, Optimal) Click OK. 
2. “Optimal” can be replaced with other choices. 

 
Name and Save a file 

1. Click File > Save As. (The  window appears) 
2. In the “Save in:” pull-down menu, select My Documents. (Click on the ▼to open the 

pull-down menu then select “My Documents) 
3. In the “File name:” pull-down menu, type My first file then click Save. 

4.  appears at the top of the screen. 
The file named “My first file” is still opened on your computer and is the OpenOffice text 
file format. The file is also saved in the “My Documents” folder by the name “My first 
file”.) 
 

Close a file 
1. Click File > Close. (The “My first file” file has been closed) 

 
Open a file 

1. Click File > Open. (the  window appears) 
2. Open the Look in: box by clicking the ▼. Select My Documents. Click on My first file. 

Click Open. 
 
 

 Reference: The following tutorial is excerpt from Tutorials for OpenOffice, 
http://www.tutorialsforopenoffice.org/tutorial/First_Time_User_OpenOffice_Writer.html. 

     
 
 
Toolbars 

1. The line that starts with the word File is called the Menu Bar. (Clicking on a word in the 
Menu Bar shows a list of things that you can choose to do in Writer. This list is called a 
Menu.) 

 
2. The second line down is the Standard Toolbar. (Clicking on a small picture will make 

available a specific function that can be done in Writer.) 
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3. The third line down is the Formatting Toolbar. (Additional specific functions that can 
be done in Writer are on this line.) 

 

 
 

4. The Horizontal Scroll bar (by clicking and holding the pointer, you can navigate a 
document left and right) is located at the bottom of the page above the Status Bar which 
is the line at the bottom of the screen that starts with Page 1/1. (This line gives you 
information about the document you are presently using.) 
 

 
 

5. The Vertical Scroll Bar (by clicking and holding the pointer, you can navigate up and 
down) is located on the right side of your screen. 

 

 

 
 

 Reference: The following tutorial is excerpted from Tutorials for OpenOffice, 
http://www.tutorialsforopenoffice.org/tutorial/First_Time_User_OpenOffice_Writer.html. 



 

125	  
	  

     
 

Icons, Click, Right-click, Insert 
 

1. The small pictures on the Standard Toolbar and some of the other toolbars are called 
icons. Click on each icon. (Click means to press and release the button on the left side of 
the mouse with your index (pointer) finger. Click only one time unless instructed to 
“double- click”.) 

2. Find the Gallery icon, . Click on the Gallery icon. (The Gallery window appears on 
the screen. The background changes color when the icon is in use. Some users may see a 
white background and some may see a blue background.) 

3. Click on the Gallery  icon again to close the window. (There is no background color 
on the “Gallery” icon.) 
 

4. Right-click anywhere on the printed or white page area of this tutorial. (Right-click 
means to press and release the button on the right side of the mouse with your middle 
finger. Click only one time unless instructed to double-click. A menu appears on the 
page. To close the window, click anywhere on the page other than on the menu.) 
 

5. On the Menu Bar, click on Insert. (The “Insert” menu appears. This is a list of the 
various things you can choose to do in Writer.) 

 
 

Turn Off the Word Completion Feature 
 

1. Click Tools > AutoCorrect > Word Completion tab. (The “AutoCorrect” window 
appears.) 
 

2. Remove the check-mark in the box, if it is there, before the words Enable word 
completion. Click on the OK button. 

 
 

Undo Entries 
Entries can be undone (can be deleted) in the reverse order in which the entries were made. 
Word(s), graphic(s), and paragraph(s) can be deleted and "Undo" can be used to put them back in 
your document. Type the three paragraphs below. 
 
This is the first paragraph. 
This is the second paragraph. 
This is the third paragraph. 
 
Delete Word(s) 

1. In the first paragraph, (This is the first paragraph.), click on the beginning of the word, 
first. Press the delete key. The first letter is deleted, do so until the whole word first, is 
deleted. 

2. Click Edit. (You will see the menu below.) 
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1. Click on Undo: Delete 'first'. (The word, "first", that was deleted is placed back in the 
document and the menu will close.) 

 
Delete One Paragraph 

1. Highlight the first paragraph, This is the first paragraph. Press the Delete key to delete 
the paragraph. Click Edit. (When you delete one paragraph and you click Edit, you will 
see the menu below, 
 

 
 

1. Click Undo: Delete 'This is ...agraph.' (The paragraph, "This is the first paragraph" is 
placed back in the document. The length of the sentences in the paragraph determines 
how much of the paragraph is shown after the "Undo: Delete".) 
 

Delete More Than One Paragraph 
1. Highlight the three paragraphs (This is the first paragraph. This is the second paragraph. 

This is the third paragraph.) at the beginning of the section, Undo Entries. Press the 
delete key to delete the paragraphs. (The three paragraphs are deleted.) 
 

2. Click Edit. (You will see the menu below.) 
 

 
1. Click on the Undo: Delete 'Paragraphs'. (The deleted paragraphs are placed back in the document.) 
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 Reference: The following tutorial is excerpted from Tutorials for OpenOffice, 
http://www.tutorialsforopenoffice.org/tutorial/Pictures_In_Text_Files.odt 

     
 
Insert an Image (Picture) 

1. Click Insert > Pictures > From File. (The “Insert picture” window will appear.) 
 

 
 

1. Click on Desktop. And select the file named “image.jpg” from the Insert picture 
window. Click the Open button. The image (picture) appears on your document. There 
are small green squares called handles at the edges of the image (picture) that indicate the 
image (picture) can be manipulated. 

 
 

1. To anchor the image (picture) above or below the text, click Format > Anchor > As 
Character. 



 

128	  
	  

2. Insert Image (Picture) In Your Text 
 
Adjust the Height of the Image (Picture) 
If the height of the selected item is greater than the current font size, the height of the line 
containing the item is increased. Adjust the height of the image (picture) so that it has little effect 
on the text line by resizing the image. 

1. Click on the image (picture). (An anchor, , will appear. Eight points (green squares), 
called "handles", will appear along the sides of the image [picture].) 
 

2. Place your pointer on any of the handles (points). To keep the proportions of the image 
(picture), press and hold the Shift key. Click and drag a handle of the image (picture) to 
modify the image (picture). (A double-headed arrow. , will appear.) Release 
the mouse button to complete the resize. 
 

3. When you have changed the image (picture) to the desired size, click anywhere on the 
page except on the image (picture). (The image [picture] will be the desired size.) 

 
 

 Reference: The following tutorial is excerpted from Tutorials for OpenOffice, 
http://www.tutorialsforopenoffice.org/tutorial/First_Time_User_OpenOffice_Writer.html 

     
 
 
Delete Graphic(s) 

1. Click on the picture. (The green handles will appear.) 
 

 
 

1. Press the Delete key. (The graphic is no longer on your document.) 
2. Click Edit. (You will see the menu below.) 

 
 

1. Click Undo: Delete graphics Alt+Backspace. (The graphic reappears on the document.) 
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Text Alignment (Left, Centered, Right) 
1. Select the first paragraph by clicking the left button of the mouse and holding the cursor 

at the beginning of the paragraph, dragging the mouse up to the end of the paragraph and 
releasing the left button. The text is selected and should look like this: 

 
2. On the formatting toolbar select Right text orientation button  

 

 
3. The text should go to the right side of the page. 

 
4. Now, let’s center the second paragraph, select again the second paragraph, the text should 

be highlited 
 

 
5. Click the center text orientation button 

 

 
6. The text should go to the center of the page. 

 

 
Change Text Size 

 
1. Select the second paragraph, should the text should be highlighted 

 
2. Click on the drop-down menu next to the text style the number 12 by clicking on the 

arrow and select the number 18 
 

 
 

3. The text should look like this (the second paragraph is bigger) 
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Lesson 2b - Open Office Calc 
 

 Reference: The following tutorial is excerpted from Tutorials for OpenOffice, 
http://www.tutorialsforopenoffice.org/tutorial/Spreadsheet_Basics.html 

     
 

The Word Spreadsheet 
The term spreadsheet was derived from a large piece of paper that accountants used for business 
finances. The accountant would spread information like costs, payments, taxes, income, etc. out 
on a single, big, oversized sheet of paper to get a complete financial overview. 
 

Spreadsheets Today 
Some examples of spreadsheet usage: 

● Spreadsheets act like a calculator by automatically doing calculations. 
● Spreadsheets are used for tracking personal investments, budgeting, invoices, inventory 

tracking, statistical analysis, numerical modeling, address books, telephone books, 
printing labels, etc. 

● Spreadsheets are used in almost every profession to calculate, graph, analyze and store 
information. 

● Spreadsheets are used for What-if calculations. Change one number in a spreadsheet and 
all the calculations in a large spreadsheet will re-calculate, will automatically change. 

 
 

Open a Spreadsheet 
1. IF on the desktop, click  > All Programs > OpenOffice.org 2.3 > 

OpenOffice.org Calc. 
2. IF you are in an Open Office program, click File > New > Spreadsheet. 

3. In either case a spreadsheet called  appears on 
our screen. 

 
 

The Calc Toolbars 
The following four Calc Toolbars appear at the top of all Calc screens: 
Main Menu Toolbar 

The first toolbar is the Main Menu toolbar that gives you access to many of the basic 
commands used in Calc. 
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Function Toolbar 
The second toolbar down is the Function Toolbar. The Function Toolbar contains 
icons (pictures) to provide quick access to commands like New, Open, Print, Copy, 
Paste, etc. When you place your mouse cursor over any of the elements of a toolbar, the 
name of the element appears on your screen. 

 

 
 
Activity: let the kids move the cursor above the different icons to see what is each of them. 
 

Move your cursor over the icon . (The word “New” appears. Clicking on  
opens a new spreadsheet.) 

 
Formatting Toolbar 

 

 
The third toolbar down is the Formatting Toolbar. The Formatting Toolbar has icons plus 
drop-down menus that allow you to select a font, font color, alignments, number formats, 
border options and background colors. 
Formula Toolbar 

 
The fourth toolbar down is the Formula Toolbar. The Formula Toolbar contains the Name 
Box drop-down menu and a long white box called the Input Line. 
Note: If your Toolbars look different, it is because these toolbars are in 800x600 screen 

resolution and the last eight icons are not shown but are available by clicking on the  on the far 
right of the toolbar. 

 
The Spreadsheet Itself 
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The rest of the window contains the spreadsheet. The spreadsheet is divided into rows that have 
a number at the left of each row and divided into columns with letters at the top of each column. 
Cells 
A cell is the fundamental element of a worksheet. This is where things are added and where 
things are seen. A cell address in a spreadsheet identifies the location of the cell in the 
spreadsheet. A cell address is a combination of the column letter and the row number of a cell, 
such as A2 or B16.etc. When identifying a cell by its address, the column letter is always listed 
first followed by the row number. The cell address of the example below is A5. 

 
Enter Data 

1. Click on the A1 cell (The cell at the very top left of the spreadsheet). 
2. Notice the heavy black border around the A1 cell. The heavy black border indicates that 

A1 is the active cell. (A is at the top of the first column and 1 is on the first row. Both are 
highlighted. The highlighting also indicates that A1 is the active cell.) 
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1. Type Hello World and press Enter. 
2. The active cell is now A2. (The words “Hello World” are in A1.) 

 
 

1. When you type something in a cell and press Enter, what you typed is seen in that cell 
and the cell below becomes the next active cell. 

2. Delete Data 
3. Click on A1 again. 
4. Press the Delete key. (The “Delete Contents” window appears.) 

 
1. Check the Delete all box then click OK. (“Hello World” is deleted from A1) 

Format Data 
Separate Thousands, Two Decimal Places, Red Negative Numbers 

1. Click cell A1. > Type the number -9999.129 > Press Enter. (The cursor moves to cell 
A2) 

2. Right-click cell A1. (A small menu appears) > click Format cells. (The “Format cells” 
window appears) 
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1. Click Numbers tab. Under “Category”, click on Number. Under “Format”, click on -

1,234.12. Click In the small box before “Negative numbers red”. (A check-mark appears 
in the box) > Click OK. (The number '-9,999.13” appears in cell A1. 

2. Align Left 
3. Click Alignment tab. In the “Horizontal” pull-down menu, select Left. Click OK. (the 

numbers move to the left edge of the cell.) 
 
 

 Reference: The following tutorial is excerpt from Tutorials for OpenOffice, 
http://www.tutorialsforopenoffice.org/tutorial/Spreadsheet_Math.html 

     
 

Addition 
The + sign is used for addition. To enter the + sign, press the Shift key and the +, ,key. 

1. Click on A6. 
2. Type the number 10, then press Enter. ("10" appears in "A6" and the active cell is "A7".) 
3. Type the number 5, then press Enter. ("5" appears in "A7" and the active cell is "A8".) 
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4. Type =A6+A7 (Or click the “Function”, , icon. The “=” appears in “A8'. The 

“Function”, , icon changes to the “Accept”,  , icon. Then type "A6+A7".). 

5. Press Enter (or click the “Accept”, , icon). The answer, 15, appears in A8. 
Sum (Calculate The Total Of A Column) 

1. In A1, type 5, press Enter. 
2. In A2, type 5, press Enter, 
3. In A3, type 5, press Enter, 
4. In A4, type 5, press Enter 
5. In A5, type 5, press Enter. 
6. Click In A6, the last cell in the column of numbers you want to add. ("A6" has a heavy 

dark border and is the "Active Cell.") 

 
1. Click on the Sum, Σ, ("Σ" is the mathematics symbol for sum.) icon on the Formula 

Toolbar just left of the Input Line The Function, , icon changes to the Accept, 

, icon. 

2. Click the Accept, , icon (green check mark) or press Enter. The formula, 
=SUM(A1:A5), appears in the A6 cell. 

3. Press Enter. The sum, 25, will appear in A6. A7 becomes the active cell. 



 

136	  
	  

 
Cell Range 
In the section above, the SUM function appears as =SUM(A1:A5). The A1:A5 in the 
parenthesis is called a Cell Range. It is shorthand for "from A1 to A5". 

Subtraction 
The - sign is used for subtraction. To enter the – sign, press the  key. 

1. Click on A8. To clear cell A8, press the Delete key. (The “Delete Contents” window 
appears.) Check the Delete all box and click OK. 

2. Type =A6-A7 (Or click the “Function”, , icon. The “=” appears in “A8" The 

“Function”, , icon changes to the “Accept”,  , icon. Then type "A6-A7".). 

3. Press Enter (Or click the “Accept”, , icon.) The answer, 20, appears in A8. 

Multiplication 
The star ,*, sign is used for multiplication. To enter the * sign, press the Shift key and the 

number 8  key. 
1. Click on A8. To clear cell A8, press the Delete key. (The “Delete Contents” window 

appears.) Check the Delete all box and click OK. 

2. Type =A6*A7 (Or click the “Function”, , icon. The “=” appears in “A8”. The 

“Function”, , icon changes to the “Accept”, , icon. Then type "A6*A7"). 

3. Press Enter (Or click the “Accept”, , icon.) The answer, 125, appears in A8. 
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Division 

The slash, /, sign is used for division. To enter the slash, /, sign, press the key [? And /]. 
1. Click on A8. To clear cell A8, press the Delete key. (The “Delete Contents” window 

appears.) Check the Delete all box and click OK. 

2. Type =A6/A7 (Or click the “Function”, , icon. The “=” appears in “A8'. The 

“Function”, , icon changes to the “Accept”, , icon. Then type "A6/A7".). 

3. Press Enter (Or click the “Accept”, , icon.) The answer, 5, appears in A8. 

Average 
1. In A1, type 5, press Enter. 
2. In A2, type 5, press Enter, 
3. In A3, type 5, press Enter, 
4. In A4, type 5, press Enter 
5. In A5, type 5, press Enter. 
6. In A6, type 25, press Enter. 
7. In A7, type =Average(A1:A6), press Enter. (8.33 appears in A7) 

 

Enter Formulas 
When you type in formulas, the order of operations must be correct. The correct order is: 
exponentiation, multiplication, division, addition, then subtraction. Let's pretend we want to 
perform a calculation using the equation: 
 

x + 10 

y + 20 

 
and suppose we entered it into Calc as follows: 

1. Select the A column. (Click on the letter "A." The whole "A "column is selected) 
2. Press Delete. (Make sure the "Delete all" box is checked.) 
3. Press OK. 
4. Click on A1. 
5. Type 20 in A1 and press Tab. 
6. Type 10 in B1 and press Tab. (Cell C1 becomes active) 

7. Type the formula =A1+10/B1 + 20.(Or click the “Function”, , icon which changes to 

the “Accept”  icon. Type "A1+10/B1+20"). 

8. Press Enter (Or click the “Accept”, , icon. The answer, 41, appears in C1.) 
The answer should be 1, using x = 20 and y = 10, but we got 41 for an answer! Why? Because 
Calc interpreted the equation as: 
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20 + (10/10) + 20 
which equals 41. If you use formulas with equations in the numerator and denominator, you need 
to use parenthesis () to force the spreadsheet to calculate them properly. Make the following 
changes: 

1. Click on C1. 
2. Click on the Input Line. 
3. Edit the formula to read =(A1+10)/(B1+20). (Click just before the A, then Press the ( key 

[Shift-9]. Click after the 0 in 10, then press the ) key [Shift-0]. Click just before the B, 
then Press the ( key [Shift-9]. Click after the 0 in 20, then press the ) key [Shift-0]). 

4. Click the Accept, , icon (green check mark.) The correct answer, 1, appears in C1. 
 

Copy Formulas 
You can copy a formula so that the formula itself is copied OR that the answer to the formula is 
copied. 
Copy The Formula Itself 

1. Select (click on) the cell(s) that is to be copied. 
2. Right-click, then click Copy. (The material is copied to the clipboard) 
3. Select (click on) the cell where the material is to appear. 
4. Right-click, then click Paste. 

Copy The Answer of a Formula 
1. Select (click on) the cell(s) that has a formula. 
2. Right-click, then click Copy. (The material is copied to the clipboard) 
3. Select (click on) the cell where the material is to appear. 
4. Right-click, then click Paste Special. (The “Paste Special” window appears) 
5. Remove the check mark at Paste all. 
6. Remove the check mark at Formulas and add a check mark at Numbers. Click OK. 

 

Exponentiation 
The number 102 is written as 10^2. To enter the ^ sign, press the Shift key and the number 6, 

, key. 
1. Click on A9. 

2. Type =A6^A7 (Or click the “Function”, , icon. The “=” appears in "A9". The 

“Function”, , icon changes to the “Accept”, , icon. Then type "A6^A7".). 

3. Press Enter (Or click the “Accept”, , icon.) The answer, 100000, appears in A8. 
 
 
 

 Reference: The following tutorial is excerpt from Tutorials for OpenOffice. 
http://www.tutorialsforopenoffice.org/tutorial/Columns.html 

     



 

139	  
	  

 

Add A Label To Columns 
1. Make A1 the active cell. (Click in cell A1) 
2. Type Check No then press the Tab key (The cursor moves to B1) 
3. Type Paid To then press Tab. (The cursor moves to C1.) 
4. Type Description then press Tab. 
5. Type Deposit then press Tab. 
6. Type Withdrawal then press Tab. 
7. Type Balance then press Enter. 

Insert An Additional Column 
Insert a Date column in the first column. 

1. Select column A. (Click on the "A" at the top of the column. The column turns black.) 
2. Click Insert > Columns. (The cell contents in columns "A" through "F" shift to the right 

and becomes columns "B" through "G". Column "A" cells are empty.) 
3. Select A1. 
4. Type Date then press Enter. 

Change The Appearance of Column Labels 
Center The Column Labels 
Use An Icon From The Formatting Toolbar 

1. Select cells A1 through G1 by dragging the mouse from cell A1 to cell G1 (Click on A1 
and without releasing the click, move the cursor over B1, C1 etc until the cursor is in cell 
G1. Release the click) 

 

1. On the Formatting toolbar, click the Align Center Horizontally  icon. (The 
column labels become centered) 

Select “Bold” And “Light Blue” For The Column Labels 
1. While the cells are still selected, move to the left and click the Bold, , icon. 

2. Move to the right to the Font Color  icon and pick Light Blue. (At the "Font 
Color", icon, click and hold the click until a choice of colors appears. Select [click on] the 
"blue" square). Press Enter. 

Make Entries In the Check Register 
Enter An Initial Balance: 

1. Select A2. 
2. Enter a date, 07/12/07. (type 07/12/07) 
3. Select G2. 
4. Enter 5000. 

 
Format Columns For Currency 
The Deposit, Withdrawal and Balance columns will contain dollars with a $ appearing in front 
of the numbers. All three columns can be formated at the same time. 
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1. Use Drag to select columns “E” through “G”. Click on E. (The cursor is at the top of 
column “E”) Press and hold down the left mouse button. Move the mouse pointer to G by 
moving the mouse. Release the mouse button. (Columns “E”, “F”, and “G” are 
highlighted) 

Continue by using either of the following two methods: 
Use A Icon From The Formatting Toolbar 

1. Click the Number Format Currency, , icon. (The three columns will show the $ 
when they have numbers in them.) 

Use Format From The Main Menu 
This method is more complex than using the icon. 

1. Select columns E through G. 

 
1. Click Format > Cells... (The "Format Cells" dialog box appears.) 
2. Click the Numbers tab. 

 
1. In the Category box, click Currency. 
2. In the Options section, make sure that Decimal places is set to 2, Leading zeros is set to 

1, and both check boxes are checked. 
3. Click OK. 
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Borders And Shading 
Borders can be used to separate data, mark certain cells or anything else you want. They are 
typically used to draw attention or separate. Add some borders to the check register worksheet: 
Select A Block Of Cells 
Use either of the following two methods; 

Use Drag To Select A Block Of Cells 
1. In A1, click and hold the click, then move the cursor onto G25. 

Use The Shift Key To Select A Block Of Cells 
1. Click A1. Press and hold down the Shift key then click G25. 
2. Add A Border 
3. Click Format > Cells... 
4. Click on the Borders tab. Find the User-defined box. Notice that there are four boxes 

created by inward facing triangles. 
5. Click to the left of the top left box . (Toward the middle of the box side.) (1) 
6. Click between the top two boxes. (Toward the middle of the box sides.) (2) 
7. Click to the right of the top right box. (3) 

 
1. You should have 3 vertical lines. Click OK. 
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1. Select A1:G1. (Click "A1". Drag copy to "G1".) 

2. Click the Borders, , icon on the Formatting Toolbar. 
3. Click on the second box from the left on the second row. 

 
Add A Background Color 

1. Click Format > Cells... 
2. Click the Background tab. 
3. Click on Gray 20%. (Use tool tips to find it.) 
4. Click the Borders tab. 
5. Click on the bottom horizontal line in the User-defined box. 
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1. Click the 2.5 pt line weight in the Style box. 
2. Click OK. 

 
 

 Reference: The following tutorial is excerpt from Tutorials for OpenOffice, 
http://www.tutorialsforopenoffice.org/tutorial/Charting_Data.html 
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Data Relationship 
The first thing you need is data that shows a relationship. Examples include mathematical 
functions, stock market prices over time, rainfall over time, statistical divisions of a population, 
or divisions of an income that make up a budget. Since math is something that anyone can 
duplicate, we'll use the sine function: 

1. Go to the bottom of your workbook and click on Sheet2. 
2. Type X in A1. 
3. Type Sine(X) in B1. 
4. Enter 0 in A2. (That's a zero. Click anywhere on the Spreadsheet to unselect “A2” after 

entering the “0”.) 
5. Select A2. (Click on A2 again to select it.)  Drag-copy A2 down until you see the tool tip 

number read 90.  (Put the cursor over the box at the bottom right corner of "A2".  When 

you see a , click on it and drag it down until you see the tool tip number read 90 then 
release the click.  The numbers will increase by 1 for every line you drag over.)  (The 
number 90 will be in cell A92) 

6. Go back to the top and Select B2. (Ctrl+up arrow is a quick way to move up.) 
7. Enter =SIN(A2). 
8. Click on the bottom right corner of the B2 cell. (The "B2" cell contents change from the 

formula "=SIN(A2)" into a "0".) Drag-copy the formula all the way down to the 90 in the 
A column. 

Don't worry if you don't know what the numbers mean; we aren't concerned with that. The order 
of the columns matters. Spreadsheet programs typically assume that the column on the left is the 
variable that is plotted on the horizontal (x) axis of the chart, and the column on the right is the 
variable that is plotted on the vertical (y) axis. 

Insert Chart 
1. Select columns A and B. 

2. Click the Insert Chart,  , icon on the Function Toolbar. (The pointer changes 

to . Click anywhere on the spreadsheet. Or Click Insert > Chart... The "AutoFormat 
Chart" window appears.) 

3. Select -New Sheet- from the drop-down box labeled Chart results in worksheet. 
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1. Click Next>>>. 

2. Select XY Chart.  (Hold the cursor over the icons to find it.) 
3. Click Next>>>. 
4. Select Lines Only and check the X axis and Y axis grid line boxes. ("Y" may already be 

checked. Don't uncheck it.) 

 
1. Click Next>>>. 
2. Give the chart a title, My First Chart, in the box that has Main Title in it. (Replace 

text.) 
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3. Click the X axis and Y axis check boxes. 
4. Type X for X axis title, and Sine(x) for Y axis title. (Replace existing text.) 
5. Click Create. 

 

 
1. Look at the worksheet tabs at the bottom. 
2. Click on the last tab. (Probably labeled Sheet4.) 
3. Use the little boxes on the corners to resize the chart by clicking on them and dragging 

them until you like the proportions. 

Appearance Of Chart 
Charts created by spreadsheet programs are unappealing most of the time. You have to mess with 
the format of the chart elements to make them look better. 
The first thing I notice is a jagged plot line. That is appropriate for some data, but the sine 
function is a smooth function, so make the following changes: 

1. Double-click somewhere on the chart if you see green boxes or no boxes. 
2. Click Format > Chart Type... 

3. Select Cubic Spline, , from the Variants box at the bottom. 
4. Click OK. 

That's better, but it could still use some improvement. Try: 
1. Click Format > Chart Wall. 
2. Click the Area tab. In the dialog box below Fill, click the  and select None. Click OK. 
3. Place the cursor over the data plot line and double-click. (The smooth Purple line.) 
4. Click the Line tab. In the Color dialog box, change the color to Sea Blue. 
5. In the Width dialog box, change the width to .02. (Click the  repeatedly or highlight 

the number in the dialog box and type ”.02”.) Click OK. 
6. Select Format > Grid > All Axis Grids... 
7. Change the Color to Gray 40%. (You have to scroll down the palette.) Click OK. 
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8. The chart still seems busy. Select Format > Axis > X Axis. Click the Scale tab. 
9. Clear the Maximum check box and replace 90 with 45. Click OK. 
10. Change the main title text to Sine Function by double-clicking on it and editing it. 
11. When you are done, click somewhere else on the chart to accept the changes. 
12. Click on a worksheet cell. Click Format > Sheet > Rename. (The “Rename Sheet” 

window appears.) Rename the sheet, Sine Graph. 
13. Save your work. (Click “File > Save”.) 
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Lesson 2c – Open Office Impress 
 
 

Reference: The following tutorial is excerpt from Tutorials for OpenOffice, 
http://www.tutorialsforopenoffice.org/tutorial/What_Is_Impress.html. 

     
 
IMPRESS is the presentation feature in OpenOffice. A presentation is pages that can be seen on 
the computer screen as normal and, with the use of a projector, the page can be seen on the wall 
or on an external screen. Normally, a laptop is used since it has good portability. 
Impress is like a SLIDE SHOW. One page after the other is projected. 
A page that is projected is called a SLIDE. The following can be included in a Slide: 

1. Animation 
2. 3-D graphics 
3. Bullets and Numbered Lists 
4. All the normal stuff that is in a word processor (Writer) and in spreadsheets such as bold, 

colors, text alignment, borders, drawing, templates (master slide) , etc. 
Notes can be added to a slide that are not projected but can be seen by the presenter. 

 
Use A Template 

1. OpenOffice has two ready-made templates, Introducing A New Product and 
Recommendation Of A Strategy. 

2. Click File > New > Presentation > From Template. (Part 1 of Window 1 of the 
“Presentation Wizard” appears.) 
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1. If not already selected, select Introducing a New Product. Click Next (Part 2 of 

Window 1 of the "Presentation Wizard" appears.) 
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1. In the dialog box under Select a slide design, click Presentation if it is not already 
selected. (Window 2 of the "Presentation Wizard" appears. Note that "Introducing a New 
Product" is highlighted. If you prefer another background than the default, under "Select 
a slide design", click "Presentation backgrounds" and select your choice.) In the dialog 
box under Select an output medium, click Slide. 

 
 

1. Click Next. (Window 3 of "Presentation Wizard" appears.) Under Select a slide 
transition, use the default for Effect and Speed. Under Select Presentation Type, click 
Automatic. In the Duration of pages dialog box, type 11 in the seconds place. In the 
Duration of pause, type 11 in the seconds place. (Highlight and type the numbers or use 

the  to select a number. The format for the numbers is: 00.00.11. The "hours setting" 
is before the first decimal (period). The "minutes setting" is before the second decimal. 
The "seconds setting" is before the third decimal.) 
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1. Note: If you use the default settings, click Create and you have your presentation ready 
for pictures, text. Etc. 

 
1. Under Describe your basic ideas, in the dialog box under What is your name or the 

name of your company?, type The Save Time Company. In the dialog box under 
What is the subject of your presentation?, type A New Watch. In the dialog box under 
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Further ideas to be presented, type Use the Stopwatch Function and Use The Date 
Function. 

2. Click Next. (Window 4 of the 'Presentation Wizard" appears.) 

 
1. Under Choose your pages, select what you want in your presentation or use the default 

settings. Click Create. (Note: "Next" is grayed. "Create" is the next step.) 
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1. Click Slide Transition if it is not already selected. To see your presentation that you just 

made, click Slide Show. 
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Save And Close Your Presentation 
1. Click File > Save As. In the Save in: pull-down menu box, click My Documents (if it is 

not already selected). In the Save as type:" box, click OpenDocument Presentation 
(.odp) (if it is not already selected). 

2. In the File name: box, type My Slide Show . 
3. Click Save. (" My Slide Show" is saved. The file, "My Slide Show" is still on the screen.) 
4. Click File > Close. (The file, " My Slide Show", is no longer on the screen.) 

 

To Watch "My Slide Show” at a Later Time 
1. Click File > Open. (The "Open" window appears.) 
2. In the menu below the "Look in:" dialog box, click My Documents if it is not already 

there. In the menu below the File name: dialog box, click My Slide Show. ("My Slide 
Show" appears on your screen.) 

3. Click Slide Transition if it is not already selected. To see your presentation that you just 
made, click Slide Show. 

 
 
 

 Reference: The following tutorial is adapted from 
http://www.tutorialsforopenoffice.org/tutorial/Automate_Slides_In_Your_Presentation.html. 

     
 

Automate Slides In Your Presentation 
Once you have created your Impress Presentation you might now want to automate the slides so 
that you don't have to click the mouse to move to the next slide every time. 
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Activity Explanation 

1. Click File > Open . The "Open" window appears. 

1. In the menu below the Look in: dialog 
box, click My Documents if it is not 
already there. In the menu below the File 
name: dialog box, click the name of your 
Presentation. . 

Your Presentation appears on your screen. 

In the Tasks window, click Slide Transition. The "Tasks" window is on the right side of your "Impress 
Presentation" screen. 

Under Apply to selected slides, click the  to 
scroll to select a transition like Wipe Down or 
Wipe right. 
 

 
 
 

Click the  to scroll to Fast in the dialog box 
to the right of Speed under Modify transition. 
Click Fast. 

In the "Speed "dialog box, you have three choices for the speed 
of the transition. The choices are "Slow", "Medium", and 
"Fast". 

Click Automatically after in the dialog box 

below Advance slide. Click the  to set the 

You can also highlight the number in the dialog box and type 
the number of seconds. 
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Seconds to5sec. 

Click Apply to All Slides.  

Press F5 to view your presentation to see if you 
have the speed and format the way you want it. If 
you want to change the speed or the type of 
transition you simply apply the process again. 

 

 
 

Lesson 3a - Introduction to Computer Aided Drafting (CAD) 
 
Using a computer program to help you draw is called “Computer Aided Drafting.” Learning how 
to draft on a computer is a very powerful skill. Drafting helps you present your information 
clearly and neatly. 
 
Most CAD Drafting programs have the same basic functions like drawing lines and circles. 
Google SketchUp is a basic drafting program that we will use to teach you how to draft. Once 
you become proficient with Google SketchUp, you will be able to adapt easily to other CAD 
programs. 
 
Lesson 1. Familiarize yourself with Google SketchUp 
In this lesson you will first learn how to draw objects by hand on isometric sketching paper.  You 
will learn the standard practices for drawing and the standard views of your drawing.  Finally 
you will be introduced to Sketchup software and how it can help you with the general concepts 
you learned.   
 
Instructions: 
Open Google Sketchup: 

1. Go to the START button 
2. Click PROGRAMS 
3. Click the left button on GOOGLE SketchUp 

 

Jose Alfaro� 6/22/12 4:15 PM
Comment [209]:  
Activity: (if time allows), make a spreadsheet to 
graph height and weight, and an invitation using 
writer. 
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You will see the following 
screen:

 
 
Figure 1. Google SketchUp start up screen  

1. Click on the button at the bottom right corner that says “Start Using Sketchup” 
2. You will see the following screen: 
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Figure 2. Google SketchUp 3-D (three dimensional) view  
 
Notice that the opening screen looks three-dimensional. 
There are three different axes on the screen (LENGTH, WIDTH, and HEIGHT) with solid lines 
marking the positive axes and dotted lines marking the negative axis.   

● The picture of the woman on the screen is provided for you to get reference of the depth 
and height of the screen.  Notice the horizon line at the back of the picture.   

● You are looking at a picture of an empty world just ready for you to fill it up with 
drawings! 

● Click on the picture of the woman and press the DELETE button on your keyboard 
● To draw in Google Sketchup, use the command bar (the command bar has the pictures) at 

the top of the page 
● Google Sketchup uses 4 major commands to draw:  drawing a Line, Rectangle, Circle 

and Arc.   
● To draw those features you can click on their corresponding buttons at the top of your 

screen: 

 
 Figure 3. Command window at the top left  
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● You can also see that there is a tool called “Select”.  Every time you click on a drawing 

tool your cursor becomes that drawing tool and you will not be able to select other lines 
or objects until you click on the select tool 

● Follow along with your instructor as you learn to draw those different shapes in Sketchup 
● Make sure that every shape is in a plane.  A plane is a two dimensional imaginary 

surface.  There are three main reference planes, the X-Y plane, the X-Z plane and the Y-
Z plane.  They are the planes created by the surface limited by the x and y axis, the x and 
z axis and the y and z axis respectively.   

● For example, note the following rectangles aligned parallel with each of the three main 
planes 

● To draw a line parallel to each axis, move the line until it is the color of the axis line that 
you want to draw parallel to. NOTE: If the line is black, then it is not parallel to an axis 
line. 

 

  
     X. X-Y-Z Coordinates        Box in the X-Y plane      Box in the X-Z plane  Box in the Y-Z plane 

 
Note: The concept of planes will be very important in Google Sketchup. So make sure you keep 
up with your planes 
 
Activity: Draw a Box in the X-Y plane 

1. Click “Line” in the command bar 
2. Click on the point where the 3 axes intersect 
3. Drag the line parallel to the X axis until your line turns RED 
4. Type “ 10’ ” on your keyboard 
5. Press ENTER on your keyboard 
1. Click on the end of the line you just drew 
2. Drag the line parallel to the Y axis until your line turns GREEN 
3. Type “ 10’ ” on your keyboard 
4. Press ENTER on your keyboard 
1. Click on the end of the line you just drew 
2. Drag the line parallel to the X axis until your line turns RED 
3. Type “ 10’ ” on your keyboard 
4. Press ENTER on your keyboard 
1. Click on the end of the line you just drew 
2. Drag the line parallel to the Y axis until your line turns GREEN 
3. Type “ 10’ ” on your keyboard 
4. Press ENTER on your keyboard 

 
Once you have a closed shape, the object will become shaded 
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Drawing and Modifying Shapes 

● With the Four Major shapes in Sketchup- lines, rectangle, circles, and arcs-- you will be 
able to create almost any shape. 

● Everything in Sketchup, no matter how complicated, is a point, a line or a face.  You will 
really have to master these concepts to able to modify your shapes.   

○ A point is a single dot in space. 
○ A line is a series of points.   
○ A face is the surface encompassed by lines that do not have a break in between 

them and which are all co-planar (all lines are on the same plane).   
● Try drawing a circle, a rectangle and a face of your choosing 

 
 
Lesson 2. Build a House 
 
I. Push and Pull Tool 
So far we have played in 2D (2 Dimensions).  But the beauty of Sketchup is how quickly you can 
turn your drawings into a 3D model.  Let’s design a house. It all starts with the push/pull tool.   

● Open the file with the faces we drew before.   
● Now, click on the push/pull tool.   

 
● Once you have selected the tool, your cursor turns into a miniature push/pull icon.  Hover 

with the cursor over the face you want to extrude into 3D. 
● The face turns dotted.  You can now click on it and move your mouse to expand it into a 

3D model.   

 
Three Dimensional Box created using the ‘Push/Pull’ button  
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● If you want to extrude (push/pull) the shape to a particular exact dimension you can just 

type that dimension and click Enter.  The face pops to that exact dimension.    
● Notice now that there are many more faces once you have extruded the original shape 

into 3D.  You can now push or pull on any of those faces!   
 
Once the object is drawn, more objects can be drawn on it. 
 
II. Let’s make a Door 

1. Click on the ‘tape measure’ tool 
 

 
 

           Tape Measure  
 
 

2. Click on the bottom left corner of the box and measure 4 feet over, parallel to the red line 
3. Press Enter 
4. Draw a line 7 feet at the measurement point you just created 
5. Draw the top of the door by drawing a line 3 feet over—parallel to the red line 
6. Complete the door 

 

 
Box with door outline  

 
7. Click the ‘SELECT’ button in the command bar (the arrow) 
8. Click on the face of the door and hit the DELETE button on your keyboard 
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Box with door  

 
III. Draw the Roof 

1. Click on the ‘tape measure’ tool 
2. Click the top left corner of the box and measure 5 feet over-- parallel to the red line 
3. Draw a line 5 feet up at the measurement point you just created 
4. Draw a line from the top of the line you just created to the top left corner of the box 

 

 
Box with part of the roof  
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1. Now complete the triangle by drawing a line to the other corner of the 

b  
 

Box with part of the roof  
1. DELETE the vertical line in the middle of the roof by clicking on it with the arrow and 

hitting the DELETE button on your keyboard 
2. Use the ‘Push/Pull’ button to make the roof 
● If the triangle does not have a face when you push it to make the roof, draw a line along 

one of the existing lines of the triangle 
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House  

 
1. DELETE the horizontal line on top of the box by clicking on it with the arrow and hitting 

the DELETE button on your keyboard 
 
IV. Get Creative! 

1. Draw windows using the ‘rectangle’ command and the ‘circle’ command 
2. Make a chimney 
3. Create a door with a window 
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4. ‘Paint’ the House (see next section for 
instructions)

 
Painted house with door, chimney, and windows  

 
Up until now all our shapes and geometries look a solid color and we don’t get to choose it.  Our 
drawings can use colors to help explain what we are trying to get across, like material choice 
(using metal, concrete, bricks or sand).  They can also help differentiate or emphasize parts of 
our drawings.   

● To introduce color and texture to our design we can use the “Paint Bucket” tool.  Click on 
it in your upper toolbar.   

● The following tool box appears.  
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Paint Tool Box  

 
● Notice the dropdown menu in the box (it says ‘Roofing’).  The menu allows you to pick 

different colors and patterns. 
 
So far we have focused on simple geometries.  Soon, we will be working on crafting our own 
bridges, machines and creations.  One of the best ways to create these machines is to visualize 
them in 3D.  As engineers we often follow the technique of thinking about a problem, creating a 
possible solution, testing that solution and possibly iterating again until we find the best solution 
possible.  Part of testing a solution involves creating a prototype.  You will be building 
prototypes in your hands on lab.  However, to create a prototype you must show others what 
your idea involves.  This is an example of where Google Sketchup can be used to make models 
of those designs and communicate to other what we want to do.   
This means that the closer our drawing is to what we want or imagine in our heads, the better 
others will be able to follow that.   
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Lesson 3b - Typing Skills 
 

 Reference: The excerpt below is from: The Importance of Daily Typing Practice, 
Burt Cotton, http://www.articles3k.com/article/319/110879/The_Importance_Of_Daily_Typing_Practice/. 
Copyright 2010 Articles3K.com, All Rights Reserved. 

    
Like anything in life, ___________makes perfect. I am sure that you have heard that saying 
before. There is great truth to this fact. If you want to achieve anything in life, you will need to 
_________yourself to daily practice. This includes everything from playing the piano, competing 
in sports, and even mastering your typing skills. If you want to improve your typing skills then 
you will need to commit yourself to daily typing practice. Daily typing practice is the key to your 
typing success. Neglecting to practice will ensure that whatever gains you have made in speed 
and accuracy will be lost over time. There is no doubt about it. To keep up with your new skills 
and to improve your typing, you will need daily typing practice. 
 
In today’s society, typing is the key to getting ____________. Most jobs require some degree of 
computer work, and knowing how to type quickly and efficiently will make you more 
marketable than your fellow worker who simply “finger pecks” at the keyboard. You can 
honestly state, that learning to type is an investment in your career future. Many public schools 
have embraced the importance of typing and they are encouraging children to schedule a time set 
aside for daily typing practice. Teaching children the correct methods of typing while they are 
young is an important step to ensuring their future success.  
 
Why is better typing productive for business and employees? 
 

 Reference: Why is better typing productive for business and employees?, 
http://www.typinginstituteofamerica.org/how-you-benefit.html. Copyright 2010, Typing Institute of 
America, All Rights Reserved. 

    
 

 Reference: Excerpts below from article “Reap the Benefits of Good Typing 
Skills” by Courtnie Packer, http://typing-tutor-review.toptenreviews.com/reap-the-benefits-of-good-typing-
skills.html. Courtesy of Tech Media Network website. All rights reserved.      

 
Save Yourself and Your Boss Some Time 
When you type properly at a faster pace, avoiding the hunt-and-peck technique, you can get a lot 
more done in a smaller amount of time. 
 

Alberto� 6/17/12 4:00 PM
Comment [210]: practice	  

Alberto� 5/30/13 4:34 PM
Comment [211]: committ	  

Alberto� 6/17/12 4:00 PM
Comment [212]: a great job	  
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It’s Not Only About the Keys 
 

 
 

This is the correct posture to type  
Image: , source: http://www.nismat.org/ptcor/ergo 

 
Hands on practice 
 
Let’s start with our typing lessons, the objective is to get familiarized with the keyboard layout 
memorize where are keys located. 
 
1. Open Tux4Kids Typing tutor program. (Remember from previous lessons, we learned how to 
open computer programs in two ways: a) using the start menu to open the program and b) using 
the desktop shortcut to open the program) 
 

Alberto� 6/17/12 4:00 PM
Comment [213]: Explain	  the	  picture,	  and	  
interactively	  ask	  the	  students	  to	  participate	  
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Navigation: to enter each section click the icon with the mouse. To exit each section press the 
ESC key on the keyboard. 
 

 
( from http://commons.wikimedia.org/wiki/File:QWERTY-home-keys-position.svg) 

This is the correct way of placing your fingers over the keyboard, using all the fingers properly 
will allow us to type much faster. 
 
Exercise # 1 
 
1. Click on Lessons 
2. Click on Lesson 1 
3. Start typing!!! 
 
 

Alberto� 6/17/12 4:00 PM
Comment [214]: Let’s begin by placing the 
fingers on the keyboard. Explain the layout: what the 
color means and which keys are you supposed to 
type with each finger. 
	  

Alberto� 6/17/12 4:00 PM
Comment [215]: Take about 10 minutes with 
each exercise. 
 
For the contest, choose the last three contestants and 
they receive a price (a candy or something). If they 
don’t loose when time’s up stop and count the points 
to determine who wins. 
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Exercise #2 
 
1. Click on fish cascade 
2. Select easy 
3. Select any category that you like. 
4. Start typing!!! 
 
Exercise #3 
 
1. Click on Comet Zap 
2. Select Space Cadet 
3 Select any category that you like. 
4. Start typing!!! 
 
Contest 
 
1. Click on Comet Zap 
2. Click on Pilot 
3. Start typing!!! 
 

Lesson 4a – Introduction to the Internet 
 
 
This is a brief history of the creation and evolution of the Internet. 
 

Reference: The History of the Internet in a Nutshell by Cameron Chapman, 
http://sixrevisions.com/resources/the-history-of-the-internet-in-a-nutshell/. Copyright 2008-2012 Six 
Revisions, All rights reserved.  

 

2012: Liberia’s High Speed Internet!! 

 

Reference: Liberians hope long wait for the web is finally over 
By Bonnie Allen and Rob Hugh-Jones, PRI's The World, http://www.bbc.co.uk/news/world-africa-
15692430. Copyright 2011 BBC, All rights reserved.  
 
 

The Future? 
Where is the future of the Internet headed? Share your opinions in the comments section. 

Other basic concepts: Intranet or Local Area Network, comparison with Internet. 

Alberto� 6/17/12 4:00 PM
Comment [216]: Play	  video	  
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A local area network (LAN) is a group of computers and associated devices that share a common 
communications line or wireless link. Typically, connected devices share the resources of a 
single processor or server within a small geographic area (for example, within an office 
building). 

 
(  by Dominio púlico, source: 
http://commons.wikimedia.org/wiki/File:Topolox%C3%ADa_en_%C3%A1rbore.png)   

 
Internet is…. Another definition of Internet 
 
 

Reference: What is the Internet, http://www.yourmaindomain.com/web-articles/what-is-
internet.asp. Copyright 1998 - 2008 www.yourmaindomain.com, All rights reserved.  
 

Lesson 4c: Instant Messaging and Chat Systems 
 
Computer instant messaging is a very commonly used way people communicate, collaborate and 
interact with friends, workmates or classmates. It allows people to exchange any type of 
information. With instant messaging systems a person can communicate using text messages 
with someone in the other side of the world! 
There are many instant messaging communications software; some of them allow voice and 
video communication as well. It can be used to send files to the person you are talking to, or just 
to talk with. 
Since our computer lab does not have Internet access, we are going to use “Squiggle Messenger” 
which is a chat system for an intranet or Local Area Network. This program will allow you to 
communicate using text messages with another person across the room. Let’s Get started: 

1. Start “Squiggle Messenger” by a double-click on the  icon on the desktop 

Jose Alfaro� 6/22/12 4:19 PM
Comment [217]: For Teachers:  
 
We will use Squiggle Messenger, which is a chat 
system for an intranet or Local Area Network. 
There should be a desktop shortcut to open the 
program. A list of the students and its peer to chat 
should be made and handed out. Teachers are 
responsible of making the list (suggestion: make a 
list of first and last name of all the students, cut each 
name and randomly give a paper to each kid. The 
name on the paper is going to be the person they are 
going to be talking with). 
 
The teacher should explain what we are going to do: 
use a chat program to talk to the person assigned, 
topics of discussion to be posted.  
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2. The program will open; type your first name and your last name, and the name of the 
camp as shown below. Check that it is spelled correctly, otherwise your peer will not be 
able to find you on the network. 

 
 

3. Press the  button. 
4. The chat window will open. On the “search contacts” section, type the name of the 
person that you are going to chat with, and press enter. 

 
 

5. Introduce yourself, tell your name and share your hobbies and interests. 
6. We will discuss the following topics: 

A. Topic one 
B. Topic two 
C. Topic three 
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Software 
 

• Tux Typing tutor, http://sourceforge.net/projects/tuxtype/  
• Squiggle LAN chat, http://squiggle.codeplex.com/ 

 

Further Reading 
 

• Open Office Writer User Guide, Linuxtopia, 2006, 
http://www.linuxtopia.org/online_books/office_guides/openoffice_writer_user_guide/ind
ex.html. CC:BY. 

• Writer (Word processing) tutorials, Tutorials for OpenOffice, 2008, 
http://www.tutorialsforopenoffice.org/category_index/wordprocessing.html. CC:BY. 

• Reap the Benefits of Good Typing Skills By Courtnie Packer, http://typing-tutor-
review.toptenreviews.com/reap-the-benefits-of-good-typing-skills.html 

• The Importance Of Daily Typing Practice, http://www.articledashboard.com/Article/The-
Importance-Of-Daily-Typing-Practice/83385 

• Why is better typing productive for business and employees?, Typing Institute of 
America, http://www.typinginstituteofamerica.org/how-you-benefit.html 

• Mr. Peralta's Media Lab, 
http://www.emersonms.org/apps/pages/index.jsp?uREC_ID=50343&type=u&pREC_ID=
307139 

• Introduction to Computer Local Area Network (LAN) by Malik, 2010, 
http://en.ridwanaz.com/3301/gadget/networking/articles-introduction-to-local-computer-
network-lan-local-area-network/.   

• The History of the Internet in a Nutshell by Cameron Chapman, 2009, 
http://sixrevisions.com/resources/the-history-of-the-internet-in-a-nutshell/.  

• Liberians hope long wait for the web is finally over by Bonnie Allen and Rob Hugh-
Jones, http://www.bbc.co.uk/news/world-africa-15692430 

• An Illustrated History of Computers - Part 4 by John Kopplin, 2002, 
http://www.computersciencelab.com/ComputerHistory/HistoryPt4.htm 

 
 

Videos 
 

• How Computers Work - Journey Into The Walk-Through Computer, Computer History 
Museum, 1990, http://www.youtube.com/watch?v=CoxQLJkLq1c 

• When Computers Changed the World from the Revolution Exhibition, Computer History 
Museum, 2011, http://www.youtube.com/watch?v=aLg4MHyyqL0  
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Hands On Lab 
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Hands on Lab  

 
Course Objectives: 
 
To introduce students to the design process and allow them to practice basic science and math 
concepts through a Tractor Pull Competition.   
 
Course Description: 
 
This lab will introduce students to the design process through basic experimentation.  The 
students will learn basic science and math principles through practice and utilize them to design 
a final product.  Students will be split into teams and each team will design and build a tractor 
that must pull a weight and perform work.  The team with the best performing tractor will win.   
 
Important Concepts: 
Students will be able to learn and apply the following concepts: 
Force 
Free Body Diagrams 
Energy 
Work 
Friction 
Mechanical Advantage 
Pulleys 
Simple Machines 
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Lesson 1: Introduction to Important Concepts 
 
 
Objective: 
To become familiar with the concepts of Force, Free Body Diagram, Work, Friction, Simple 
Machines, and Mechanical Advantage. 
 
Force 
A force is kind of an abstract concept.  Think of it as something that acts on objects.  Forces have 
two characteristics: magnitude and direction.  They are what are known as  vectors.  The 
magnitude of a force is how large it is.  Its direction shows where the force is moving.  We 
measure the magnitude of a force in Newtons (N).    A Newton is the magnitude that a force 
needs to accelerate 1 kg at 1 m/s2.  So 1 N = 1 kg*m/s2. 
 
Forces don’t just appear.  In fact they must be applied, or generated, by something as well.  Right 
now there are at least two forces acting on you.  Can you guess what they are?   
Many things apply forces from obvious things like our muscles to seemingly impossible things 
like air!  The forces exerted by air are key to allow planes to fly! 
Can you come up with some examples of forces?  What are their magnitudes and directions? 
 

 
 
 
 
 
 
 
 
 
 
 
 

Free Body Diagram 
 
Now that you know what a force is you need to be able to think about forces in a more concrete 
way.  This is important for both Engineering and Agriculturalists.  A Free Body Diagram is a 
representation of an object and the forces acting on it.  For example: imagine I am holding a 
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book on my hand.  What are the forces acting on it?  What direction are they going towards?  A 
Free Body Diagram (FBD) tells us that information.   
A FBD can represent the object forces are acting on as a point and the forces as arrows.  The 
arrows’ length and direction correspond to the forces magnitudes and direction.   
 

Example of a FBD 

 

 
 
 
 
(  by Andrew Dressel, source: 
http://commons.wikimedia.org/wiki/File:Free_body_dia
gram.svg ) 

 
Now that we know how to draw free body diagrams (FDG) draw the forces acting on the following objects:   
 
You sitting on a chair 

 
 
 
A dog being yanked by a leash but not moving 
 

Brieland Jones� 6/17/12 4:21 PM
Comment [218]: It	  might	  be	  difficult	  with	  80	  
students,	  but	  it	  would	  be	  cool	  to	  have	  more	  
interactive	  examples	  with	  students…perhaps	  like	  
forces	  of	  the	  body	  that	  act	  on	  itself	  or	  another	  body.	  	  
Not	  necessarily	  that	  but	  something	  like	  it.	  
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Sign Convention: 
 
We want to be able to calculate the magnitudes and effects of forces.  To do that we need a 
convention on what their sign is.  A convention is something we agree on.  For example, altitude 
is generally described as being positive starting with zero at the level of the sea.  This is 
arbitrary.  We could just as well have defined altitude as being negative from the top of the 
atmosphere!  Conventions make things easier for us to communicate with each other.  By 
convention, forces are positive if their direction is in the positive x-axis or if they are going from 
left to right according to the observer.  They are negative if they are going in the opposite 
direction.  In the same way if forces are going in the direction of the positive y-axis, then they 
are considered positive.  They are negative if they are going in the negative y-axis. 
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Of course, forces often don’t point in the easiest direction.  They may point at different 
angles.  How can we deal with that so that we can make calculations?  The answer is 
trigonometry!  Every force can “decomposed” into its normal components, or the components 
pointing in the same direction as the x and y axis.  

 
Now, practice decomposing some forces: 
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The same process can be done in reverse to determine a “resulting force”.  A resulting force is 
the force with the magnitude and direction that you have if you put two or more forces together. 
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Draw the resulting force in the following figures: 
  
 
 
 
 
 
 
 

 
 
 
 
 

 
 
Work 
 
Work is a little more concrete than forces.  You may think of work as things you do, like 
homework or cleaning.  However, in physics, work is the result of a force acting over a particular 
distance.  It is key that both things are present.  You could have a huge force but if the object the 
force is acting on does not move then there is no work!  Look at the following images and decide 
if there is work being done or not.  
  
 
 
 
 
 
  

 by Yutaka Kachi, source: 
http://openclipart.org/detail/23624/bluema
n-108-by-anonymous-23624  

 
 Source: 

http://openclipart.org/detail/74761/man-push-by-
aungkarns-74761  
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We measure work in Nm or Joules (J).  Work, unlike forces, is a scalar and it only has a 
magnitude.  It does not have a direction.  So, if you move a box in whatever direction for 10 
meters, you still did positive work.  (At least for now, we will consider this true, wait till you do 
thermodynamics!).  In our example, let’s say that you use a force of 1 N to move that box.  That 
means you did 10 Nm of work or 10 J of work.   
 
 
 

 
 
Work does not have a direction but it IS actually PATH dependent.  That means you can move a 
box 10 meters horizontally but if you moved it in a particular path then the work done was 
actually more.  Look at the following figures and determine what the work done was.  
 

 
 Source: 

http://pixabay.com/en/outline-bar-sport-
recreation-25791/  

 
 Source: 

http://openclipart.org/detail/20044/paratrooper-
chibi-by-wsnaccad  
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Friction 
Friction is a very important force.  As a matter of fact, it touches almost everything we do!  One 
reason you can walk is because of friction.  Friction is also very interesting because it depends on 
two surfaces rubbing on each other.  The magnitude of friction is dependent on the nature of the 
two surfaces you are rubbing together.  
Another thing that makes friction interesting is that there are two types.  When an object is sitting 
still the force required to make it move is actually HIGHER than the force required to keep that 
same object moving once it has started to move.  
Finally, friction also depends 
on how much weight is resting 
on the object.  For example, if 
you were trying to slide a chair 

along a 
tile floor 
you will 

need 
little 

force.  B
ut if you 

sat 
somebod
y on the 

chair 
and tried 
to slide 
the chair 

across 
the 

floor, you would need a lot higher force to move it.  
You will now conduct a series of experiments to see how this is true.  We 
will use a simple gauge to measure a force.  You will then use it to pull 
objects made of different materials over different surfaces.  Record your 
results in the table below.  

 
 
 

 Photo taken by University of Michigan 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

Material A 
Material B Weight Static 

Friction 
Kinetic 
Friction 

Glass Glass    

Glass Glass    

Glass Wood    

Glass Wood    

Glass Rubber    

Glass Rubber    

Rubber Wood    

Rubber Wood    

Aisha Moinuddin� 2/1/13 6:53 PM
Comment [219]: I	  like	  this	  experiment	  too!	  

Brieland Jones� 2/1/13 6:53 PM
Comment [220]: Cool	  visible	  experiment.	  	  I’m	  
remembering	  as	  kids	  we	  used	  to	  put	  soap	  and	  water	  
on	  the	  floor	  of	  the	  kitchen	  and	  slide	  around	  on	  it.	  	  
With	  all	  of	  these	  new	  ideas,	  small	  eye-‐opening	  
experiments	  are	  essential.	  	  This	  is	  a	  really	  good	  one.	  	  
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Simple Machines and Mechanical Advantage 
 
As you saw, forces can do work.  A small force can only do small work, right?  No!  Small 
forces can do a lot of work.  Remember that work depends on distance.  So a small force acting 
over a long distance can do a lot of work.  However, how can we get a small force to do a 
specific task that requires a large force?  The answer is in something called “Simple Machines.”  
 
Simple Machines allow us to use a smaller force to do the amount of work that would have 
required a larger force.  For example, look at the picture below of a rock weighing 10 N and a 
rope moving it 2 meters up.  This would mean 20 Nm of work and we would have to use a force 
on the rope of 10 N.  However, the picture on the right uses a simple machine called a 
pulley.  Using this machine you achieve the same amount of work using a force of only 5 
N!  That is half the force! 
   

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
There are 6 types of simple machines: levers, incline planes, wedges, screws, pulleys, and wheel 
and axles.  These great inventions allow us to exert much less force to achieve the same amount 
of work.  But wait, how can that be?  Isn’t work dependent on the magnitude of the force and the 
distance it acts on it?  If you decrease the force then... Yep!  Somehow the smaller force has to 
act through a larger distance for these machines to work.  The reason the simple machines are so 
important is because of the ingenious ways in which they increase the distance for the force to 
act on.  And on top of that, they allow us to apply forces in more comfortable ways so we can be 
more effective.  In other words they change the direction of the force as well. 
Let’s visit them one by one. 
 
   
Levers: 
Levers are basically a bar that can be used to increase the force that you produce.  There are three 
types of levers, but they all have a fulcrum, a load and an effort.  The basic idea is that you use a 
fulcrum to transfer the effort or force you put in so that it will increase the force delivered to the 
load.  Some examples of levers are a crow bar, wheelbarrow, scissors, nutcracker, nail clippers, 
and a seesaw.   
 
Type 1:  
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In a type 1 lever the load rests at one end, the fulcrum in the middle and the load is applied to the 
other end.   

 
Type 2:  
In a type 2 lever the fulcrum rests at one end of the lever while the force is applied at the other end and the load rests 
in the middle. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Type 3: 
Type 3 levers have the load at one side the fulcrum at the other and the force is applied in the 
middle.   
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Incline Planes: 
Inclined planes are flat surfaces that allow us to move objects up or down with ease.  Some 
examples of inclined planes are loading ramps, roads and tailgates.   

 
 

 
Wedges: 
Wedges allow you to push apart two objects or loads.  They can also be used to hold objects in 
place or to break through surfaces.  The wedge increases the distance between the objects 
through the translation of a perpendicular force.  Some examples of wedges are nails, chisels, 
and knives.   

 
 

 
 
 
 
 
 
 
 
 
 
 
 



 

188	  
	  

Screws: 
Screws can be thought of as a bend incline plane.  Screws can be used to translate a rotational 
force to a perpendicular force.  Because of this they can be used to insert objects onto others or to 
move objects from one place to another.   

 
 
 
 
 
 
 
 
 
 

Pulleys: 
Pulleys are usually circular pieces that rotate 

around a center axle or eye.  They usually have a rope or other tension device (chain, thread, 
belt) that is used to change the direction of the force applied and/or increase the force applied.  
Pulleys allow us to pick up things or even move them across large spans laterally with very little 
effort.  One of the most exciting uses of pulleys is in high angle rescue.  Rescuers sometimes use 
sets of pulleys and ropes to extract injured people of the face of rocks, bottom of wells, or even 
the ocean. 
 
   

 
 
 
 
 
 
 
 

 
 Source: 

http://commons.wikimedia.org/wiki/File:Chambers_
1908_Archimedean_Screw.png  

 
 “Drive Screw” Source: 

http://openclipart.org/detail/12324/wood-
screw---blue-by-rfc1394  

 
 “Block and Tackle” by 

Pearson Scott Foresman, source: 
http://commons.wikimedia.org/wiki/File:Bl
ock_and_tackle_%28PSF%29.png  

 
 “Movable Pulleys” Source: 

http://commons.wikimedia.org/wiki/File:Power_pul
ley.svg  
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Wheel and axles: 
Wheels and axles allow us to move things reducing the friction required to slide them. This 
machine can also help us move things vertically as in a wheel and axle used to lift a bucket from 
a well.   
 

 
Simple machines allow us to use smaller forces.  The ratio of the original force to the force you 
utilize is what is called the Mechanical Advantage.  For example if you cut your force by half, 
then the machine is said to give you a 2:1 advantage.  If you cut your force by 3 it is said to give 
you a 3:1 advantage. 
There is an ideal mechanical advantage that is defined by the properties of the idealized design of 
the simple machines.  However, in real life we often experience losses of energy to friction and 
other phenomena.  Because of that we have an Actual Mechanical Advantage (AMA).  The 
AMA can be calculated by measuring the force that was applied to the machine.  We can then 
divide the actual load by the force applied.   
We will experiment with a couple of different machines.  You will then calculate the AMA 
based on the loads you are given.  You will be split into teams for this exercise.  Your team will 
rotate through the machines until you have conducted all the experiments.   
Record your results in the table provided.  You can see instructions and images of the 
experiments below.   

Experiment Load Force Used AMA 

Lever    

Pulley    

Incline Plane    

 
 
 
 
 
 
 

!
 

 “Wheel and Axle to Lift Bucket” 
Published before Jan.1, 1923. Source: 
http://commons.wikimedia.org/wiki/File:Wheelaxle
_quackenbos.gif  

 
 “Wheel and Axle to Move Forward” by 

Clem Rutter, Rochester, Kent, source: 
http://commons.wikimedia.org/wiki/File:Higgins_3503.J
PG  
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Experiments 

 
The following experiments are pretty simple.  They will show you how the mechanical 
advantage of simple machines reduces the force required to perform a task.  You will need the 
same gauge you used for the friction experiment earlier.  Your instructor will help you set up the 
experiments.  With your group start at one experiment and rotate around the stations to get the 
data you need.   
Levers: 
With your gauge determine the force it takes to lift the load provided.  Then place the load on a 
lever (Type 1).  You may need to use some tape to keep the load in place.  Now measure the 
force it takes to lift the load.  Record your results in the table above.   
 

 Photos taken by University of Michigan 
 
Pulleys: 
Using your gauge measure the load you will be picking up with the pulley.  Then attach the load 
to the pulley system.  Now measure the force it takes to lift the load using the pulley system.  
Record your results in the table above.   
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Photos taken by University of Michigan 
 

Incline Plane: 
Using the your gauge measure the load you are supposed to move.  Notice that for the incline 
plane experiment you are trying to raise the load to a certain level and not necessarily move it in 
the horizontal direction.  Using the incline plane set up measure the force it takes to move the 
load.  Record your results in the table above.   

 
 

 
 Photos taken by University of Michigan 
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Lesson 2: Brainstorming and Design 

 
 
 
Objective: 
 
To introduce the students to the brainstorming and design process 
 
 
Outline: 
 

• What is Brainstorming? 
• Why is Brainstorming good? 
• Brainstorming Techniques 
• Brainstorming rules 

 
 by Leeds Tidal, source: 

http://www.flickr.com/photos/30296430@N03/5156113247/sizes/l/in/photostream/  
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Class Discussion: What is brainstorming?  
 
 
 
Brainstorming Definition: 
_______________________________________________________________ 
 
______________________________________________________________________________ 
 
______________________________________________________________________________
______. The term was popularized by Alex Faickney Osborn in the 1953 book Applied 
Imagination. Osborn claimed that brainstorming was more effective than individuals working 
alone in generating ideas. 
 
Or to put it simply, brainstorming is the 
____________________________________________________. 
 
Class Discussion: Why is it called brainstorming? 
 
Class Discussion: Why is brainstorming useful? 
(Removed paragraphs, all-rights-reserved by Infinite Innovations Ltd., accessible at: 
http://www.brainstorming.co.uk/tutorials/benefitsofbrainstorming.html) 
 
What is achieved throughout brainstorming? 
 

• __________________________________________________________________________ 
 

• __________________________________________________________________________ 
 

 
 by Ariel Dovas, source: http://www.flickr.com/photos/eviloars/2926037204/  

Sibu Kuruvilla� 6/19/12 7:04 PM
Comment [221]: Brainstorming	  is	  a	  group	  or	  
individual	  creativity	  technique	  by	  which	  efforts	  are	  
made	  to	  find	  a	  conclusion	  for	  a	  specific	  problem	  by	  
gathering	  a	  list	  of	  ideas	  spontaneously	  contributed	  
by	  its	  member(s).	  

Sibu Kuruvilla� 6/19/12 7:01 PM
Comment [222]: Generation	  of	  new	  ideas	  



 

194	  
	  

• __________________________________________________________________________ 
 

• __________________________________________________________________________ 
 

• __________________________________________________________________________ 
 

For Business and companies better brainstorming means better ideas leading to: 
• More money 
• Faster promotion 
• Increased creativity 
• Better society 
• More pleasant working environment 
• Better employee relations 
• A more responsive company 
• Taking advantages of gaps in the 

market 

• Creating new markets 
• New products and services 
• Better products and services 
• Better management 
• Less conflicts and arguments 
• Improvements in productivity and 

reliability

 
Brainstorming Rules: 
 
 

Reference: Rules of Brainstorming, 
http://www.brainstorming.co.uk/tutorials/brainstormingrules.html. Copyright 1997-2011 Infinite 
Innovations Ltd. All rights reserved.) 

 

Reference: Benefits of Brainstorming, 
http://www.brainstorming.co.uk/tutorials/benefitsofbrainstorming.html. Copyright 1997-2011 Infinite 
Innovations Ltd. All rights reserved.) 

 
 
Size of the brainstorming group:  
________ people: Perfect size for brainstorming. All participants can sit in a circle and feel 
equally involved in the session, while a facilitator guides the process and writes down the 
contributed ideas. In order for all ideas to be kept, participants should have a notepad to write 
down their ideas, in case another participant is talking or the facilitator is writing an idea on the 
main board.  
 
_________ people: A smaller group will be easier to manage, but there may be less ideas to keep 
the session rolling. Participants should be seated around a smaller table, and contribution may be 
greater for each individual.  
 
__________ people: A larger group makes it much more difficult to arrange everyone in a circle 
while still allowing them to feel included. In this case, theatrical-type seating may be more 
beneficial, and each participant should be required to write their ideas down on a notepad. Once 
the session is over, the ideas can be turned in to the facilitator and presented to the entire group, 

Sibu Kuruvilla� 1/23/13 12:14 AM
Comment [223]: •Share different ideas 
•Improve current ideas 
•Generate Many ideas 
•Promotes teamwork 
•Develop solutions 

Brieland Jones� 6/17/12 4:21 PM
Comment [224]: The	  first	  lesson	  is	  very	  
compacted	  and	  I’m	  wondering	  if	  the	  students	  will	  
be	  able	  to	  grasp	  all	  of	  the	  concepts	  in	  just	  2	  hours,	  
especially	  if	  mor	  examples	  are	  added…Maybe	  
splitting	  up	  the	  second	  lesson	  to	  have	  more	  forces	  
and	  then	  brainstorming	  would	  work?	  

Sibu Kuruvilla� 6/19/12 7:16 PM
Comment [225]: 4-‐14	  

Sibu Kuruvilla� 6/19/12 7:16 PM
Comment [226]: <4	  

Sibu Kuruvilla� 6/19/12 7:15 PM
Comment [227]: >14	  
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either anonymously or by identifying the contributor.  
 
Class Activity: Brainstorming Session 
Let us all practice some brainstorming now. We can identify a problem, such as what properties 
are required in a boat, and then brainstorm ideas together. Another example that we can 
brainstorm is the benefits of recycling. Can you guys think of why recycling is useful?  

 
Group Activity: Brainstorming Session 
Now let’s divide into groups, and try brainstorming amongst ourselves. Try to brainstorm 
answers to the following questions, and make sure each student writes all answers done. 
Remember, it’s quantity, not quality at this stage.  

• What properties would a tractor require? 
• What physics principles would be used in the design of a tractor? 
• How would you design a tractor out of raw materials? 

 
 

Design Process 
Coming up with ideas is not enough to solve a problem.  We must find one that actually works.  
This is what we call the design process.  Brainstorming is key to this process since it allows us to 
have ideas to start with.  The design process is iterative.  That means you may need to go through 
the process over and over again until you find an acceptable solution.  The following figure 
illustrates the process.  
 
 
 
 
  
 

Sibu Kuruvilla� 6/19/12 9:17 PM
Comment [228]: “Model” the brainstorming 
process by picking a problem, like what is required 
in building a boat, and then work through a 
brainstorming session with them. Some ideas are that 
the boat needs: 

To float 
Lightweight 
Seat passengers 
Be narrow enough to allow paddling on both sides 

 
Or ask the students to identify which concepts from 
the first Hands-On lecture (force, work, levers) that 
would be useful in the design of a boat or airplane.  

Force 
Weight 
Maybe pulleys (to anchor) 
Screws to hold it together 
Buoyancy (didn’t talk about it, but it is essentially 

a force/free body diagram) 
 
Why is recycling useful? 

Reduces pollution 
Reduces waste products in landfills 
Reduces global warming 
Saves the earth by not requiring more natural 

materials to be used (recycling paper saves trees) 
Saves energy: recycling takes less energy than 

making new materials 

Sibu Kuruvilla� 6/19/12 9:21 PM
Comment [229]: Divide the class into groups 
and give them a problem, like what properties would 
a tractor need, what physical principles would be 
used, and how would they design one. Let them 
brainstorm amongst themselves (10-15 mins), and 
then pick on each group to present one or a few of 
their ideas, and if time allows, critique each of the 
choices.	  
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!

 
 
 
 
 

 

Lesson 3: Material Presentation and Competition Rules and 
Building Time 

 
 

Objective: 
To allow the students to understand the materials they will be working with and their options for their 
use.  

To present the rules for the Tractor Pull Competition and the use of building equipment and 
materials.   

Tractor Pull Competition Rules 
For the competition you will be working in your teams.  Each team will receive the same access 
to materials and tools.  However, you do not need to use all the materials if you do not want to.   

1. Your team must create a machine that we will call a tractor.   
2. Your tractor must be able to move a load vertically.   
3. The load will be attached to a pulley system so that your tractor can move horizontally 

while lifting the load.   
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4. There will be a testing rig provided by your instructors.   
5. The testing rig will consist of the pulley system, the load and a track for your tractor.   
6. Your machine cannot attach itself to any part of the rig other than the provided chain 

ring.   
7. Your team will be able to examine the testing rig before the competition.   
8. Your team will be able to perform at least two test runs on the rig.   
9. Once competition starts each team will be given three attempts at moving the load.   
10. To begin your attempt you must prepare your tractor, attach it to the chain ring, and place 

it on the starting line.  
11. On the signal you must let go completely of the tractor and not provide forward motion to 

it.   
12. The instructor will measure how far the load has moved vertically on the rig.   
13. The final reading will be made after the forward momentum of your tractor has stopped 

(if your tractor begins to slide back it will not count against you).   
14. The best of the three attempts will be your final score.   
15. You will be allowed to place ballast weight on your tractor.  The instructor will provide 

the weight.   
16. Your tractor will be taken to central offices after the competition.   

 
Material List 

You will receive a series of materials.  Each team will receive the same initial amount of each 
material.  You may request additional materials but may not receive them if supplies have run 
out.  The additional materials will be given on a first come first served basis.  Instructors may 
deny your request if they deem that you are wasting materials.   
 
Materials you will receive are: 

- Wheels and axle 
- Towing rig or ring 
- Cardboard 
- Plastic bottle 
- Rubber bands 
- Sand paper 
- Nails 
- Staples 
- Duck tape 
- Scotch tape 
- Twine 
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Lesson 4: Building Time 
 
 
Objective: 
To allow students time to ask questions of the instructors about their design and receive help 
with the building process. 
 
GLOSSARY 
Force: An influence that causes an object to move or change in form.   
Free Body Diagrams: a way to represent the forces acting on a body.   
Energy: the ability to do work. 
Work: A force acting on an object over a distance.  It is measured in N*m or J.   
Friction: A special force that acts on objects resisting their movement at contact points.   
Mechanical Advantage: The ability of a simple machine to reduce the force required to perform a 
task.   
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Simple Machines: Six instruments that were recognized during the renaissance as capable of 
reducing the force needed to perform a task.  The six simple machines are levers, incline planes, 
wedges, screws, pulleys, and wheels and axles.   
Brain Storming: A process that can be used to generate ideas and possible solutions to a problem. 
Design Process:  A series of steps used to come up with a desired solution for a problem.   
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 

Life Skills 
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Lesson 1: The Importance of Teamwork 
Objectives: Students will continue to develop – here more intentionally – their skills as 
colleagues and classmates working together towards a common goal. 
 
Lesson:  
I. Teamwork, Team Building, Group Development, and Group Dynamic 

Coming together is a beginning. 
Keeping together is progress. 
Working together is success. 

- Henry Ford 
A team is a group of people who come together temporarily to achieve a   

   
  

There is no magic formula for "building a team" because teams are organic - they  
and  . 
 
By studying how individuals, groups and teams work you will enhance your                         

of helping teams learn how to work together                                      . Improving teams 

usually requires a combination of improving                                 ,                                         of 

others,                                                   and negotiation skills, and                         

skills.  Experiential learning offers a rich framework and methodology for real-life and real-

situation development of teamwork. 
 

 
Team building is tied to                                                                           -- team development 

requires individual team members to                             and                                        -- as an 

individual's personal growth unfolds, so too does their                                          to participate 

in and thrive in group situations. 

The closer the correspondence between                            goals and                                  goals, 

the greater the sum of individual motivations for  ___________________________.  

 
Team building is not easy, but there are several techniques, principles and methods which 
can make a real difference, including: 
 

Stages of Group Development 

Bruce Tuckman (1965) developed a 5-stage model of group development: 

Aisha Moinuddin� 6/22/12 4:40 PM
Comment [230]: May	  also	  include	  a	  name	  game	  
at	  the	  start	  of	  this	  block	  of	  time	  

Aisha Moinuddin� 6/22/12 4:40 PM
Comment [231]: This	  lesson	  is	  to	  be	  used	  
primarily	  as	  an	  Icebreaker	  exercise	  and	  to	  give	  the	  
students	  a	  chance	  to	  interact	  in	  team	  building	  
games/exercises.	  The	  lesson	  plan	  does	  not	  need	  to	  
be	  followed	  rigidly!	  

Manchester Staff� 6/22/12 4:40 PM
Comment [232]: Teachers:	  Take	  about	  30	  
minutes	  total	  to	  complete	  Part	  I,	  allowing	  time	  to	  
complete	  the	  two	  activities	  and	  some	  discussion	  
questions	  at	  the	  end	  of	  the	  lesson.	  
	  
Teachers	  should	  stand	  by	  board	  and	  take	  
suggestions	  and	  write	  down	  possible	  answers	  for	  
blanks.	  Also,	  provide	  feedback	  and	  guide	  the	  
discussion.	  

Manchester Staff� 6/22/12 4:40 PM
Comment [233]: Answers:	  common	  purpose	  
	  
	  
	  
	  
Grow;	  change	  
	  
	  
	  
Capability	  
	  
Effectively	  
	  
	  
Work	  skills;	  understanding	  
	  
Communication;	  problem	  solving	  

Manchester Staff� 6/22/12 4:40 PM
Comment [234]: Answers:	  personal 
development  
Grow; develop 
 
capacity	  

Manchester Staff� 6/22/12 4:40 PM
Comment [235]: Answers:	  Team;	  individual	  
	  
succeeding together	  
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1.                                     : The group comes together and gets to initially know one 
other and form as a group.  

2.                                      : A chaotic vying for leadership and trialing of group 
processes.  

3.                                      : Eventually agreement is reached on how the group 
operates (norming)  

4.                                      : The group practices its craft and becomes effective in 
meeting its objectives. 

5.                                       : The process of "unforming" the group, that is, letting go 
of the group structure and moving on. 

Group Dynamics 
1. Group development - How does a groups' pattern of behavior evolve and change 

over time?  
____________________________________________
__________________________________________ 

 
2. Group size - Does the size of the group matter? How do the experiences of a 

group of 3 differ from a group of 30 from a group of 300 or 3000?  
____________________________________________
__________________________________________ 

 
3. Risky shift - Do people tend to take risks in groups that they would be less likely 

to take alone? How so? 
____________________________________________
__________________________________________ 
 

4. Social support - How important is fostering social support within personal 
development groups? What ingredients need to be combined with social support 
to effectively facilitate personal and group growth and development? e.g., Growth 
= Challenge + Support  
____________________________________________
__________________________________________ 
 

 
 
 

Manchester Staff� 6/22/12 4:40 PM
Comment [236]: Answers:	  Forming	  
	  
	  
	  
Storming	  

Manchester Staff� 6/22/12 4:40 PM
Comment [237]: Answers:	  Norming	  
	  
	  
	  
Performing	  
	  
	  
	  
Adjourning	  

Manchester Staff� 6/22/12 4:40 PM
Comment [238]: Teachers:	  Take	  about	  10	  
minutes	  and	  answer	  these	  together	  as	  a	  class	  or	  
divide	  students	  into	  groups.	  	  
Instruct	  students	  to	  write	  down	  answers	  in	  their	  
manual.	  
There	  are	  no	  right	  or	  wrong	  answers	  as	  this	  is	  more	  
for	  the	  students	  to	  think	  critically	  about	  group	  
dynamics.	  
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5. Group games & activities - What kinds of games and activities can be used to 
help people get to know one another and develop their interrelationships?  
____________________________________________
__________________________________________ 

 
6. Group mix - What is the effect of having groups consisting of people from one 

ethnicity compared to groups which are multi-ethnic? Is it better to create groups 
with diverse (heterogenous) or narrow (homogenous) membership?  
 
____________________________________________
__________________________________________ 

 
7. Group norms - What kinds of group norms evolve? What role does the facilitator 

play in the formation of group norms? What kinds of group norms should be 
established? (e.g., through a group contract and organizational culture) In what 
kinds of situations should a participant be excluded from a group?  

 

____________________________________________
__________________________________________ 
____________________________________________
__________________________________________ 

 
Group dynamics can be brazenly characterized as explosively positive, dull/neutral, or 
explosively negative.  So watch out if you're going to tinker with groups -- anything can and 
usually does happen.  The more experience you have the better, but experience is no cause 
for complacency or conceit, since every group situation is unique. 

 
II. Game Time! 

See teachers for further instructions  
 
III. Discussion 

In small groups discuss the following questions about the activities: 
 
1. What links exist between the teamwork activities and how they relate to skills for college 
courses or employment? 
 
 
 
 
 
 
 
 

 � 6/22/12 4:40 PM
Comment [239]: LOCATE	  UM	  LOGO	  
BALLOONS!!	  

Manchester Staff� 1/23/13 12:14 AM
Comment [240]:  
 
A. The Balloon Game- A Teamwork Activity 
1.Give about 10 minutes to complete activity. 
2.This is an "all-in" teamwork activity game 
which requires a bag of balloons, some chalk, 
lots of enthusiasm and a wide open indoor 
space! 
3.Mark out an area on the floor with chalk, and 
explain to students that this is the game area. 
Blow up about ten balloons (more or less 
depending on your class size).  
4.Tell students the challenge is to keep all the 
balloons in the air at the same time, and within 
the game area. The best way to do this (what a 
surprise!) is for them to all work together.  
5.Failing to co-operate with each other will end 
up with balloons going in all directions, and 
landing on the ground or going out of the game 
area.  
6.Working together as a group and using good 
teamwork skills will mean the balloons can be 
kept aloft easily, without any going out of the 
area. 
7.Ask students to set themselves a time 
challenge, or to gradually increase their skills to 
the point where they can keep greater numbers 
of balloons up at the same time.  
8.As they get more used to get game, add other 
elements such as only using their feet or not 
touching the same balloon twice in a row. 
 
 
B. Blindfolded - Are Your Eyes Open to 
Being Work Ready? 
1.Allow about 10 minutes to complete activity, 
switching partner roles after 5 minutes. 
2.Organize students into pairs.  
3.Give each pair a blindfold (a scarf will do).  
4.Instruct students to organize a 'safe word' so 
the person who is blindfolded can end the game 
at any point if they do not feel safe.  
5.Arrange the pairs in a large, safe area with no 
obstacles nearby.  
6.Add an appropriate 'stop signal' of your own, 
such as a whistle blast (for any hearing 
impaired students, use a more suitable signal), 
to tell students there is a problem of some sort ... [1]

Aisha Moinuddin� 6/22/12 4:40 PM
Comment [241]: Blindfolds	  to	  be	  purchased	  in	  
Liberia;	  	  

Manchester Staff� 6/22/12 4:40 PM
Comment [242]: Teachers:	  Use	  these	  questions	  
to	  conclude	  the	  lesson.	  They	  are	  optional	  and	  it	  may	  
not	  be	  necessary	  to	  complete	  them	  all.	  These	  
questions	  can	  be	  discussed	  as	  a	  class	  (if	  there	  is	  a	  
small	  amount	  of	  time	  left)	  or	  in	  smaller	  groups	  (if	  
more	  time	  is	  left).	  
Instruct	  the	  students	  to	  write	  down	  some	  answers	  
in	  their	  manuals.	  

Aisha Moinuddin� 6/22/12 4:40 PM
Comment [243]: Other	  ideas:	  Human	  Knot,	  
Toxic	  Waste,	  Reach	  and	  Grab	  
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2. What are some examples of other activities that may help others learn to be ready for 
teamwork? 
 
 
 
 
 
3. What problems can happen in a team setting if someone lacks the skills needed to get 
along with the team? 
 
 
 
 
 
 
 
4. Overall, how did you feel during the blindfold game? How well did your partner guide 
you? How well did you guide your partner? 
 
 
 
 
 
 
 
5. How can you carry on your team building skills throughout everyday activities? At 
school? At home? During sports? Doing chores?  
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Lesson 2: The Importance of College and the Application Process  

 
Objective: Students will understand why and how a college education is important to obtain. 
They will review the admissions requirements of a few Liberian colleges, as well as practice 
filling out a college application. 
 
Lesson:  

I. As a group, answer the following questions. As answers are given, write down the 
ones that are most important for you on the following lines. 
 
a. Why should I go to college?  

 
 
 
 
 
 
 
 
 

b. What are the benefits of going to college?  
 
 
 
 
 
 
 
 
 

c. What are the drawbacks? 
 

 
 
 
 
 
 
 
 

d. How can I overcome these drawbacks? 
 

 
 
 

Manchester Staff� 1/23/13 12:14 AM
Comment [244]: Teachers:	  This	  should	  take	  
about	  10	  minutes.	  Allow	  students	  to	  write	  the	  most	  
meaningful	  answers	  in	  their	  manuals	  if	  they	  need	  
more	  time.	  	  	  
	  
Hints	  to	  stimulate	  discussions:	  
•It	  will	  give	  you	  a	  better	  quality	  of	  life.	  
•It	  will	  give	  you	  the	  power	  to	  change	  the	  world.	  
•It	  will	  likely	  make	  you	  more	  prosperous.	  
•It	  will	  be	  something	  you	  can	  pass	  on	  to	  your	  
children. 
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II. Admissions Requirements for Various Colleges: 
 

Cuttington University: 
• $20 application fee 
• Must have at least a 2.00 cumulative High School GPA 
• Required Units: 
• English: 4 Units 
• Math: 3 Units (2 years of Algebra and 1 year of Plane Geometry) 
• Social Science: 3 Units 
• Entrance Exam 
• WAEC Certificate 
• High School diploma 
• Two letters of recommendation from his/her previous school and community, 

church or mosque 
• Two passport size photos 
• Application letter 
• Health certificate from the University's Clinic  

University of Liberia: 
• Autobiography a page or two 
• Health Certificate 
• Two letters of recommendation (one from a church or community) 
• High School Diploma 
• Transcript 
• WAEC Certificate 
• Application form that you pick up at the university  
• Two photos 
• Entrance Exam 
• $25-$30  
•  

Tubman University: 
• High School transcript (showing evidence of graduation) 
• WAEC Certificate with (copy of scores) 
• Recommendation 
• Three passport size photos 
• Health Certificate 
• Birth Certificate 
• Autobiography 
• Placement Test for Math and Language Arts 

Stella Maris Polytechnic: 
• Entrance Exam 
• Interview at Mother Patern College of Health Sciences 

Manchester Staff� 6/22/12 4:41 PM
Comment [245]: Teachers:	  Read	  over	  
requirements,	  taking	  only	  about	  5	  minutes.	  Allow	  
about	  20	  minutes	  for	  students	  to	  respond	  to	  the	  
questions.	  Answering	  the	  questions	  does	  not	  
necessarily	  have	  to	  be	  done	  individually	  because	  
some	  students	  may	  not	  know	  the	  answer	  to	  all	  the	  
questions	  (e.g.	  when	  and	  where	  to	  take	  the	  WAEC).	  
Therefore,	  it	  might	  be	  beneficial	  to	  allow	  groups	  of	  
2	  or	  3	  to	  work	  together,	  or	  answer	  such	  questions	  as	  
a	  class.	  	  
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• WAEC Certificate 
• High School Transcript and Diploma 
• Two letters of recommendation 
• One from last attended school 
• One from pastor, parish priest or Imam 
• Two passport size photos 
• Application Letter 

Answer the following questions about how you can prepare for college: 

a. What am I going to do to prepare for an entrance exam and/or placement tests? 

 

 

b. When and where am I going to take the WAEC? 

 

 

 

c. How am I going to obtain my High School diploma and transcripts? 

 

 

 

a. Do I have the GPA I need to apply to my college of choice? 

 

d. What is a letter of recommendation? 

 

 

a. Who can I ask to write a letter of recommendation? 
i. School faculty: 

 

Aisha Moinuddin� 6/22/12 4:41 PM
Comment [246]: Include	  University	  of	  Liberia	  
requirements	  as	  well	  
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ii. Community members: 
 

 

iii. Church/mosque members: 
 

 
b. Are there inappropriate ways of seeking recommendation letters? How do 

you ensure you maintain your own sense of self-respect and character in 
the face of the challenges of a strong application? 
 

e. Where can I obtain passport size photos? 

 

f. Have I taken the right amount of units required for my college of choice? 
 

 

a. What other units do I still need? 

 

g. How do I plan on paying for college? 

 

 

III. Filling out a College Application 
 
Look over this application and fill out only the forms titled PLACEMENT TEST 
REGISTRATION FORM and ADMISSION APPLICATION. The rest are just for 
your viewing to give you an idea of what types of forms you may be required to fill 
out. Be sure to use legible handwriting and if you have any questions, please ask.  

 
 
 

Aisha Moinuddin� 6/22/12 4:41 PM
Comment [247]: Peace	  corps	  members	  may	  also	  
be	  applied	  to	  (or	  instructors	  from	  the	  camp)	  

Aisha Moinuddin� 6/22/12 4:41 PM
Comment [248]: Teachers	  may	  use	  this	  
discussion	  question	  as	  a	  way	  to	  open	  up	  a	  discussion	  
within	  the	  small	  groups	  regarding	  the	  
inappropriateness	  of	  bribes	  and	  sexual	  favors,	  etc	  
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Lesson 3: General Placement Tests 
Objectives: Students will gain understanding about placement and standardized tests, including 
what they mean, how they are structured, and why they are important.  They will also learn 
practical tips for successfully completing a standardized test. Finally, students will be given the 
opportunity to put those tips to use in a short, mock exam. 

I. The WAEC Exam 

• Exams take place May/June or November/December 
• Students must provide pencils, math sets, etc. unless the school provides them. 
• Answers must be written in pen and ink, pencils are allowed only for diagrams and 

objective answers. 
• Simple calculators are allowed. 

 
More details about the Exam is available at: http://www.liberiawaec.org/lshsce.html 

 
II. General Test Taking Tips: 

Preparations: 

Study concepts you do not know or understand and review concepts you do understand 
every day leading up to the exam: 

o Math concepts: 
 Algebra, geometry, statistics, etc. 

o Language concepts: 
 Writing formal letters, writing an article, writing an effective argument 
 Mastery of the English language 

o Science concepts: 
 Biology: balancing equations, definitions 
 Physics: force, viscosity, speed of electrons, collisions 
 Chemistry: atomic numbers, states of matter, equilibrium, different laws 

o Social Science concepts: 
 Geography: topographical maps, graphs, definitions, earth science 
 Economics: total revenue calculations, ratios 
 History 

 

Answer the following questions: 
a. In which areas am I most familiar?  

 
 
 
 

b. In which areas do I still need to improve?  

Manchester Staff� 6/22/12 4:43 PM
Comment [250]: Teachers:	  Only	  take	  about	  5	  
minutes	  to	  go	  over	  WAEC	  criteria.	  

Manchester Staff� 6/22/12 4:43 PM
Comment [251]: Teachers:	  allow	  25	  minutes	  
total	  to	  review	  tips	  and	  answer	  questions.	  	  
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c. How am I going to make sure I do my best in all areas? 
 

 
 

Day before the exam: 

• Review concepts 
• Set everything out to take with you to the exam. This includes packing a back of 

test-taking necessities (e.g. pens, pencils, scrap paper, calculator, etc.), even the 
clothes you are going to wear to the test. This way, you won’t have to scramble 
around looking for everything the day of the test. 

• Get a good night’s rest! Relax before you hit the sack and don’t cram for the test 
before you go to bed. If you have studied well in the days and weeks preceding 
the exam, you should be able to rest well, being confident that you have prepared 
the best you could. 

 
Morning of the exam: 

• Eat breakfast- especially a high protein/high carbohydrate meal (e.g. eggs and 
toast, meat and a fruit). This will fuel your body and your brain to stay as alert 
and active during the exam as much as they can. Besides, there is nothing worse 
than trying to focus on something important when your stomach is growling. 

• Fill up a water bottle and take it with you to stay hydrated during the exam. If 
possible, take a small snack to munch on during breaks. This will help stave off 
hunger during the exam. 

• Leave with enough time to get to the exam 20 minutes early. When you arrive at 
the exam site, take a walk around and become familiar with the place. Seek out 
restrooms, drinking fountains, etc. so you do not waste valuable time looking for 
them. If possible, find a seat in the exam room farthest from any possible 
distractions so you can focus on your own exam and not what is happening 
outside the window or what your fellow test-takers are doing. 

During the exam: 

• Read all the directions and make sure you understand what is being asked. If you 
are unsure of any directions, ask for assistance and clarification. 

• Relax! You were made for this moment and, with all your preparation, you will 
do fine. 

 � 6/22/12 4:43 PM
Comment [253]: Teachers:	  This	  is	  probably	  not	  
going	  to	  be	  an	  exciting	  lesson,	  so	  to	  break	  up	  the	  
monotony,	  have	  the	  students	  each	  read	  a	  bullet	  
points,	  or	  have	  the	  student	  who	  just	  read	  chose	  the	  
next	  reader	  (popcorn).	  	  



 

211	  
	  

• Pace yourself. Don’t rush through the questions to be the first one done, but don’t 
linger longer than you have to on any one question. If a question is too difficult or 
time consuming at the moment, skip it and come back if there is time. Use all the 
time allotted for the test. 

• Determine how much time you can spend on each question. For example, if you 
have 60 minutes to complete 120 questions, you should only spend 30 seconds on 
each question. However, if there are several questions you know the answer to 
right away, then you can use those extra seconds to answer more difficult 
questions. 

• Relax your hand, neck, shoulders and back. Every so often, take a break to pull 
your shoulders back, take a deep breathe, and shake out your hand. 

• Write as neatly as you can and fill out bubble sheets as neatly as possible. 
• Double check your question numbers every few questions to make sure you are 

answering the right question on the right line. 

 
For multiple choice questions: 

• Read the whole question and all the answer choices before you mark anything. 
Make sure you understand what the question is asking and if you do not 
understand any directions, ask for help. 

• Try to answer every question. Make the most educated guesses that you can. 
• Think about what you know concerning the question. Use prior knowledge to 

your advantage. 
• Eliminate answers you know are obviously wrong. This narrows down your 

choices and can really help you make a better choice 
o Beware of answer choices using qualifiers (e.g. always, never, often, 

sometimes). Generally, if a statement has a general qualifier (often, 
sometimes, probably) it is true. If the statement has an absolute qualifier 
(always, never, everyone, no one) there is a good chance the statement is 
false. 

• If a statement gives a reason (e.g. because, due to, since) it is most likely false. 
• When you have reached the end of the section, go back through and make sure 

you have answered all the questions 
o With that said, do not second- guess yourself. Your first guess is usually 

the right guess. Unless you are absolutely, without a doubt, 100% sure 
another option is the answer, DO NOT CHANGE YOUR ANSWER. All 
too often students second- guess themselves and put down the wrong 
answer- don’t make the same mistake. 

Math sections: 

• Before you begin answering questions, it may be helpful to write down any 
formulas you know off the top of your head to create a small list to refer to during 
the exam. Make sure you understand what the question is asking. If not, then ask. 
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• Write down any important values, terms, and draw any pictures or diagrams to 
help organize your thoughts before answering. 

• Line up place values, etc. otherwise you will come out with the wrong answer. 
• If your answer does not match any of the choices given, reread the problem, 

recopy the numbers and try again. If you find yourself spending too much time on 
one problem, come back to it later. 

• Make sure your answer choice makes sense for the problem. 

 
Science sections: 

• As with the math tips, it may be helpful to write down any formulas you know. 
• If an excerpt is involved, make sure to read it carefully and even take some notes 

to keep yourself on track. 
• Cross out information that is irrelevant to the question, or write down information 

that is important to the answering of the question on a piece of scrap papers 
• Don’t get caught up in technical terms as they rarely have anything to do with the 

answer. 

 
Language sections: 

• Plan your thoughts before your write your official answer. Brainstorm ideas of 
what you can write about, and then organize them into logical sections. 

• Make sure you stay on topic. What you are talking about at the beginning of the 
essay should be the same thing you are talking about at the end of the essay. 

• Remember, the organization of your essay is just as important as the content. 
Make sure you have an introduction to the topic, a substantial body, and a 
conclusion. 

• Use specific examples when possible. 
• If time is available, proofread and check spelling and grammar. 
• Absolutely DO NOT copy anything word for word. You are smart, so put 

passages in your own words. 

 
Social Science sections: 

• Make sure to read and understand what the question is asking. 
• Write down any formulas you already know to create a reference list. 
• As with math, make sure the answer you have selected makes sense for the 

problem being asked. 
• Draw graphs, histograms, and charts neatly. Make sure they are readable. 
• Answer each question as best you can and use prior knowledge to help answer. 

Answer the following questions: 
a. What other tips can you think of to help you successfully pass this exam? 

 � 6/22/12 4:43 PM
Comment [254]: Teachers:	  Reinforce	  the	  point	  
that	  writing	  an	  essay	  is	  NOT	  something	  to	  be	  copied	  
or	  memorized	  from	  previous	  exams.	  Previous	  exams	  
may	  be	  used	  as	  a	  guide,	  but	  sample	  essay	  answers	  
must	  not	  be	  memorized	  as	  a	  standard	  writing	  from	  
the	  student.	  In	  fact,	  points	  will	  be	  taken	  away	  when	  
this	  is	  the	  case.	  Students	  should	  develop	  their	  own	  
essay	  in	  their	  own	  style.	  	  
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answer	  these	  questions.	  	  
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b. You are one month away from taking the WAEC. Use this space to make a study 
schedule to help you stay on track throughout the month. 

 

Reference: WAEC Practice Exam, http://waeconline.org.ng/e-learning/index.htm. Copyright 2008 
The West African Examinations Council, All rights reserved. 

 

Further Reading: 
 

• How to Balance a Chemical Equation by Anne Marie Helmenstine, Ph.D., About.com 
Guide, http://chemistry.about.com/od/chemistryquickreview/a/balanceequation.htm. All 
rights reserved. 

• Atomic Mass from Atomic Abundance Example Chemistry Problem by Anne Marie 
Helmenstine, Ph.D., About.com Guide, 
http://chemistry.about.com/od/workedchemistryproblems/a/atomabundance.htm. All 
rights reserved. 

• High School physics question about horizontal force, 
http://answers.yahoo.com/question/index?qid=20111003173308AARdMos. All rights 
reserved. 

• Momentum and Collisions: Problem Set, 
http://www.physicsclassroom.com/calcpad/momentum/problems.cfm. Copyright 1996-
2013 The Physics Classroom, All rights reserved. 

• Free Mathematics Tutorials, Problems and Worksheets (with applets) By Abdelkader 
Dendane. Copyright 2003-2013, All rights reserved: 

o Probability Exercises, 
http://www.analyzemath.com/statistics/probability_questions.html. 

o Algebra Exercises, 
http://www.analyzemath.com/high_school_math/grade_11/algebra.html 

o Geometry Exercises, 
http://www.analyzemath.com/high_school_math/grade_11/geometry.html 

o Trigonometry Exercises,	  
http://www.analyzemath.com/high_school_math/grade_11/trigonometry.html 

o Math Word Problems, 
http://www.analyzemath.com/high_school_math/grade_11/problems.html  

 � 6/22/12 4:43 PM
Comment [256]: Teachers:	  After	  this	  portion	  of	  
the	  lesson,	  mention	  the	  practice	  exam	  and	  
encourage	  them	  to	  check	  it	  out	  and	  take	  it	  on	  their	  
own	  time	  (perhaps	  after	  Fast	  Start).	  This	  is	  so	  they	  
can	  get	  a	  general	  idea	  of	  what	  an	  exam	  will	  be	  like.	  
End	  lesson.	  	  
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Lesson 4: Managing Time, Study Skills and Relationships in College 
Objectives: Students will learn and share time management, study skills and relationship 
maintenance while in college. 
Lesson: 

 

 Reference: Time Management for Teens by Deborah Erbach Burger, http://www.homeschool-by-
design.com/time-management-for-teens.html. Copyright 2004, All Rights Reserved. 
 
 

I. Study Skills: Specifying what skills are important for effective studying 

Reference: Study Skills For College That You Want To Have, http://www.study-skills-for-all-
ages.com/study-skills-for-college.html. Copyright 2008-2009, All rights reserved. 

 

Reference: High School Study Skills, http://www.study-skills-for-all-ages.com/high-school-study-
skills.html. Copyright 2008-2009, All rights reserved.  

 

Reference: Study Skills Activities, http://www.study-skills-for-all-ages.com/study-skills-activities.html.  
Copyright 2008-2009, All rights reserved.  

 
 
 What other study skills not mentioned have worked well for you? 
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II. Basic Classes for Success 

 
Objective: Students will be exposed to the areas of coursework they should enroll in for the best chance of 
entering the fields of engineering and agriculture. 
 
Lesson: 
 
Boeing List of “Desired Attributes of an Engineer”  

• A good understanding of engineering science fundamentals: Mathematics (including statistics) – 
Physical and life sciences – Information technology (far more than “computer literacy”)  

• A good understanding of design and manufacturing processes (i.e. understands engineering)  
• A multi-disciplinary, systems perspective  
• A basic understanding of the context in which engineering is practiced: Economics (including business 

practice) – History – The environment – Customer and societal needs  
• Good communication skills: Written – Oral – Graphic – Listening  
• High ethical standards  
• An ability to think both critically and creatively, independently and cooperatively  
• Flexibility. The ability and self-confidence to adapt to rapid or major change  
• Curiosity and a desire to learn for life  
• A profound understanding of the importance of teamwork.  

 
∗ This is a list, begun in 1994, of basic durable attributes into which can be mapped specific skills reflecting the diversity of the overall 

engineering environment in which we in professional practice operate.  
∗ This current version of the list can be viewed on the Boeing web site as a basic message to those seeking advice from the company on the 

topic. Its contents are also included for the most part in ABET EC 2000.  
∗ (  Excerpt from: Mechanical Engineering: How and Why Machines Work, Massachusetts Institute of Technology, 2002 

http://ocw.mit.edu/courses/mechanical-engineering/2-000-how-and-why-machines-work-spring-2002/lecture-
notes/lecture3MEoverview_fixed.pdf) 

 
 
I. Science Courses 
Agricultural engineers are often called biological and agricultural engineers, and most agricultural engineering 
careers require not only technological and engineering knowledge and skills, but also a thorough familiarity 
with the sciences. At the University of North Carolina, for example, the agricultural engineering concentration 
includes three chemistry courses, including a lab, two biology courses and two courses in physics. These basic 
science courses are supplemented with more specialized science classes, such as soil science and 
thermodynamics. 
 
Example syllabi of basic science courses offered at the Massachusetts Institute of Technology (MIT)  
(  http://ocw.mit.edu/) 

Introduction to Inorganic Chemistry II:  

Course Meeting Times 

Lectures: 3 sessions / week, 1 hours / session 

 � 6/22/12 4:46 PM
Comment [257]: Teachers:	  The	  last	  few	  lectures	  
were	  pretty	  intensive	  and	  may	  have	  taken	  more	  
time	  than	  allotted.	  If	  this	  is	  the	  case,	  use	  this	  class	  
period	  to	  catch	  up	  on	  those	  lectures	  before	  delving	  
into	  this	  lecture.	  	  In	  fact,	  this	  can	  just	  be	  used	  as	  a	  
reference	  for	  the	  students.	  	  
	  
If	  you	  are	  caught	  up	  on	  all	  the	  lessons,	  you	  can	  
extend	  this	  into	  a	  full	  lecture-‐	  just	  be	  creative	  ;)	  	  
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Recitations: 1 session / week, 1 hour / session 

Overview 

This course provides a systematic presentation of the chemical applications of group theory with emphasis on 
the formal development of the subject and its applications to the physical methods of inorganic chemical 
compounds. Against the backdrop of electronic structure, the electronic, vibrational, and magnetic properties of 
transition metal complexes are presented and their investigation by the appropriate spectroscopy described. 

Textbook 

Required 

Cotton, Frank A. Chemical Applications of Group Theory. 3rd ed. New York, NY: John Wiley & Sons, Inc., 
1990. ISBN: 9780471510949. 

Recommended 

Albright, Thomas A., Jeremy K. Burdett, and Myung-Hwan Whangbo. Orbital Interactions in Chemistry. New 
York, NY: John Wiley & Sons, 1985. ISBN: 9780471873938. 

Harris, Daniel C., and Michael D. Bertolucci. Symmetry and Spectroscopy: An Introduction to Vibrational and 
Electronic Spectroscopy. New York, NY: Dover Publications, 1989. ISBN: 9780486661445. 

Tsukerblat, Boris S. Group Theory in Chemistry and Spectroscopy: A Simple Guide to Advanced Usage. New 
York, NY: Dover Publications, 2006. ISBN: 9780486450353. 

Assignments 

There are 5 problem sets: 4 graded and one optional. They are worth 10% of the final grade, and will be graded 
on a 0-3 grading scale, with 3 being the highest score. 

Exams 

There are three exams, two during the semester and one final exam. Each is worth 30% of the final grade. 

Grading 

ACTIVITIES PERCENTAGES 
Three exams (30% each) 90% 
Problem sets 10% 

Schedule 

LEC # TOPICS KEY DATES 
1 Symmetry elements and operations  
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LEC # TOPICS KEY DATES 
2 Operator properties and mathematical groups  
3 Irreducible representations and character tables  
4 Molecular point groups I  
5 Molecular point groups II  
6 LCAO and Hückel theory I  
7 Hückel theory II  
8 N-dimensional cyclic systems Problem set 1 due 

9 Band theory in solids  

10 General electronic considerations of metal-ligand complexes  

11 Frontier molecular orbitals of σ-donor, π-donor and π-acceptor 
ligands  

12 Octahedral ML6 σ complexes Problem set 2 due 
13 Octahedral ML6 π complexes  
14 Angular overlap method and M-L diatomics  
15 AOM for MLn ligand fields  
 Exam review Problem set 3 due 
 Exam 1  

16 Introduction to spectroscopy  

17 The weak field  

18 The strong field  

19 Tanabe-Sugano diagrams  

20 Selection rules for electronic spectroscopy  
21 Descent in symmetry  
22 Metal-ligand multiple bonds (M=L)  
23 Metal-ligand multiplebonds (L=M=L) Problem set 4 due 
 Exam review  
 Exam 2  
24 Cyclopentadienyl compounds  
25 Metal-metal bonded complexes  
26 Vibrational spectroscopy  
27 Raman spectroscopy  
28 Normal coordinate analysis  
29 Spin orbit coupling, double groups, and ligand fields  
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LEC # TOPICS KEY DATES 

30 Magnetic susceptibility and the Van Vleck equation Problem set 5 
assigned 

31 Transition metal magnetism  
32 Transition metal magnetism (cont.)  
 Exam review  
 Exam 3  

 

Physics I: Classical Mechanics 

Introduction 

Prerequisites 

Physics I is a first-year, first-semester course at MIT. Students usually take this course at the same time as 18.01 
Single Variable Calculus.   

This course is ideal for motivated high school students, college students, and anyone interested in learning the 
basics of physics. 

Course Overview 

Physics I is an introduction to Classical Mechanics. The noun “mechanics” here refers to the motion of objects: 
we will study how the motion of an object can be understood and predicted in terms of the forces that are acting 
on the object. The adjective “classical,” in this context, means that we will restrict our study to speeds that are 
slow compared to the speed of light, so we will not have to take into account the effects of relativity. It also 
means that we will restrict our study to objects which are generally large, compared to atoms or molecules, so 
that we will not need to consider the effects of quantum theory. Fortunately, almost any situation we are likely 
to meet in everyday life satisfies these restrictions, so the results of classical mechanics have a wide variety of 
applications in science and engineering. 

Course Goals 

The overall goal of this course is to convey the excitement of the physicist's quest to understand nature at its 
deepest level, and at the same time to provide the knowledge and tools that you will need to continue your 
studies in science or engineering. 

There are three main reasons why the study of Classical Mechanics important, one obvious and two more 
subtle. 

1. The physical laws and principles you will learn, and the methods of applying them to practical problems, 
are important and relevant in many other fields. A civil engineer designing a bridge, an automobile 
designer laying out the specifications for the engine or the safety air-bag of a new model, or a geologist 
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estimating the likely severity of the next earthquake all are using, directly or indirectly, the principles of 
classical mechanics. 

2. The structure and development of classical mechanics is a good example of the aims and methods of 
science. You will see how experimental results and mathematical representations are combined to create 
testable scientific theories, and how the impossible complexities of most real-life physical situations can 
be reduced to soluble problems by identifying the essential physical features and ignoring the rest. This 
way of working is what distinguishes the scientific approach to situations from the many other ways of 
looking at them (e.g. artistic, political, business, etc.). 

3. Because the same basic principles can be used in a wide variety of different applications, the study of 
classical mechanics is an excellent introduction to the art of problem solving. By the end of the course 
you should be able to extract the essential features of a problem, use them to set up and solve the 
appropriate mathematical equations, and make quick and easy checks on your answer to catch simple 
mistakes. 

The course will have succeeded in its aims if you come away from it with a grasp of the basic principles 
governing the motion of objects, a feel for the scientific method, and an understanding of the techniques of 
problem solving. 

Course Format 

This course combines the content of two key versions of Classical Mechanics taught at MIT and previously 
published on OCW: a "classroom lecture style" course and a "studio physics" course. The content of those two 
courses are still available in their original form: 

• Physics I with 35 video lectures by Professor Lewin, recorded on the MIT campus during the Fall of 
1999. 

• Physics I as taught in the Studio Physics, or TEAL (Technology Enabled Active Learning), format 

MIT students can expect to spend about 150 hours learning Classical Mechanics. That number comes from a 
combination of attending lectures, studying independently, and time spent in the lab. It’s difficult to estimate 
how long it will take you to complete all of the modules in this particular course because it’s never been taught 
at MIT in this format. But you can probably expect to spend an hour on practice problems, readings and 
assessment for each hour of video you watch. 

Optional Textbook 

Everything you need to complete this course is included on this site. However, if you would like to use a 
textbook in addition to the material provided, the following is recommended: 

Sears and Zemansky's University Physics: with Modern Physics. 12th edition 
Young, Hugh D., Roger A. Freedman, and A. Lewis Ford. San Francisco, CA: Addison Wesley, 2007. ISBN: 
9780805321876. 

II. Math Courses 

All engineering careers require training in higher mathematics. At the undergraduate level, most agricultural 
engineering students will be required to complete courses in calculus and statistics. The University of North 
Carolina requires three semesters of calculus and two semesters of specialized mathematics courses. 
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Example Syllabus of an Undergraduate Calculus Course from MIT (  http://ocw.mit.edu/): 

Prerequisites 

Single Variable Calculus is a first-year, first-semester course at MIT. The prerequisites are high school algebra 
and trigonometry. Prior experience with calculus is helpful but not essential. 

 

 

Course Overview 

Calculus is a foundational course at MIT; it plays an important role in the understanding of science, 
engineering, economics, and computer science, among other disciplines. This introductory calculus course 
covers differentiation and integration of functions of one variable, with applications. Topics include: 

• Concepts of Function, Limits and Continuity 
• Differentiation Rules, Application to Graphing, Rates, Approximations, and Extremum Problems 
• Definite and Indefinite Integration 
• The Fundamental Theorem of Calculus 
• Applications to Geometry: Area, Volume, and Arc Length 
• Applications to Science: Average Values, Work, and Probability 
• Techniques of Integration 
• Approximation of Definite Integrals, Improper Integrals, and L'Hôpital's Rule 

Course Goals 

After completing this course, students should have developed a clear understanding of the fundamental concepts 
of single variable calculus and a range of skills allowing them to work effectively with the concepts. 

The basic concepts are: 

1. Derivatives as rates of change, computed as a limit of ratios 
2. Integrals as a "sum," computed as a limit of Riemann sums 
  

After completing this course, students should demonstrate competency in the following skills: 

• Use both the limit definition and rules of differentiation to differentiate functions. 
• Sketch the graph of a function using asymptotes, critical points, the derivative test for 

increasing/decreasing functions, and concavity. 
• Apply differentiation to solve applied max/min problems. 
• Apply differentiation to solve related rates problems. 
• Evaluate integrals both by using Riemann sums and by using the Fundamental Theorem of Calculus. 
• Apply integration to compute arc lengths, volumes of revolution and surface areas of revolution. 
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• Evaluate integrals using advanced techniques of integration, such as inverse substitution, partial 
fractions and integration by parts. 

• Use L'Hopital's rule to evaluate certain indefinite forms. 
• Determine convergence/divergence of improper integrals and evaluate convergent improper integrals. 
• Determine the convergence/divergence of an infinite series and find the Taylor series expansion of a 

function near a point. 

 

 

 

Course Structure 

This course, designed for independent study, has been organized to follow the sequence of topics covered in an 
MIT course on Single Variable Calculus. The content is organized into five major units: 

1. Differentiation 
2. Applications of Differentiation 
3. The Definite Integral and its Applications 
4. Techniques of Integration 
5. Exploring the Infinite 

Each unit has been further divided into parts (A, B, C, etc.), with each part containing a sequence of sessions. 
Because each session builds on knowledge from previous sessions, it is important you progress through the 
sessions in order. Each session covers an amount you might expect to complete in one sitting. 

Within each unit you will be presented with sets of problems at strategic points, so you can test your 
understanding of the material. As you begin each part of a unit, review the problem set at its end so that you 
may work toward solving those problems as you learn new material. 

MIT expects its students to spend about 150 hours on this course. More than half of that time is spent preparing 
for class and doing assignments. It's difficult to estimate how long it will take you to complete the course, but 
you can probably expect to spend an hour or more working through each individual session. 

Readings, Assignments and Exams 

No textbook is required for this OCW Scholar course. 

The notes that accompany the video clips present their content slightly more formally than Professor Jerison 
does. If you are wondering exactly what conditions must hold for a statement to be true or if you wish to see the 
details of the calculations displayed on the blackboard, check the notes. 

"Worked examples" present a problem or problems to be solved; many of these problems have appeared on 
homework assignments at MIT. After you have solved these problems you can check your answer against a 
detailed solution. 
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Some worked examples will be accompanied by a Mathlet. These interractive learning tools will improve your 
geometric intuition and illustrate how changes in certain factors affect the results of different calculations. 

Problem sets occur at the end of each part; these were taken directly from homework assigned at MIT in the Fall 
of 2009. As you start each part, familiarize yourself with the problems in the problem set. This will enable you 
to work on each problem as you gain the knowledge you need to solve it. Once you have completed the problem 
set you can check your answers against the solutions provided. (The problem sets are carefully selected from a 
longer list of questions available to you. Do not hesitate to work any problem that piques your interest.) 

Each unit ends in an exam. To prepare for an exam, check that you are proficient in each of the topics listed in 
the exam review lecture and review your work on the unit's examples and problem sets. Allow yourself one 
hour to work each exam and three hours to complete the final. The exams are quite challenging; do not be 
surprised if you are unable to complete all of the questions correctly in the time allowed. 

Example of an Undergraduate Calculus Assignment from MIT (  http://ocw.mit.edu/): 

 
18.01 EXERCISES  
Unit 1. Differentiation  
 
1. By completing the square, use translation and change of scale to sketch  

a) y=x22x-1  b) y =3x
2 
+6x +2  

 
2. Sketch, using translation and change of scale 2  

a) y= 1+ |x+2|   
 
b) y=(x-1)2

 
 

4.  
a) Show that every polynomial is the sum of an even and an odd function.  
b) Generalize part (a) to an arbitrary function f(x) by writing  
 f(x)= [(f(x) + f(-x))/2] + [(f(x) + f(-x))/2] 
 
Verify this equation, and then show that the two functions on the right are respectively even and odd.  
 
c) How would you write 1/x + a as the sum of an even and an odd function?  

 
 
5. Find the inverse to each of the following, and sketch both f(x) and the inverse function g(x). Restrict 
the domain if necessary. (Write y = f(x) and solve for y; then interchange x and y.)  

a) (x-1)/ (2x+3) b) x2+2x 

 

6. Express in the form Asin(x + c)  

a) sin x + √3cos x  b) sin x 
− 

cos x  

 

7. Find the period , amplitude , and phase angle, and use these to sketch  
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a) 3sin(2x-π)   b) -4cos(x + π/2) 

 

 

 
III. Technology and Mechanics Courses 
Courses in technology and mechanics will combine the agricultural engineering major's knowledge of 
mathematics and science. Courses might include engineering mechanics, engineering dynamics, hydraulics, 
fluid mechanics, geomatics, mechanics of solids, bioinstrumentation and engineering design. These specialized 
courses are usually introduced in the latter part of the degree program, after basic requirements have been met. 
Students will take courses in computer technology and systems modeling. 
 
  
Example Course Descriptions from MIT (  http://ocw.mit.edu/): 
 

Mechanics & Materials I: 
This course provides an introduction to the mechanics of solids with applications to science and 
engineering. We emphasize the three essential features of all mechanics analyses, namely: (a) the 
geometry of the motion and/or deformation of the structure, and conditions of geometric fit, (b) the 
forces on and within structures and assemblages; and (c) the physical aspects of the structural system 
(including material properties) which quantify relations between the forces and 
motions/deformation. 
 
 
Hydrodynamics: 
This course covers the development of the fundamental equations of fluid mechanics and their 
simplifications for several areas of marine hydrodynamics and the application of these principles to 
the solution of engineering problems. Topics include the principles of conservation of mass, 
momentum and energy, lift and drag forces, laminar and turbulent flows, dimensional analysis, 
added mass, and linear surface waves, including wave velocities, propagation phenomena, and 
descriptions of real sea waves. Wave forces on structures are treated in the context of design and 
basic seakeeping analysis of ships and offshore platforms. Geophysical fluid dynamics will also be 
addressed including distributions of salinity, temperature, and density; heat balance in the ocean; 
major ocean circulations and geostrophic flows; and the influence of wind stress. Experimental 
projects conducted in ocean engineering laboratories illustrating concepts taught in class, including 
ship resistance and model testing, lift and drag forces on submerged bodies, and vehicle propulsion. 

 
Mechatronics: 
This course teaches the design of mechatronic systems which integrate mechanical, electrical, and 
control systems engineering. A computer hard disk drive is an example of a complex mechatronic 
system discussed in the class. Laboratories form the core of the course. They cover topics such as 
aliasing, quantization, electronic feedback, power amplifiers, digital logic, encoder interfacing, and 
motor control. The labs make extensive use of Simulink®, a MATLAB® toolbox which allows for 
graphical simulation and programming of real-time control systems. The new lab facilities feature 
dSPACE digital signal processors which are programmed through Simulink®. Each student builds 
circuits on a breadboard kit which is issued to them. 
 
Solid Mechanics: 
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This course introduces students to the fundamental principles and methods of structural mechanics. 
Topics covered include: static equilibrium, force resultants, support conditions, analysis of 
determinate planar structures (beams, trusses, frames), stresses and strains in structural elements, 
states of stress (shear, bending, torsion), statically indeterminate systems, displacements and 
deformations, introduction to matrix methods, elastic stability, and approximate methods. Design 
exercises are used to encourage creative student initiative and systems thinking. 

 
Thermodynamics of Materials: 
Treatment of the laws of thermodynamics and their applications to equilibrium and the properties of 
materials. Provides a foundation to treat general phenomena in materials science and engineering, 
including chemical reactions, magnetism, polarizability, and elasticity. Develops relations pertaining 
to multiphase equilibria as determined by a treatment of solution thermodynamics. Develops 
graphical constructions that are essential for the interpretation of phase diagrams. Treatment includes 
electrochemical equilibria and surface thermodynamics. Introduces aspects of statistical 
thermodynamics as they relate to macroscopic equilibrium phenomena. 
 
Advanced Soil Mechanics: 
This class presents the application of principles of soil mechanics. It considers the following topics: 
the origin and nature of soils; soil classification; the effective stress principle; hydraulic conductivity 
and seepage; stress-strain-strength behavior of cohesionless and cohesive soils and application to 
lateral earth stresses; bearing capacity and slope stability; consolidation theory and settlement 
analysis; and laboratory and field methods for evaluation of soil properties in design practice. 

 
 
IV. Communications Courses: Public Speaking, English and Writing 

These courses are outside the realm of engineering courses; however, they are incredibly important to 
take because within the field of engineering, you will be expected to communicate both verbally through 
public speaking and in writing through scientific essays, papers and articles.  
 

 
V. Elective Courses 

It will also be important to take courses such as art, physical education, literature, or social science 
courses. Although these are not directly related to engineering, they will broaden your course base and 
give you experience in other fields. Additionally, while you are engaged in these courses, always 
consider how they can further your prospects as an engineer. In other words, ask yourself: “In what 
ways can this course help in my future as an engineer?” Not only will asking yourself this keep you 
focused on the course, it will also help you determine how to use other disciplines within your career.   
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Lesson 5: Intelligence, Aptitudes, Interests and Personalities 
Objectives: Students will learn how to begin to assess their learning preferences, personal traits and qualities 
and how to take stock of their personal inventory/resources and career possibilities.  
Lesson:  

I. Multiple Intelligences: What are they and Why are they Important?  

 Reference: Excerpt from: Theory of multiple intelligences, Wikipedia. 
http://en.wikipedia.org/wiki/Theory_of_multiple_intelligences.  

 
 
Logical-mathematical 

This area has to do with logic, abstractions, reasoning and numbers and critical thinking. While it is often 
assumed that those with this intelligence naturally excel in mathematics, chess, computer programming and 
other logical or numerical activities, a more accurate definition places less emphasis on traditional mathematical 
ability and more on reasoning capabilities, recognizing abstract patterns, scientific thinking and investigation 
and the ability to perform complex calculations. Logical reasoning is closely linked to fluid intelligence and to 
general ability.  

Spatial 
This area deals with spatial judgment and the ability to visualize with the mind's eye. A spatial person is also 
good with puzzles.  
 
Linguistic 
This area has to do with words, spoken or written. People with high verbal-linguistic intelligence display a 
facility with words and languages. They are typically good at reading, writing, telling stories and memorizing 
words along with dates. They tend to learn best by reading, taking notes, listening to lectures, and by discussing 
and debating about what they have learned. Those with verbal-linguistic intelligence learn foreign languages 
very easily as they have high verbal memory and recall, and an ability to understand and manipulate grammar 
and structure.  
 
Bodily-kinesthetic 

The core elements of the bodily-kinesthetic intelligence are control of one's bodily motions and the capacity to 
handle objects skillfully (206). Gardner elaborates to say that this intelligence also includes a sense of timing, a 
clear sense of the goal of a physical action, along with the ability to train responses so they become like 
reflexes. 

In theory, people who have bodily-kinesthetic intelligence should learn better by involving muscular movement 
(e.g. getting up and moving around into the learning experience), and are generally good at physical activities 
such as sports or dance. They may enjoy acting or performing, and in general they are good at building and 
making things. They often learn best by doing something physically, rather than by reading or hearing about it. 
Those with strong bodily-kinesthetic intelligence seem to use what might be termed "muscle memory", drawing 
on it to supplement or in extreme cases even substitute for other skills such as verbal memory. 

 � 6/22/12 4:50 PM
Comment [258]: This	  lesson	  is	  broken	  up	  into	  
two	  30-‐minute	  sections;	  be	  sure	  to	  leave	  enough	  
time	  in	  each	  section	  to	  complete	  the	  activities.	  

 � 6/22/12 4:50 PM
Comment [259]: Teachers:	  choose	  students	  to	  
briefly	  read	  each	  paragraph	  out	  loud	  to	  the	  class.	  
This	  should	  only	  take	  about	  10	  minutes,	  leaving	  
enough	  time	  in	  the	  first	  30	  minutes	  to	  complete	  the	  
20	  minute	  multiple	  intelligence	  test.	  
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Musical 

This area has to do with sensitivity to sounds, rhythms, tones, and music. People with a high musical 
intelligence normally have good pitch and may even have absolute pitch, and are able to sing, play musical 
instruments, and compose music. Since there is a strong auditory component to this intelligence, those who are 
strongest in it may learn best via lecture. Language skills are typically highly developed in those whose base 
intelligence is musical. In addition, they will sometimes use songs or rhythms to learn. They have sensitivity to 
rhythm, pitch, meter, tone, melody or timbre. 

Research measuring the effects of music on second language acquisition is supportive of this music-language 
connection. In an investigation conducted on a group of elementary-aged English language learners, music 
facilitated their language learning. This theory may help to explain why music and its sub-components (i.e., 
stress, pitch, and rhythm) may be viable vehicles for second language learning. 

Interpersonal 

This area has to do with interaction with others. Interpersonal intelligence is the ability to understand others. In 
theory, individuals who have high interpersonal intelligence are characterized by their sensitivity to others' 
moods, feelings, temperaments and motivations, and their ability to cooperate in order to work as part of a 
group. "Inter- and Intra- personal intelligence is often misunderstood with being extroverted or liking other 
people..." Interpersonal intelligence means that you understand what people need to work well. Individuals with 
this intelligence communicate effectively and empathize easily with others, and may be either leaders or 
followers. They typically learn best by working with others and often enjoy discussion and debate. 

Intrapersonal 

This area has to do with introspective and self-reflective capacities. This refers to having a deep understanding 
of the self; what your strengths/ weaknesses are, what makes you unique, being able to predict your own 
reactions/emotions. Philosophical and critical thinking is common with this intelligence.  

Before taking the assessment on the next page, what intelligence level do you think is dominant in your 
life? What leads you to believe this? 

 

 

 

Why is it important to understand which intelligence level is dominant for you? That is, how can 
knowing which intelligence level is dominant help in your work in high school, college, and your career?
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II. Multiple Intelligence Test  

 Reference: Multiple Intelligence Test by BHS Learning Center, 
http://bhslearningcenter.wikispaces.com/Multiple+Intellegence+Test.  

     

Where does your true intelligence lie?  This quiz will tell you where you stand and what to do about it.  Read 
each statement.  If it expresses some characteristic of yours and sounds true for the most part, jot down a "T." If 
it doesn't, mark an "F." If the statement is sometimes true, sometimes false, leave it blank.  

 

  1.  _____  I'd rather draw a map than give someone verbal 
directions.  

  2.  _____  I can play (or used to play) a musical instrument.  

  3.  _____  I can associate music with my moods.  

  4.  _____  I can add or multiply in my head.  

  5.  _____  I like to work with calculators and computers.  

  6.  _____  I pick up new dance steps fast.  

  7.  _____  It's easy for me to say what I think in an argument 
or debate.  

  8.  _____  I enjoy a good lecture, speech or sermon.  

  9.  _____  I always know north from south no matter where I 
am.  

10.  _____  Life seems empty without music.  

11.  _____  I always understand the directions that come with 
new gadgets or appliances.  

12.  _____  I like to work puzzles and play games.  

13.  _____  Learning to ride a bike (or skates) was easy.  

14.  _____  I am irritated when I hear an argument or 
statement that sounds illogical.  

15.  _____  My sense of balance and coordination is good.  

16.  _____  I often see patterns and relationships between 
numbers faster and easier than others.  

17.  _____  I enjoy building models (or sculpting).  

18.  _____  I'm good at finding the fine points of word 
meanings.  

19.  _____  I can look at an object one way and see it sideways 
or backwards just as easily.  

20.  _____  I often connect a piece of music with some event 
in my life.  

21.  _____  I like to work with numbers and figures.  

22.  _____  Just looking at shapes of buildings and structures 
is pleasurable to me.  

23.  _____  I like to hum, whistle and sing in the shower or 
when I'm alone.  

24.  _____  I'm good at athletics.  

25.  _____  I'd like to study the structure and logic of 
languages.  

26.  _____  I'm usually aware of the expression on my face.  

27.  _____  I'm sensitive to the expressions on other people's 
faces.  

28.  _____  I stay "in touch" with my moods.   I have no 
trouble identifying them.  

29.  _____  I am sensitive to the moods of others.  

 � 6/22/12 4:50 PM
Comment [260]: Teachers:	  allow	  about	  20	  
minutes	  for	  students	  to	  complete	  the	  test,	  score	  
their	  results	  and	  answer	  the	  follow-‐up	  question.	  
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30.  _____  I have a good sense of what others think of me. 

31.   _____  I belong to a club or other group organization.  

32.   _____  I give advice to my friends who have problems. 

33.   _____  I prefer to work alone instead of in a group 

34.   _____  I have an interest or hobby that I don’t talk a lot 
about. 

35.   _____  I have high self-esteem. 

 

Scoring Sheet 

Place a check mark by each item you marked as "true."  Add your totals.    
A total of four in any of the categories indicates strong ability. 

    
   Linguistic  Logical- 

Mathematical  
Musical  Spatial Bodily- 

Kinesthetic 
Intra- 

personal  
Inter- 

personal  
                        
   7  ___  4   ___  2  ___  1  ___    6 ___  26 ___  27 ___  
   8  ___  5   ___  3  ___  9  ___  13 ___  28 ___  29 ___  
   14___  12 ___  10 ___  11___  15 ___  33 ___  30 ___  
   18 ___  16 ___  20 ___  19___  17 ___  34 ___ 31 ___ 
   25 ___  21 ___  23 ___  22___  24 ___  35 ___ 32 ___ 
                        
Totals:     ____     ____     ____   ____     ____     ____     ____  

The Seven Multiple Intelligences Characteristics  

If you are 
strongly:  Think  Love  Need  

Linguistic  in words  reading, writing, telling stories, 
playing word games, etc.  

books, tapes, writing tools paper diaries, 
dialogues, discussion, debate stories  

Logical- 
Mathematical  by reasoning  

experimenting, questioning, 
figuring out puzzles, 
calculating, etc.  

things to explore and think about, science 
materials, manipulatives, trips to the 
planetarium and science museum  

Spatial  in images and 
pictures  

designing, drawing, visualizing, 
doodling, etc.  

art, building blocks, video, movies, slides, 
imagination games, mazes, puzzles, illustrated 
books, trips to art museums  

Bodily- 
Kinesthetic  

through somatic 
sensations  

dancing, running, jumping, 
building, touching, gesturing, 
etc.  

role play, drama, movement, things to build, 
sports and physical games, tactile experiences, 
hands-on learning  

Musical  via rhythms and 
melodies  

Singing, whistling, humming, 
tapping feet and hands, 
listening, etc..  

sing-along time, trips to concerts, music playing 
at home and school, musical instruments  

Interpersonal  
by bouncing 
ideas off other 
people  

leading, organizing, relating, 
manipulating, mediating, 
partying, etc.  

friends, group games, social gatherings, 
community events, clubs, 
mentors/apprenticeships  

Intrapersonal  deeply inside 
themselves  

setting goals, meditating, 
dreaming, being quiet,  

secret places, time alone, self-paced projects, 
choices  
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Now that you know what intelligence level is dominant, how will you apply it to your 
education and career? 
 
 
 
 
III. The four domains of a career assessment: 

 Reference: Mapping a Career Path: Know Your Aptitude, Interests, Values & 
Personality by the Learning Seed, 2011, 
http://www.learningseed.com/_guides/1154_Career_Assessment_Guide.pdf 

     
Every career has strengths in each domain: aptitude, interest, value, and personality. Analyzing a 
career before mapping a career path is an excellent way to start. 

1. Aptitude: is a                                                       to do something well, especially one that 
can be further developed. Essentially, your aptitude for something depends on how quickly 
and easily you learn something.  

Aptitude versus Intelligence/Achievement: 
 

Intelligence is the ability to                         facts and skills and                        them, 
especially when this ability is highly developed. You do not have to have aptitude 
to have intelligence. However, both are incredibly important for success.  

2. Interest: a feeling of                          or concern about something that makes your attention 
turn toward it. How interested you are in a career will often determine how much you enjoy it 
and how well you perform in it. 

 Interests may include (circle which interests you have): 
1. Realistic (“doers” – work with hands, mechanically inclined) 
2. Investigative (thinkers- work information) 
3. Artistic (creators – value independence and creativity) 
4. Social (helpers – prefer being supportive to others) 
5. Enterprising (persuaders – enjoy competition) 
6. Conventional (organizers – like order and detail) 

3. Value: the worth, importance or usefulness of something to somebody. Values in career 
assessment refer to how one feels about certain types of work. 

Intrinsic versus Extrinsic Values: 
 

Extrinsic Values relate to values                          of work itself such as: job security, 
earning potential, or job location. 
 

 � 6/22/12 4:50 PM
Comment [261]: Teachers:	  Take	  5	  minutes	  to	  
overview	  each	  domain,	  leaving	  roughly	  20	  minutes	  
to	  complete	  the	  activity.	  

 � 6/22/12 4:50 PM
Comment [262]: Answer:	  natural tendency	  

 � 6/22/12 4:50 PM
Comment [263]: Answers:	  learn;	  apply	  

 � 6/22/12 4:50 PM
Comment [264]: Answer:	  curiosity	  

 � 6/22/12 4:50 PM
Comment [265]: Answer:	  outside 
 
 
 
Answer: inside	  
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Intrinsic Values relate to values                            the work itself such as: helping 
others, making a difference, or being part of a team. 
 

4. Personality: the totality of somebody’s                             , interests, behavioral patterns, 
emotion responses, social roles, and other individual traits that endure over long periods of 
time. Personality types act as crucial factor into                                     a career path. 
Personality assessments measure personal traits, needs and attitudes to a fitting career. 

 

 Personalities include (circle which you are more prone to): 

1. Introverted – reserved and task orientated 
2. Extroverted – outgoing and action orientated 

 

IV. You Say, I Say: Practice Interview for Aptitude Discovery 

The four domains of career assessment are: _____________________, ____________________, 
 
_______________________, and _________________________. 
 
 
Part A: Interview your partner using the questions below. Write down their responses. 
 
1. What are some things you are naturally good at (aptitude)? 
 
 

 
 
 
2. What are some things you have to work really hard at or put a lot of effort towards to be good 
at them (intelligence)? 
 

 
 
 
3. Do you think it is more important for a job to fulfill extrinsic or intrinsic values? 
 
 
 

 � 6/22/12 4:50 PM
Comment [266]: Answer:	  attitudes;  
 
 
mapping	  

 � 6/22/12 4:50 PM
Comment [267]: Teachers:	  pair	  the	  class	  into	  
groups	  and	  allow	  20	  minutes	  for	  each	  group	  to	  
complete	  Part	  A	  and	  Part	  B	  (i.e.	  partner	  A	  fills	  out	  
form	  w/	  partner	  B’s	  information;	  then	  they	  switch-‐	  
partner	  B	  filling	  out	  forms	  for	  partner	  A).	  If	  time	  
allows,	  at	  the	  end,	  have	  a	  few	  partners	  come	  up	  and	  
read	  to	  the	  class	  Part	  B.	  	  
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4. Why? 
 

 
 
Part B: Use the information above to fill in the template below. You will use this template to 
guide the way you introduce your partner to the class. 
 
_____                                 has a natural ability or aptitude for_                                                  _.  
(insert partner’s name)     (insert answers from question 1) 
 
While in order to achieve high results at                                                             _______, he/she  
      (insert answers from question 2) 
 
must put forth effort and hard work. 
When it comes to values,                                                   believes                                      _____ 
        (insert partner’s name)        (insert answer from question 3) 
 
values are more important because                                                                       . 
     (insert answers from question 4) 
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Lesson 6: Relationships: Effective Communication and Fostering 
Valuable Connections 

 

 Reference: Communication Skills, 
http://www.pamf.org/teen/abc/buildingblocks/skills.html. Copyright 2012 Palo Alto Medical Foundation, 
All Rights Reserved.  

 
 

 Reference: Eight Things to do to Practice Better Communication,  
http://www.pamf.org/teen/abc/buildingblocks/eightthings.html. Copyright 2012 Palo Alto Medical 
Foundation, All Rights Reserved.  

 
A. Pre-Conversation 
On the following chart, rephrase the statement on the left with an “I” statement. 
 
Instead of saying… I should say… 

You always tell me what to do and never let 
me do what I want to do.  

 

You never let anyone else go first.  

Why do you always ignore me? You never 
listen when I have anything important to say. 

 

You need to get off my back!  

You need to stop insulting me!  

 
 

B. During the Conversation 
 
On the following chart, write down what you think is important to your parent without using 
yourself in the statement. That is, rephrase each statement to explain your parent’s reasoning 
without using yourself in the statement. 
 

Aisha Moinuddin� 6/22/12 4:52 PM
Comment [268]: Teachers:	  This	  lecture	  was	  
pulled	  from	  Lesson	  4.	  It	  may	  not	  take	  the	  full	  hour.	  If	  
this	  is	  the	  case,	  use	  this	  class	  period	  to	  catch	  up	  on	  
those	  lectures	  	  
If	  you	  are	  caught	  up	  on	  all	  the	  lessons,	  you	  can	  
extend	  this	  into	  a	  full	  lecture-‐	  just	  be	  creative	  ;)	  

Manchester Staff� 6/22/12 4:52 PM
Comment [269]: Possible	  answer:	  	  
It's	  really	  important	  to	  me	  that	  I	  feel	  like	  I	  can	  
make	  my	  own	  decisions.	  When	  you	  don't	  listen	  to	  
my	  opinions,	  I	  don't	  feel	  like	  I	  have	  control	  over	  my	  
own	  life.	  

Manchester Staff� 6/22/12 4:52 PM
Comment [270]: Possible	  answer:	  
I	  feel	  unimportant	  and	  disregarded	  when	  I	  am	  not	  
able	  to	  go	  first.	  	  

Manchester Staff� 6/22/12 4:52 PM
Comment [271]: Possible	  answer:	  	  
It's	  really	  important	  to	  me	  that	  I	  feel	  respected.	  
When	  you	  ignore	  me	  every	  day	  when	  I	  come	  home,	  
I	  don't	  feel	  respected	  

Manchester Staff� 6/22/12 4:52 PM
Comment [272]: Possible	  answer:	  
Having	  my	  own	  space	  is	  really	  important	  to	  me.	  

Manchester Staff� 6/22/12 4:52 PM
Comment [273]: Possible	  answer:	  
It's	  important	  to	  me	  that	  I	  feel	  respected.	  
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Instead of… My parent really means… 

He wants me to check in with him every 5 
minutes. 

 

He wants me to turn my music down at night.  

He is always on my case about doing my 
homework and getting my chores done. 

 

 

Even if you're wrong, thinking about what's important to them before the conversation will make 
it easier to listen during the conversation.  

C. Post-Conversation 
1. Keep your end of the agreement. 
2. Reflect. 

 

 
 

Lessons 7 and 8: Public Speaking 
 
Objectives: Students will learn how to deliver confident presentations and communicate 
effectively in front of large groups.  
 
Lesson:  
 

 Reference: Exercise adapted from: How to Write a Speech, Teach like a Peace 
Corps Volunteer, http://teachlikeapcv.files.wordpress.com/2012/06/how-to-write-a-speech.pdf     

 
I. Steps for Writing a Successful Speech:  

1.                              : Assess how much time your speech should take. If you don't have a 
time limit, try to keep your speech brief yet informative. 

2.                              : Think about your audience and let your                                     of the 
audience shape the tone of your speech as you write it. 

3. Introduction: Begin with an introduction that establishes                                            , 
what your                                is, what you'll be talking about and how long you're going 
to take. The introduction should make up about                                  of the total speech. 

Manchester Staff� 6/22/12 4:52 PM
Comment [274]: Possible answer:  
It's important to him that he knows his children 
are safe.  

Manchester Staff� 6/22/12 4:52 PM
Comment [275]: Possible answer: 
It's	  important	  to	  him	  that	  he	  gets	  sleep	  at	  night	  
because	  it's	  important	  that	  he	  does	  well	  at	  work	  in	  
the	  morning.	  	  

Manchester Staff� 6/22/12 4:52 PM
Comment [276]: Possible	  answer:	  He	  believes	  in	  
hard	  work	  and	  he	  wants	  his	  children	  to	  have	  a	  solid	  
education	  and	  a	  chance	  at	  a	  better	  future.	  	  

 � 6/22/12 4:53 PM
Comment [277]: Teachers:	  This	  lesson	  should	  be	  
split	  into	  two	  days	  as	  follows:	  
Day	  1:	  go	  over	  lecture	  information	  (i.e.	  Parts	  I,	  II,	  
and	  the	  grading	  rubric.	  
	  
Day	  2:	  speech	  presentations	  and	  feedback.	  

 � 6/22/12 4:53 PM
Comment [278]: Answers:	  1)	  Time	  
	  
	  
	  
2)	  Audience;	  perception	  
	  
	  
	  
3)	  Who	  you	  are;	  purpose;	  long	  
	  
	  
10-‐15%	  
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You may want to include a joke, anecdote (story) or interesting fact to grab the audience's 
attention. 

4.                             : Organize your information into                         main points and 
prioritize them according to importance and                                        . 

a. Start with your                                                                point and then go to your 
least important point and move slowly back toward the most important. For 
example, if you have five points with No. 5 being the most important and No. 1 
being the least important, your presentation order would be 5-1-2-3-4. 

b.                                 points that aren't crucial to your speech if you have too many 
for your time frame. 

5.                                : Add support to each point using statistics, facts, examples, 
anecdotes, quotations or other supporting material. 

6. Link your introduction, points and conclusions together with smooth                               . 

7.                               : Write a conclusion that                                   each of your points, 
restates your main purpose and leaves the audience with a lasting                                . 
The conclusion should make up                               of your total speech. 

8. When preparing your speech, make your notes easy to read by writing or printing them in 
large, clear letters. 

 
 
 
II. Tips to control nervousness 
 

Reference: 10 Tips for Public Speaking, http://www.toastmasters.org/tips.asp. Copyright 2012 
Toastmasters International, All rights reserved. 

 

Reference: Gestures: Get Moving, 
http://www.toastmasters.org/MainMenuCategories/FreeResources/NeedHelpGivingaSpeech/TipsTechniqu
es/GesturesGetMoving.aspx. Copyright 2012 Toastmasters International, All rights reserved. 

 
 
III. Write your own Speech 
Prepare a one minute speech about one of the following subjects: 

1) Your family 
2) Your professional goals 
3) A story from your childhood (rated G) 
4) Something from the history of your village 

 

 � 6/22/12 4:53 PM
Comment [279]: Answers:	  4)	  organize;	  3	  to	  7;	  
effectiveness	  
	  
	  
4a)	  Most	  important	  
	  
	  
	  
	  
	  
4b)	  Delete	  

 � 6/22/12 4:53 PM
Comment [280]: Answers:	  5)	  Support	  
	  
	  
	  
6)	  Transitions	  
	  
7)	  Conclusion;	  summarizes	  
	  
8)	  Impression	  
5-‐10%	  

 � 6/22/12 4:53 PM
Comment [281]: Teachers:	  Give	  some	  
examples	  of	  each	  of	  the	  tips	  on	  the	  left	  in	  your	  
speaking	  from	  personal	  experience.	   
	  

 � 6/22/12 4:53 PM
Comment [282]: Teachers:	  Read	  through	  
instructions	  with	  the	  students.	  Make	  sure	  to	  prep	  
the	  students	  by	  telling	  them	  they	  will	  be	  presenting	  
their	  speeches	  tomorrow.	  Therefore,	  anything.	  they	  
do	  not	  complete	  in	  class	  today,	  they	  will	  need	  to	  
take	  home	  and	  finish	  as	  homework.	  
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On the following page is the rubric which will be used to assess your speech. Look over the 
rubric before you begin your speech to understand what needs to be included in the speech. Be 
sure to cover every area within the rubric.  
 
Follow the steps and tips presented in this lesson to help you create a successful speech. Use the 
rest of this page to write down and organize ideas for your speech, but write your speech or 
speech outline in your journal. 
 
 
 
 
Public Speaking Assessment Rubric 
 
 

Reference: Rubric for Public Speaking, 
http://www.tusculum.edu/research/documents/PublicSpeakingCompetencyRubric.pdf. Copyright 2010, 
Tusculum College, All rights reserved. 

 
 

Lesson 9: Effective Writing Skills: A Guide and Examples 
 
Objectives: Students learn how to convey their ideas, analyze what they read and hear, and 
present their thoughts in writing. 
 
Lesson: 
 
1. Know the assignment 

Without fully understanding the details of their homework, it can be difficult to start 
writing. Therefore, explain the assignment in your own words, and, if unable to, consult 
the assignment sheet provided by the instructor. Always ask any questions you have to be 
sure you know what is being asked of you! 

 
2. Brainstorm!  

 
                                                           . Writing will be much easier if you can explain your 
ideas verbally before putting pen to paper.  
 
                                                          that support your topic or main points. Strong 
evidence makes a paper that much better, so use facts, data, real life examples, journal 
articles, school book examples, etc. Do the examples support your main idea? Are they 
accurate? Engaging?  
 
Answer the five W’s: 

 � 6/22/12 4:53 PM
Comment [283]: Teachers:	  go	  over	  the	  rubric	  
and	  answer	  any	  questions	  before	  the	  students	  
leave,	  as	  they	  may	  have	  difficulty	  understanding	  the	  
concepts	  within	  the	  rubric.	  

 � 6/22/12 4:53 PM
Comment [284]: Teachers:	  As	  you	  review	  this	  
rubric,	  focus	  on	  the	  importance	  of	  good	  writing	  and	  
that	  the	  students	  will	  gain	  a	  lot	  more	  if	  they	  focus	  
on	  why	  they	  should	  write	  well.	  

Aisha Moinuddin� 6/22/12 4:53 PM
Comment [285]: 	  Instructors	  will	  ask	  one	  
student	  (1:1)	  to	  assess	  each	  speaking	  student;	  
assign	  the	  assessors	  to	  speakers	  randomly.	  The	  
student	  who	  is	  speaking	  will	  hand	  over	  his	  copy	  of	  
this	  rubric	  from	  his	  manual	  while	  he/she	  speaks	  so	  
he/she	  can	  keep	  a	  copy	  of	  the	  assessment.	  

 � 6/22/12 4:55 PM
Comment [286]: Teachers:	  briefly	  explain	  the	  
differences	  between	  speeches	  and	  essay	  writing:	  
	  
“The	  last	  two	  classes	  we	  discussed	  speeches.	  But	  
when	  you	  are	  presenting	  something	  in	  an	  essay,	  the	  
tone	  is	  much	  more	  formal.	  You	  will	  probably	  
present	  yourself	  in	  a	  way	  different	  than	  how	  you	  
speak.”	  	  

 � 6/22/12 4:55 PM
Comment [287]: Answer:	  Talk	  out	  your	  ideas.	  

 � 6/22/12 4:55 PM
Comment [288]: Answer:	  Make	  a	  list	  of	  
examples	  

 � 6/22/12 4:55 PM
Comment [289]: Teachers:	  Ask	  students	  to	  
come	  up	  with	  Questions	  beginning	  with	  each	  word;	  
i.e.	  Who	  is	  my	  audience?	  What	  is	  your	  main	  idea?	  
When	  did	  this	  event	  take	  place?	  Where	  did	  this	  
event	  take	  place?	  Why	  is	  this	  topic	  important?	  
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  Who?                                                                                                                        . 

  What?                                                                                                                       . 

  When?                                                                                                                      . 

  Where?                                                                                                                     . 

  Why?                                                                                                                        . 

 

What is your thesis statement?  
The thesis statement is a sentence or two that                                                         . 
It gives the audience a sense of what is to come in the following paragraphs. 
 
The thesis statement is not a fact or an observation.  
A thesis statement is a statement that:  

• Can be                                          . 

• Portrays an                          one way or another  

•                                         . 

• Expresses only                  main idea 

 
 
Decide what is wrong with each of these thesis statements and rephrase them 
to provide a stronger statement:  

 

1) There are some negative and positive aspects to the Banana Herb Tea 
Supplement. 

What is wrong with this statement? 

 

What is a better way to phrase the statement?  

 

 

2) My family is an extended family and I want to get married someday. 

What is wrong with this statement? 

 

 � 6/22/12 4:55 PM
Comment [290]: Answer:	  	  summarizes	  your	  
entire	  paper.	  

 � 6/22/12 4:55 PM
Comment [291]: Answers:	  debated	  
	  
Opinion	  
	  
	  
Specific	  
	  
one	  

 � 6/22/12 4:55 PM
Comment [292]: Teachers:	  This	  may	  be	  best	  as	  a	  
class	  discussion,	  not	  necessarily	  an	  individual	  
assignment.	  	  

 � 6/22/12 4:55 PM
Comment [293]: Answers:	  This	  statement	  is	  not	  
debatable;	  it	  does	  not	  take	  any	  position	  about	  the	  
topic.	  
	  
An	  example	  rewrite	  would	  be:	  While	  Banana	  Herb	  
Tea	  Supplements	  may	  be	  portrayed	  as	  beneficial	  
by	  the	  media,	  they	  are	  actually	  very	  detrimental	  to	  
one’s	  health.	  

 � 6/22/12 4:55 PM
Comment [294]: Answer:	  This	  sentence	  is	  too	  
vague	  and	  can	  easily	  confuse	  the	  reader-‐	  is	  the	  
essay	  about	  the	  writer’s	  family	  or	  their	  desire	  to	  
get	  married?	  
	  
An	  example	  rewrite	  would	  be:	  Having	  a	  large	  
extended	  family	  has	  shown	  me	  the	  value	  of	  family	  
ties.	  Or	  Having	  an	  extended	  family	  as	  caring	  and	  
loving	  as	  mine	  has	  shown	  me	  what	  to	  strive	  for	  
when	  I	  get	  married	  someday.	  
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What is a better way to phrase the statement?  

 

 

3) World hunger has many causes and effects. 

What is wrong with this statement? 

 

What is a better way to phrase the statement?  

 

 

3. Organize 

Organization is the key to what separates a good paper from an excellent paper. Once you 
have all of your ideas written down, you can begin putting them in a logical order within 
your paper. 
Introduction: Think of your introduction as an inverted triangle. Start with a broad 
explanation, narrowing it down to your specific topic. This gives the audience a sense of 
what is coming in the following paragraphs. 
 

 
 

 
 
 

Body: As the meat of your essay, this is where you organize all of the facts and examples 
you have listed to support your thesis. While there is no standard as to how many 
paragraphs you have within the body (e.g. 3 paragraphs versus 30 paragraphs), you do 
want to make sure you have enough to fill the space you are assigned. Therefore, judging 
on how long your essay is required to be will determine what supporting material you 
include. For example, a one-page essay will obviously need less supporting material than 
a ten-page essay. Depending on the side of the size of the essay, you may need to add or 
subtract information. 
 

  General: the broader topic (e.g. World hunger) 
 

Specific: your thesis statement (e.g. Hunger is prevalent 
in northern China because of short growing seasons and 
limited job availability.) 

 � 6/22/12 4:55 PM
Comment [295]: Answer:	  This	  statement	  is	  not	  
specific	  enough	  to	  cover	  in	  an	  essay	  shorter	  than	  
50	  pages-‐	  world	  hunger	  is	  just	  too	  huge	  of	  an	  issue.	  
The	  topic	  must	  be	  narrowed	  down	  to	  a	  more	  
specific	  aspect	  of	  world	  hunger.	  Additionally,	  
“cause	  and	  effects”	  is	  too	  vague.	  
	  
An	  example	  rewrite	  would	  be:	  Hunger	  is	  prevalent	  
in	  northern	  China	  because	  of	  short	  growing	  
seasons	  and	  limited	  job	  availability.	  	  
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Make sure you have a                                                         to the body of your essay. If one 
idea flows into another, make sure to put them next to each other. Don’t jump around 
topics, because the last thing you want your reader to feel is motion sickness. Make sure 
the flow of your paper is fluid. 
 
With that said, pay attention to                                          as these can make or break a 
paper. Transitions are key words that help tie one idea to the next and help create a 
smoother flow throughout the paper. For example consider the following paragraphs and 
determine which flows better: 
 
 Example A: 
 

“Moving towards an authentic dialogue in public health is definitely going to take some changing 
of attitudes. Participants in the dialogue must be willing to set aside any desire to prove 
themselves through debate. Dialogue is not a type of debate; the goal is neither to present 
arguments nor to seek immediate solutions. It is the pursuit of mutual understanding between 
participants. Dialogue must aim towards welcoming different viewpoints while directly 
highlighting common purposes. If dialogue participants enter the arena with guns fully loaded, 
nothing is ever going to be accomplished. Participants must be willing to ‘seek to understand, not 
to be understood.’” 

 
Example B: 
“Moving towards an authentic dialogue in public health is definitely going to take some changing 
of attitudes. First, participants in the dialogue must be willing to set aside any desire to prove 
themselves through debate. As described, dialogue is not a type of debate; meaning, the goal is not 
to present arguments and seek immediate solutions. Rather, it is the pursuit of mutual 
understanding between participants. Additionally, dialogue must aim towards welcoming different 
viewpoints while directly highlighting common purposes. If dialogue participants enter the arena 
with guns fully loaded, nothing is ever going to be accomplished. Therefore, participants must be 
willing to “seek to understand, not to be understood.” 

 
One can present excellent ideas in a logical way, but if the transitions are choppy, the 
whole paper can fall apart. The following is a list of common transitions to make your 
paper as smooth as glass.  

 
Agreement / Addition / Similarity 

These transitional devices add information, reinforce ideas, and express agreement with preceding 

material. 
 

in the first place 

not only ... but also 

as a matter of fact 

in like manner 

in addition 

coupled with 

in the same fashion / way 

first, second, third 

in the light of 

not to mention 

to say nothing of 

equally important 

by the same token 

again 

to 

and 

also 

then 

equally 

identically 

uniquely 

like 

as 

too 

as well as 

together with 

of course 

 � 6/22/12 4:55 PM
Comment [296]: Answer:	  logical	  	  sequence	  

 � 6/22/12 4:55 PM
Comment [297]: Answer:	  	  transitions	  

 � 6/22/12 4:55 PM
Comment [298]: Teachers:	  	  
There	  is	  no	  need	  to	  read	  through	  the	  entire	  list	  of	  
transition	  words-‐	  it	  is	  more	  of	  a	  reference	  for	  the	  
students.	  Instead,	  have	  students	  glance	  through	  
the	  list	  and	  circle	  the	  transition	  words	  within	  the	  
Example	  B	  paragraph.	  
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likewise 

comparatively 

correspondingly 

similarly 

furthermore 

additionally 
 

Opposition / Limitation / Contradiction 

Transition phrases like but, rather and or, express that there is evidence to the contrary or point out alternatives, 

and thus introduce a change the line of reasoning (contrast). 

 
although this may be true 

in contrast 

different from 

of course ..., but 

on the other hand 

on the contrary 

at the same time 

in spite of 

even so / though 

be that as it may 

then again 

above all 

in reality 

after all 

but 

(and) still 

unlike 

or 

(and) yet 

while 

albeit 

besides 

although 

instead 

whereas 

despite 

conversely 

otherwise 

however 

rather 

nevertheless 

regardless 

notwithstanding 

 
 

Examples / Support / Emphasis 

These transitional devices (like especially) are used to introduce examples as support, to indicate importance or as 

an illustration so that an idea is cued to the reader. 

  
in other words 

to put it differently 

for one thing 

as an illustration 

in this case 

for this reason 

to put it another way 

that is to say 

with attention to 

by all means 

important to realize 

another key point 

first thing to remember 

most compelling evidence 

must be remembered 

point often overlooked 

to point out 

on the positive / negative side 

with this in mind 

notably 

including 

like 

to be sure 

namely 

chiefly 

truly 

indeed 

certainly 

surely 

markedly 

especially 

specifically 

expressively 

surprisingly 

frequently 

significantly 

in fact 

in general 

in particular 

in detail 

for examplefor instance 

to demonstrate 

to emphasize 

to repeat 

to clarify 

to explain 

to enumerate 

such as 
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Cause / Condition / Purpose 

These transitional phrases present specific conditions or intentions. 

  

in the event that 

granted (that) 

as / so long as 

on (the) condition (that) 

for the purpose of 

with this intention 

with this in mind 

in the hope that 

to the end that 

for fear that 

in order to 

seeing / being that 

in view of 

If 

... then 

unless 

 when 

whenever 

since 

while 

because of 

as 

since 

while 

lest 

in case 

provided that 

given that 

only / even if 

so that 

so as to 

owing to 

inasmuch as 

due to  

 
 

Effect / Consequence / Result 

Some of these transition words (thus, then, accordingly, consequently, therefore, henceforth) are time words that 

are used to show that after a particular time there was a consequence or an effect. 

Note that for and because are placed before the cause/reason. The other devices are placed before the consequences 

or effects. 

  
as a result 

under those circumstances 

in that case 

for this reason 

for 

thus 

because the 

then 

hence 

consequently 

therefore 

thereupon 

forthwith 

accordingly 

henceforth 

 
 

Conclusion / Summary / Restatement 

These transition words and phrases conclude, summarize and/orrestate ideas, or a indicate a final general 

statement. Also some words (like therefore) from the Effect / Consequence category can be used to 

summarize. 

  
as can be seen 

generally speaking 

in the final analysis 

all things considered 

as shown above 

in the long run 

given these points 

as has been noted 

in a word 

for the most part 

after all 

in fact 

in summary 

in conclusion 

in short 

in brief 

in essence 

to summarize 



	  

241	  
	  

on balance 

altogether 

overall 

ordinarily 

usually 

by and large 

to sum up 

on the whole 

in any event 

in either case 

all in all 

 
 

Time / Chronology / Sequence 

These transitional words (like finally) have the function of limiting, restricting, and defining time. They can be used 

either alone or as part of adverbial expressions. 

  
at the present time 

from time to time 

sooner or later 

at the same time 

up to the present time 

to begin with 

in due time 

until now  

as soon as 

in the meantime 

in a moment 

without delay 

in the first place 

all of a sudden 

at this instant 

immediately 

quickly 

finally 

after 

later 

last 

until 

since 

then 

before 

hence 

since 

when 

once 

about 

next 

now 

formerly 

suddenly 

shortly 

henceforth 

whenever 

eventually 

meanwhile 

further 

during 

first, second 

in time 

prior to 

forthwith 

straightaway 

instantly 

presently 

occasionally

Space / Location / Place 

These transition words are often used as part of adverbial expressions and have the function to restrict, limit or 

qualify space. Quite a few of these are also found in the Time category and can be used to describe spatial order or 

spatial reference. 

  
in the middle 

to the left/right 

in front of 

on this side 

in the distance 

here and there 

in the foreground 

in the background 

in the center of 

adjacent to 

opposite to  

here 

there 

next 

where 

from 

over 

near 

above 

below 

down 

up 

under 

further 
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beyond 

nearby 

wherever 

around 

between 

before 

alongside 

amid 

among 

beneath 

beside 

behind 

across 

 
Conclusion: The conclusion is the                                  of the paper. Within the 
conclusion, you will need to                                  your points and                              your 
thesis statement. In contrast to the inverted triangle of the introduction, the conclusion 
can be considered a right-side up triangle, in that it should begin with a rewording of your 
thesis, followed by a summary of your main points, and opening up to a broader 
generalization. 
 

 
 

 
 

 
4) Writing the First Draft 

Once you have gathered your supporting material and organized them in a logical way, it 
is time to put them all together into the first draft of your paper. When writing your first 
draft, do not spend a lot of time worrying about grammar, punctuation or spelling. This is 
just the time to get everything written down in an essay format. 

 
5) Editing and Proofreading 

After you have finished your first draft, you will want to go back through what you have 
written and correct any mistakes and/or add anything to the paper as needed. This is the 
time to ask yourself: 

 Does what I have written make sense logically? Or are there gaps? 

 Do I need to add or remove anything to make my topic clearer? 

 Do I need transitions to link paragraphs together? 

 Does the introduction command the reader’s attention?  

Does the conclusion include a thesis and summarize the ideas presented in the 
paper? 
 

There are multiple strategies to help you have a successful editing session: 

Specific: reword your thesis 
summarize your main points 

Generalization 

 � 6/22/12 4:55 PM
Comment [299]: Answer:	  wrap	  up	  
Summarize;	  rephrase	  
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1) If time allows, take a                          from looking at your paper and come 
back to it                               . Following this strategy allows your mind to refocus 
and find more mistakes than if you were to write it and edit all in one sitting. Even 
a 15 or 20  minute break can make a difference. 
 
2) Read your paper                                 . This will allow you to hear what you 
have written and determine if your paper makes sense to your ear. You are also 
more likely to find obvious mistakes when reading out loud. 
 
3) To help find spelling errors, read your paper                                     . In doing 
this, you will be able to focus on each word individually, instead of how it relates 
to its surrounding words.  
 
4) Enlist the help of                              . It is always beneficial to have an extra 
pair of eyes look at what you have written. They have an open mind going into it 
and can offer some suggestions that you might not have thought of on your own.  

 
6) Writing and Proofreading the Final Draft 

You may find that you will write multiple drafts for your paper, especially if it is an 
exceptionally long paper. This is okay! Just make sure you have the time for multiple 
edits. When you are satisfied with how the paper looks and sounds, read through it one 
last time, making any last minute corrections. Once these corrections are made, write a 
final, clean copy to turn in.  

 
7) Homework! 

For Lesson 10, you will be asked to write a 5- paragraph essay about one topic listed on 
Lesson 10. Look ahead at that lesson and decide which topic you would like to write 
about. Use the following space and the next page to brainstorm your ideas. Do not 
actually write your essay here, you will do that tomorrow. Just write down your ideas.  

 
 

Lesson 10: Putting it All Together 
 
Objectives: Students will evaluate what they have learned throughout this course through a well- 
written essay. They will then participate in activities designed to reinforce team work and 
community building. 
 
Lesson: 
 
I. In your journal, write a 5 paragraph essay concerning one of the following topics: 
  
 A. Write about your favorite lesson(s) during the past two weeks. 
 

B. Discuss how you will use what you have learned during this program to help you 
achieve success in college and/or your future career. 
 

 � 6/22/12 4:55 PM
Comment [300]: Answers:	  Break;	  later	  

 � 6/22/12 4:55 PM
Comment [301]: Answer:	  out	  loud	  

 � 6/22/12 4:55 PM
Comment [302]: Answer:	  backwards	  

 � 6/22/12 4:55 PM
Comment [303]: Answer:	  others	  

 � 6/22/12 4:56 PM
Comment [304]: Teachers,	  give	  approximately	  
40	  minutes	  for	  students	  to	  gather	  ideas	  and	  write	  
their	  essays.	  If	  they	  finish	  early,	  encourage	  them	  to	  
proofread	  their	  essay.	  	  
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C. Explain how this program has given you confidence as a future engineer. 
 
D. Write a letter to a future student explaining the importance of what you have 
learned during this program. 
 

Feel free to look back through your student manual and journal to refresh your memory on what 
you have learned throughout the program and steps to writing an essay. Be sure to follow the 
basic essay format, including an introduction, a three-paragraph body with facts and smooth 
transitions, and a conclusion.  
 
II. A Final Fun Activity! 
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English 
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Lesson 1: Introducing a Classmate 
 

Identity Card: 
Introducing a Classmate 

 
Name:                                                                  Home Town:   
 
 
 
Family (siblings, parents, etc.)  :           Three Things I Like:                                               
 
 
        
 
 

Hobbies: 

 

 

Something I’d Like to Do:                           Three Things I Don’t Like: 

 

 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 � 6/22/12 4:59 PM
Comment [305]: Teachers:	  Briefly	  explain	  the	  
cards	  and	  the	  assignment	  (to	  get	  to	  know	  each	  
other	  through	  interviewing).	  Give	  10-‐15	  minutes	  for	  
the	  partners	  to	  interview	  each	  other.	  Use	  the	  rest	  of	  
the	  time	  to	  have	  the	  partners	  present	  their	  partner	  
to	  the	  class.	  	  
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Lesson 2: Giving Expression to Your Original Thoughts 
 
Objectives: Students will choose an object to write about creatively and originally. This will 
enable them to continue to develop their skills in bringing forth original, imaginative, and 
innovative ideas. The goal is to get students thinking, writing, and dialoguing creatively and 
critically. 
 
Lesson:  
I. Let’s talk about originality! 

It is better to fail in originality 
than to succeed in imitation. 

- Herman Melville 
Originality does not consist in saying what no one has ever said before, but in saying exactly 

what you think yourself. 
- James Stephens 

 
Creativity involves breaking out of established patterns in order to look at things                        

in a different way.  
- Edward de Bono 

 
II. Quick Puzzles 
 
1. Acting on an anonymous phone call, the police raid a house to arrest a suspected murderer. 
They don't know what he looks like, but they know his name is John. Inside they find a 
carpenter, a taxi driver, a car mechanic and a fireman all playing cards. Without even asking his 
name, they immediately arrest the fireman. How do they know they've got their man?  
(  Source: http://www.funonthenet.in/content/view/163/31/) 
 
2. A murderer is condemned to death. He has to choose between three rooms. The first is full of 
raging fires, the second is full of assassins with loaded guns, and the third is full of lions that 
haven't eaten in 3 years. Which room is safest for him?  
(  Source: http://wilk4.com/humor/humore14.htm) 
3. How could a baby fall out of a twenty-story building onto the ground and live? 
 
4. A man and his son are in a car crash. The father is killed and the child is taken to hospital 
gravely injured. When he gets there, the surgeon says, 'I can't operate on this boy - for he is my 
son!!!' How can this possibly be? 
 
5. A man lives in the penthouse of an apartment building. Every morning he takes the elevator 
down to the lobby and leaves the building. Upon his return, however, he can only travel halfway 
up in the lift and has to walk the rest of the way - unless it's raining. What is the explanation for 
this? 
(  Source for 3, 4 and 5: http://www.folj.com/lateral/) 
 
 

Aisha Moinuddin� 6/22/12 5:01 PM
Comment [306]: This	  is	  simply	  for	  interaction	  
with	  the	  class	  as	  a	  whole.	  	  

Aisha Moinuddin� 6/22/12 5:01 PM
Comment [307]: Source:	  
http://www.funonthenet.in/content/view/163/31/	  

Aisha Moinuddin� 6/22/12 5:01 PM
Comment [308]: Solution:	  Answer: The 
fireman is the only man in the room. The rest of 
the poker players are women.	  

Aisha Moinuddin� 6/22/12 5:01 PM
Comment [309]: Source:	  
http://wilk4.com/humor/humore14.htm	  

Aisha Moinuddin� 6/22/12 5:01 PM
Comment [310]: Solution:	  the	  third	  –	  if	  the	  lions	  
haven’t	  eaten	  in	  three	  years,	  they	  are	  dead	  

Aisha Moinuddin� 6/22/12 5:01 PM
Comment [311]:  The baby fell out of a 
ground floor window.	  

Aisha Moinuddin� 6/22/12 5:01 PM
Comment [312]: The surgeon can not 
operate on her own son; she is his mother.	  

Aisha Moinuddin� 6/22/12 5:01 PM
Comment [313]: he man is a dwarf. He can't 
reach the upper elevator buttons, but he can 
ask people to push them for him. He can also 
push them with his umbrella.	  

Aisha Moinuddin� 6/22/12 5:01 PM
Comment [314]: Source	  for	  #3-‐5	  
http://www.folj.com/lateral/	  



	  

248	  
	  

III. Random Word Bridge Technique  
Soon, we are going to work on an exercise where you will work to describe something in an 
original, creative way – but first we’ll discuss a technique where you can create a new bridge 
between ideas to help you when you’re stuck.  
Let’s say you’re given a topic, but you are not sure how to talk about it. What do you do? Well, 
using the random word technique you can come up with unexpected ideas. First you’ll need a 
random word. It can be from anywhere: the cover of a book, an advertisement, flipping through a 
dictionary or magazine. But don’t look for a “good” word – just make sure it’s random.  

• Look around you. What can you see? Can you see any words? What about things? What 
else is happening? 

• Open a book at a random page. Run your finger around the page and stop at a random 
point. Look for a suitable word near your finger. 

• Ask the people you are with to give you a random word. 
• Select a word from a prepared list of evocative words (fire, child, brick, sausage, etc.) 

The next step is establishing a bridge idea… 
 

Reference. How to use the Random Word technique, 
http://www.infinn.com/randomwordtutorial.html. Copyright 1997-2011 Infinite Innovations Ltd, All right 
reserved. 

  
IV. Doing it Yourself 
You have seen one way of coming up with new ideas. You can also explore your own. Select an 
object (person, place or thing) that is physically present. Spend fifteen minutes writing about it 
below and on the next page. Be as conservative or imaginative as you wish. Just make sure the 
ideas and thoughts you express are from within your head – think about what you want to say, 
and without curbing or over evaluating, talk about the object and your own flowing ideas. 
 

Aisha Moinuddin� 6/22/12 5:01 PM
Comment [315]: Students will now choose an 
object (person, place, thing) that is local (i.e., 
physically present nearby where it can be seen). 
There will be a sign-up sheet, where each student 
will list the object they will describe. The maximum 
overlap between objects is two students. Therefore, 
as students sign the list with their idea, they must 
ensure at most one other person has the same object 
in mind. 
 
Depending	  on	  where	  you	  are	  and	  the	  weather,	  you	  
may	  allow	  student	  up	  to	  five	  minutes	  to	  explore	  
outside	  near	  the	  classroom	  to	  come	  up	  with	  their	  
object.	  



	  

249	  
	  

 

Aisha Moinuddin� 6/22/12 5:01 PM
Comment [316]: Choose	  students	  to	  read	  their	  
descriptions	  aloud	  from	  their	  seat;	  number	  chosen	  
depends	  on	  how	  much	  time	  is	  left	  after	  each	  
student	  reads.	  
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Lesson 3: Reading Articles 

 
Refer to Annex for articles.   

Lesson 4: Letter Writing 

 
Formal vs. Informal Language 

 
Different styles of speaking and writing are appropriate in different situations and contexts.  For 
example, you typically would not talk to your employer at work in the same way that you talk to 
your friend while playing sports.  These types of speech can be categorized as either formal 
language or informal language.  The figure below gives some examples to help you think about 
these differences. 

 
 

We can summarize some important differences between formal and informal language, along 
with some more specific examples (in italics): 

David Robert Johnson� 6/22/12 5:03 PM
Comment [317]: Instructor	  note:	  have	  students	  
give	  other	  suggestions	  which	  are	  not	  in	  the	  figure	  
below.	  	  Come	  up	  with	  your	  own	  also	  if	  you	  want.	  

David R Johnson� 6/22/12 5:03 PM
Comment [318]: Reviewer	  note:	  any	  other	  
qualities	  we	  can	  easily	  describe?	  
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Formal Informal 

Passive voice 
More information is requested by the student. 
Dinner is served by the waiter. 

Active voice 
The student requests more information. 
The waiter serves dinner. 

Sophisticated words and sentences 
Therefore, I request that you carefully consider my 
application for employment. 

Simple words and sentences 
I want to apply for a job. 
 
 

Contractions should not be used 
They will arrive soon. 
I am a great soccer player. 

Ok to use contractions 
They’ll arrive soon. 
I’m a great soccer player. 

Clear enunciation (clear, proper, and complete 
pronunciation) is important 
I have something important to discuss with you. 
Please buy some red oil from me. 

Clear enunciation is not important 
 
I cuh’ to spe’ to yaw. (I come to speak to you.) 
Plea’ buy suh’ re’ oi’ fruh me. 

Slang should not be used 
American man, mister, sir, etc. 

Slang is ok 
White man 

 
 
Activity – is it formal or informal language? 
Your teacher will guide you through the following words and phrases.  In the blank space, mark 
each one either with an “F” for formal language or “I” for informal language.  In each pair, one 
is formal and one is informal. 
 

Word or phrase F/I Word or phrase F/I 
Can’t  Cannot  
The engineer tested a theory  A theory was tested by an engineer  
The rice is finish  There is no more rice  
I need  I require  
Everything  E’ry’tin’  
Regarding your letter  About your letter  
Is not  Isn’t  
Boieh  Boiled egg  
Mary fixed the problem  The problem was fixed by Mary  

  
 

Sections of a letter 
Lesson 
A formal letter consists of several sections.  Each section has a purpose and a placement within 
the letter.  This lesson is presented as would be common in the United States, so the addressing 
sections may not be as relevant here in Liberia.  The key point is to focus on the structure of the 
letter, and also the use of formal vs. informal language, depending on your audience.  Below is 
an example letter, and each section is indicated.  Whether typing or handwriting, take note of the 
number of lines between each section.  An explanation of each section is provided below the 
example letter. 
 

David R Johnson� 6/22/12 5:03 PM
Comment [319]: Instructor	  note:	  again,	  add	  
some	  of	  your	  own	  if	  you	  wish.	  

David Robert Johnson� 6/22/12 5:03 PM
Comment [320]: Instructor	  note:	  	  have	  the	  
students	  read	  the	  letter	  (either	  silently	  or	  aloud).	  	  
Ask	  them	  to	  classify	  the	  letter	  as	  either	  formal	  or	  
informal.	  
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 Example letter by University of Michigan 

Address 
First of all, an address is a collection of information that identifies a location.  Each country 
around the world has a different way of presenting this information.  In the United States, the 
address format is as follows: 
 
Format Example 
Name of addressee 
House number and street name 
Name of town, State abbreviation + ZIP code 

Jeremy Martinson 
455 Larkspur Dr. 
California Springs, CA 92926 
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 Drawing by University of Michigan 

 
In the United States, you can write a letter, pay a small fee, and workers will deliver your letter 
anywhere in the country!  In Liberia, communication is more challenging, so if you want to write 
a letter to someone, you may have to come up with some creative ways to deliver the message to 
that person! 
 
Sender Address 
The sender address is the address of the person who is sending the letter.  The sender should not 
include their name in this section.  Reading down farther, note that the sender’s name is included 
in the closing section. 
Date the letter was written 
This can also be the day the letter was completed if the letter took several days to write. 
Inside address (or recipient address) 
This is the address of the recipient – the person who is receiving the message. 
Salutation 
Formal salutations contain a formal addressing word, such as “Dear,” followed by the 
addressee’s name.  If you don’t know the addressee well, you would generally use a personal 
title (e.g., Dear Mr. William White or Dear Mr. White).  If you are quite familiar with the 
addressee and usually call them by their first name, you may address them by first name (e.g., 
Dear William or Dear Bill).  In a formal letter, follow the addressee’s name with a colon (:).  If 
you don’t know the person at all (you are writing to a company to request information) or you 
are unsure of the addressee’s gender (e.g., Sudarshan Chopra or Xiasong Ming), you may use 
something like “To Whom It May Concern:” as the salutation. 
 
Informal salutations are much looser, but follow the same structure.  Use an addressing word, 
such as “Hello” or “Hey” (“Dear” is also common and acceptable).  You will generally use the 
person’s first name, followed by a comma (,). 
Body 
In a formal letter, use formal language!  Also, be concise – some people are very busy and have 
limited time, so make the best use of their time.  The first paragraph should be a greeting (e.g., “I 
hope this letter finds you well.”), and then make the main point of the letter (e.g., “I would like to 
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apply for a job.”).  Following paragraphs should contain supporting information and important 
details, and the last paragraph should wrap up the letter – restate the purpose and possibly 
request an action or other follow up. 
In an informal letter, again, the format is very loose.  You may be writing to a friend – make it 
fun and interesting for them to read! 
Closing 
This is a phrase used to close out the letter.  The phrase is followed by a comma (,), and only the 
first word of the phrase is capitalized.  Some examples of formal closing phrases are 
“Respectfully,” “Sincerely,” and “Best regards,”.  Informal phrases could include “Love,” 
“Sunny days,” and “Your sugar pie,”.  The 4 spaces between the closing and the sender’s name 
are for the sender’s signature. 
Enclosures 
You might include some external documents with your letter.  If you are applying for a job, you 
might include a resume.  If you are applying for college, you might include your grades from 
high school or a photocopy of an award you received.  If you include any documents, write 
“Enclosures” one line below the sender’s name. 
 
Activity – identify the parts of the letter 
Below are two example letters.  Circle and label the sections of each letter.  Also, identify what 
type of letter each one is by writing a big “F” for formal or “I” for informal near the letter. 
 
 

 
 Example letter by University of Michigan 
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 Example letter by University of Michigan 

 

Formal letter writing 
Now it’s your turn to write a letter! 
Choose a topic below and write a formal letter to the person.  Remember to use proper language 
and also to assemble the letter as discussed earlier.  You probably don’t have an address – so 
make one up!  It can be based on reality or totally fun and inventive.  Also make up an address 
for your recipient.  Remember that this is a formal letter – be short and to the point! 
 
When you finish, trade your letter with a partner.  Read your partner’s letter and try to find any 
mistakes in language or in letter structure.  If you have a dispute, ask your instructor! 
Topics 

1. Write to President Ellen Johnson Sirleaf, requesting that schools have more athletic 
programs so that Liberia can have better athletes to compete in the Olympic Games. 

2. Write to the University of Liberia to request information about an academic program like 
electrical engineering or agriculture. 

3. Write to Firestone Natural Rubber Company to apply for a recent employment 
opportunity you heard about.  (Don’t forget – you may want to enclose a resume!) 

 
 

David Robert Johnson� 6/22/12 5:03 PM
Comment [321]: Instructor’s	  note:	  this	  activity	  
can	  take	  up	  as	  much	  or	  as	  little	  time	  as	  needed	  to	  fill	  
the	  remaining	  class	  time.	  
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Further Reading 
 

Reference: “Writing skills: formal and informal writing by Jackie McAvoy. 
http://www.onestopenglish.com/skills/writing/lesson-plans/writing-skills-formal-and-informal-
writing/146337.article. Copyright 2000-2013 Macmillan Publishers Ltd, All rights reserved. 

 

Reference: Formal and Informal English, 
http://www.blssrl.com/assets/Formal_Informal_English.pdf. Copyright 2012 Business Language Services, 
All rights reserved. 

 

Reference: Liberian English, http://reedsinliberia.blogspot.com/2007/10/liberian-english.html.  
Copyright 2007 The Reed Family, All rights reserved. 

 
 
 

Lesson 5: Data Collection and Write-Up 
 
Objectives: Students will learn to collaboratively collect data and write a short report concerning 
the data. 
I. Collecting the Data: 
The following chart is a list of Dominant and Recessive traits in humans. Your mission is to 
figure out a way to determine how many people in your group possess each trait. You may use 
the following page to develop your ideas and record your data.  
 

Reference: Mendelian Traits in Humans, 
http://education.sdsc.edu/download/enrich/mendelian_traits.pdf. Copyright 2005 The Regents of the 
University of California, All rights reserved.  

 
 

 
II. Draw a Graph: 

In the space below, draw a graph depicting the data you collected. 

 � 6/22/12 5:04 PM
Comment [322]: Teachers:	  If	  the	  students	  are	  
having	  trouble	  developing	  a	  clear	  way	  to	  record	  
their	  data,	  try	  suggesting	  a	  chart	  similar	  to	  the	  one	  
presented	  here,	  only	  have	  them	  add	  columns	  for	  
the	  total	  number	  of	  people	  with	  each	  trait.	  	  
	  

 � 6/22/12 5:04 PM
Comment [323]: Teachers:	  You	  may	  also	  need	  
to	  help	  groups	  develop	  their	  graphs.	  A	  bar	  
graph/Histogram	  would	  be	  the	  best	  route.	  
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III. Write it up: 

As a group, write your observations from this project using the following questions as a 
guide. Be sure to use complete sentencing and paragraph structure: 

   
 Introduction: What was the purpose of this project? What traits are considered  

dominant? What traits are recessive? 
 

Method: How was the data collected; that is, what steps were taken to collect the data? 
How many participants were involved? What were the questions asked about the data? 
 
Results: What were the results of the project? What traits were the most frequent? Which 
were the least?  
 
Discussion: Why was this project important? What was done well? What could have 
been done differently? What did you learn about data collection through this project? 
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Lesson 6: Problem Solving and Experimental Solutions 
 
Objective: Students will brainstorm difficulties within their country, village, school or family 
and develop a solution to help solve this problem. 
 
Lesson:  
 
I. Group Brainstorm 
 
With your instructor’s guidance, and as a class, develop a list of difficulties within your country, 
village, school or family, or a difficulty you may have personally. These can be physical, 
cultural, sociological, emotional, or any other type of difficulty you can think of.  
 
 
II. Questions to Stir Your Creativity 
 
Which item from the class list did you find most intriguing?  

 
 
 
 
 

How is this item a difficulty for you or your country/village/school/family? Who is most 
affected by this difficulty (this is your target audience)? 
 
 
 
 
 
 
 
Given unlimited resources (including money), what would you do to relieve this difficulty? 
 
 

__________________________________________________________
__________________________________________________________
__________________________________________________________
__________________________________________________________ 
 
III. Write it out 
 
You are given an opportunity to present your idea for easing this difficulty to your village leader. 
In your journal, write a short essay to your village leader describing your difficulty, your target 
audience (who will be most helped by your solution), and, of course, your solution.  
 
 

 

 � 6/22/12 5:06 PM
Comment [324]: 	  If	  possible,	  divide	  your	  
drawing	  board	  into	  four	  columns	  and	  label	  each	  
column	  as:	  country,	  village,	  school,	  family,	  you.	  
	  
Spend	  2-‐3	  minutes	  taking	  ideas	  from	  the	  students	  
for	  each	  category.	  	  
	  
The	  following	  are	  possible	  questions	  to	  ask	  to	  
encourage	  discussion:	  
	  
“If	  you	  were	  to	  change	  one	  thing	  about	  your	  
[country/village/school/family]	  what	  would	  it	  be?”	  
	  
“What	  is	  the	  most	  difficult	  physical	  activity	  you	  have	  
ever	  engaged	  in?”	  
	  
“Which	  chore/subject/living	  condition	  do	  you	  dislike	  
the	  most?”	  

 � 6/22/12 5:06 PM
Comment [325]: Teachers:	  Depending	  on	  the	  
class	  dynamic,	  this	  can	  be	  done	  individually	  or	  in	  
groups	  of	  2-‐3.	  	  
	  
Limit	  this	  time	  to	  10-‐15	  minutes,	  saving	  enough	  
time	  for	  the	  students	  to	  write	  their	  own	  paragraphs.	  	  

 � 6/22/12 5:06 PM
Comment [326]: Teachers,	  this	  part	  should	  be	  
done	  individually.	  While	  the	  students	  may	  have	  
been	  able	  to	  brainstorm	  their	  ideas,	  they	  will	  be	  
giving	  their	  hypothetical	  speech	  to	  their	  own	  village	  
leaders;	  therefore,	  they	  need	  to	  develop	  their	  
speech	  individually.	  
	  
If	  students	  are	  still	  having	  difficulty	  writing	  this,	  
remind	  them	  that	  they	  have	  basically	  provided	  the	  
essential	  information	  in	  the	  previous	  questions.	  	  
	  
It	  may	  help	  them	  to	  talk	  about	  their	  ideas	  to	  you.	  Or	  
guide	  them	  through	  their	  essay	  one	  sentence	  at	  a	  
time.	  
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Lesson 7: Reading Comprehension 
 
Name: ________________                                 Date: ___________ 

KWL 
Complete the first two columns below (K and W) before reading. 
Complete the third column below (L) after reading. 
Name of Text: __________________________ 

 
 

 

K 
What I Know 

W 
What I Want to 

Learn 

L 
What I Learned 
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Lesson 8: The Lady, or the Tiger? 
Objective:  Students will listen to the beginning of a story and develop their own ideas about the 
ending.  
Lesson: 
I. The Story  

Read along as the following story is read. 

  Reference: The Lady, or the Tiger? by Frank R. Stockton, Voices of America, 
http://learningenglish.voanews.com/content/a-23-2009-04-17-voa3-83140447/129441.html.  

 
The Lady, or the Tiger? 
Transcript of radio broadcast: 
“Long ago, in the very olden time, there lived a powerful king.  Some of his ideas were 
progressive.  But others caused people to suffer. 
 
One of the king's ideas was a public arena as an agent of poetic justice.  Crime was punished, or 
innocence was decided, by the result of chance.  When a person was accused of a crime, his 
future would be judged in the public arena. 
 
All the people would gather in this building.  The king sat high up on his ceremonial chair.  He 
gave a sign.  A door under him opened.  The accused person stepped out into the arena.  Directly 
opposite the king were two doors.  They were side by side, exactly alike.  The person on trial had 
to walk directly to these doors and open one of them.  He could open whichever door he pleased.  
 
If the accused man opened one door, out came a hungry tiger, the fiercest in the land.  The tiger 
immediately jumped on him and tore him to pieces as punishment for his guilt.  The case of the 
suspect was thus decided.  
 
Iron bells rang sadly.  Great cries went up from the paid mourners.  And the people, with heads 
hanging low and sad hearts, slowly made their way home.  They mourned greatly that one so 
young and fair, or so old and respected, should have died this way. 
 
But, if the accused opened the other door, there came forth from it a woman, chosen especially 
for the person.  To this lady he was immediately married, in honor of his innocence.  It was not a 
problem that he might already have a wife and family, or that he might have chosen to marry 
another woman.  The king permitted nothing to interfere with his great method of punishment 
and reward.  
 
Another door opened under the king, and a clergyman, singers, dancers and musicians joined the 
man and the lady.  The marriage ceremony was quickly completed.  Then the bells made cheerful 
noises.  The people shouted happily.  And the innocent man led the new wife to his home, 
following children who threw flowers on their path. 
 
This was the king's method of carrying out justice.  Its fairness appeared perfect.  The accused 
person could not know which door was hiding the lady.  He opened either as he pleased, without 
knowing whether, in the next minute, he was to be killed or married.   

 � 6/22/12 5:09 PM
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Sometimes the fierce animal came out of one door.  Sometimes it came out of the other.  
 
This method was a popular one.  When the people gathered together on one of the great trial 
days, they never knew whether they would see a bloody killing or a happy ending.  So everyone 
was always interested.  And the thinking part of the community would bring no charge of 
unfairness against this plan.  Did not the accused person have the whole matter in his own hands? 
 
The king had a beautiful daughter who was like him in many ways.  He loved her above all 
humanity.  The princess secretly loved a young man who was the best-looking and bravest in the 
land.  But he was a commoner, not part of an important family.   
 
One day, the king discovered the relationship between his daughter and the young man.  The 
man was immediately put in prison.  A day was set for his trial in the king's public arena.  This, 
of course, was an especially important event.  Never before had a common subject been brave 
enough to love the daughter of the king.  
 
The king knew that the young man would be punished, even if he opened the right door.  And the 
king would take pleasure in watching the series of events, which would judge whether or not the 
man had done wrong in loving the princess. 
 
The day of the trial arrived.  From far and near the people gathered in the arena and outside its 
walls.  The king and his advisers were in their places, opposite the two doors.  All was ready.  
The sign was given.  The door under the king opened and the lover of the princess entered the 
arena.  
 
Tall, beautiful and fair, his appearance was met with a sound of approval and tension.  Half the 
people had not known so perfect a young man lived among them.  No wonder the princess loved 
him!  What a terrible thing for him to be there! 
 
As the young man entered the public arena, he turned to bend to the king.  But he did not at all 
think of the great ruler.  The young man's eyes instead were fixed on the princess, who sat to the 
right of her father.  
 
From the day it was decided that the sentence of her lover should be decided in the arena, she 
had thought of nothing but this event. 
 
The princess had more power, influence and force of character than anyone who had ever before 
been interested in such a case.  She had done what no other person had done.  She had possessed 
herself of the secret of the doors.  She knew behind which door stood the tiger, and behind which 
waited the lady.  Gold, and the power of a woman's will, had brought the secret to the princess. 
 
She also knew who the lady was.  The lady was one of the loveliest in the kingdom.  Now and 
then the princess had seen her looking at and talking to the young man. 
 
The princess hated the woman behind that silent door.  She hated her with all the intensity of the 
blood passed to her through long lines of cruel ancestors. 
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Her lover turned to look at the princess.  His eye met hers as she sat there, paler and whiter than 
anyone in the large ocean of tense faces around her.  He saw that she knew behind which door 
waited the tiger, and behind which stood the lady.  He had expected her to know it. 
 
The only hope for the young man was based on the success of the princess in discovering this 
mystery.  When he looked at her, he saw that she had been successful, as he knew she would 
succeed. 
 
Then his quick and tense look asked the question: "Which?"  It was as clear to her as if he 
shouted it from where he stood.  There was not time to be lost.  
 
The princess raised her hand, and made a short, quick movement toward the right.  No one but 
her lover saw it.  Every eye but his was fixed on the man in the arena. 
 
He turned, and with a firm and quick step he walked across the empty space.  Every heart 
stopped beating.  Every breath was held.  Every eye was fixed upon that man.  He went to the 
door on the right and opened it.” –End story 
 
Now, the point of the story is this: Did the tiger come out of that door, or did the lady? 
 
The more we think about this question, the harder it is to answer.  It involves a study of the 
human heart.  Think of it not as if the decision of the question depended upon yourself.  But as if 
it depended upon that hot-blooded princess, her soul at a white heat under the fires of sadness 
and jealousy.  She had lost him, but who should have him? 
 
How often, in her waking hours and in her dreams, had she started in wild terror, and covered her 
face with her hands?  She thought of her lover opening the door on the other side of which 
waited the sharp teeth of the tiger! 
 
But how much oftener had she seen him open the other door?  How had she ground her teeth, 
and torn her hair, when she had seen his happy face as he opened the door of the lady!  How her 
soul had burned in pain when she had seen him run to meet that woman, with her look of victory.  
When she had seen the two of them get married.  And when she had seen them walk away 
together upon their path of flowers, followed by the happy shouts of the crowd, in which her one 
sad cry was lost! 
 
Would it not be better for him to die quickly, and go to wait for her in that blessed place of the 
future?  And yet, that tiger, those cries, that blood! 
 
Her decision had been shown quickly.  But it had been made after days and nights of thought.  
She had known she would be asked.  And she had decided what she would answer.  And she had 
moved her hand to the right. 
 
The question of her decision is one not to be lightly considered.  And it is not for me to set 
myself up as the one person able to answer it.  And so I leave it with all of you: 
 
Which came out of the open door – the lady, or the tiger? 
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Overview: 
 
Day Topic Activities 
1 Why Math? 

What are equations? 
The “Language” of math 
 

Math is all around us!  Examples. 
 
The “equation” machine 
 
How to read an equation like a 
sentence. 
 

2 Basic Algebra practice Play the “game” of solving for x. 
 
- Several in-class examples 

 
Review of some common 
terminologies. 
- Square roots 
- Exponents 
- Fractions 
- Order of Operations 

3 More algebra practice 
- Factoring 
- The quadratic equation 

 

4 Analytical: Turning words into 
pictures and equations 
 
 

Split into groups, each has a 
problem to turn into a picture or 
equation 
 

5 Graphing Equations 
The x-y plane 
Graphing lines 
Making data tables 

Agriculture example: Graphing 
supply and demand; money 
payback problem 

6 Geometry 
- Angles 
- Basics of shapes 
- Right Triangles 
- The Pythagorean Theorem 
- 3D shapes 
- Volume 

Engineering example: Building a 
straight road between two points 

7 Trigonometry: It’s all about 
Right Triangles! 
- Sine, Cosine, and Tangent 
- SOHCAHTOA 

Engineering Example: Finding the 
angle on a bridge or a ramp; angle 
of solar rays on a solar panel 

8 More trigonometry 
- More SOHCAHTOA 

practice 
- The Unit Circle 
 

Example problems in class 

9 Group Work Day Engineering or agriculture-related 
problem to solve in groups of 5 

10 Group Work Day Engineering or agriculture-related 
problem to solve in group of 5 
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Day 1 Homework: 
NO HOMEWORK 
 
Day 2 Homework: 
Solve the following equations for x: 
 
2x + 3 = 11 
 
10x – 4 =16 
 
25 = x^2 
 
x/2 = 6 
 
x + 2x + 7 = 10 
 
Challenge question: 
(10 - x) / 2 = 4 
 
Day 3 Homework: 
 
Solve for x in the following equations: 
 
x^2 + 3x + 2 = 0 
 
x^2 + 8x + 15 = 0  
 
x^2 = 7x – 10 
 
3x^2 + 2x +9 = 0 
 
4x^2 + 6x + 10 = 6 
 
Challenge Question: 
10x^2 + 42x + 150 = 9x^2 +40x + 148 
 
Day 4 Homework: 
 
A story problem.  Good ones include: 
 - Population dynamics.  Day 1 you start with one bunny, then one more each day… 
 - You pay 500 dollars upfront for a big basket of plums at the market.  But you know you can 
re-sell them and make 10 dollars for every plum.  How many plums do you need in the basket to 
make your purchase worth it? 
 - Interest rate problem.  Down payment plus interest rate over how many years 
 - Augustine is 3 more than twice the age of Francis.  If Augustine is 25 years old, how old is 
Francis? 
 
Day 5 Homework: 
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Identify and label the following points on the x-y plane below. 
 
Point A: (2, 3) 
Point B: (-7, 1) 
Point C: (5, -5) 
Point D: (-4, -6) 
 
 
 

Make a data table with 5 data points for the following function: 
 
y = (1/2)x + 3 
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Now graph the function on the given x-y plane 
 

 
 
Day 6 Homework: 
 
Find the perimeter of the rectangle below.  Next, find the area. 
 

 
 
 
If Angle A is 60 degrees, what are the angles for angles B, C, and D? 

 
 
 

6 ft 

12 ft 

A B 

C D 
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Find the length of the missing side of this triangle: 
 
 

 
Find the length of the missing side of this triangle: 
 
 

 

4 ft 

3 ft 

5 ft 

10 ft 
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Challenge Question: 
From WAEC 2011:  
 
Find the area of the trapezoid below: 

 
 
 
Day 7 Homework: 
 
Define what SOHCAHTOA means.  Please draw a diagram to help explain. 
 
 
Using the triangle below, please find the following: 
 
sin(ө) 
 
cos(ө) 
 
tan(ө) 
 

 

15 ft 

20 ft 

17 ft 

4 ft 

5 ft 

3 ft 

ө 
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Using the words you know from SOHCAHTOA, please simplify the expression: 

 
What is cos(ө) in the following figure, if the area of triangle ABC is 5 square feet? 
 

 
Day 8 Homework:  
 
From WAEC 2011: 
 
Given that tanө = 5/12 and that 0o < ө < 90o, what is the value of cosө - sinө? 
 
 
Fill in the values for cosine and sine for each angle shown on the Unit Circle below.  Give your 
answer in the form of (___,____)  the first number being cosine, and the second number being 
sine. 

Sin(ө) 

Cos(ө) 

5 ft 

ө 

A B 

C 

2 ft 
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Find the length of side BC. 
 

 
Day 9 Homework: 
 
GROUP ACTIVITY #1: 10 MINUTES 
What is the value of the area of a square whose diagonals measure 8 cm? 
 
 
 
GROUP ACTIVITY #2: 30 MINUTES 
 
A little boy is flying a kite. The string of the kite makes an angle of 30o with the ground. If the 
height of the kite is h = 21 m, find the length (in meters) of the string that the boy has used. 
  
Group activity #3: 30 minutes 
A ship of height h = 12 m is sighted from a lighthouse. From the top of the lighthouse, the angle 
of depression to the top of the mast and the base of the ship equal 30o and 45o respectively. How 
far is the ship from the lighthouse (in meters)?  
 
 
 
 

 
 

 
 
 
 
 

 

4 ft 

? 

ө = 30o 
A C 

B 
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Reading: Winter In Songming 
 

Reference: Winter in Songming, https://shop.heifer.org/shop/books-and-dvds/winter-in-
songming.html, Copyright Heifer International, All rights reserved.  

 

UN Millennium Development Goal Posters 
 

 Reference: UN Millennium Development posters,  
http://www.oxfam.org.uk/education/resources/change-the-world-in-eight-steps. Copyright 2012-2013 
Oxfam, All Rights Reserved.  

 

Research Articles 
 
The articles below are from the American Chemical Society, Copyright 2006-
2012, All Rights Reserved. 
• “Erosion – Soil on the Move,” 

http://portal.acs.org/preview/fileFetch/C/CSTA_015154/pdf/CSTA_015154.pdf  
• “The Fist Airplane,” 

http://portal.acs.org/preview/fileFetch/C/CSTA_015175/pdf/CSTA_015175.pdf  
• “Dynamic Soil,” 

http://portal.acs.org/preview/fileFetch/C/CSTA_015152/pdf/CSTA_015152.pdf  
• “Green grass, Green beans, Green thumb, but Green chemistry,” 

http://portal.acs.org/preview/fileFetch/C/CSTA_015156/pdf/CSTA_015156.pdf  
• “Washing Water,” 

http://portal.acs.org/preview/fileFetch/C/CSTA_015178/pdf/CSTA_015178.pdf  
• “Milli Recycles & You Can, Too,” 

http://portal.acs.org/preview/fileFetch/C/CSTA_015164/pdf/CSTA_015164.pdf  
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